InfoPrint Manager

SAP R/3 Planning and Configuring Guide

Version 4.9

Overview of the SAP R/3 print feature
Installing and configuring InfoPrint Manager’s OMS
InfoPrint Manager non-OMS support
Customizing your print environment

For information not in this manual, refer to the Help System in your product.

Read this manual carefully and keep it handy for future reference.
TABLE OF CONTENTS

1 Overview of the SAP R/3 print feature

InfoPrint Manager and SAP R/3 ................................................................. 7
Reliable notification of job status to SAP users ......................................... 8
Adding electronic forms, logos, and electronic signatures to text documents ....................................................... 8
Reliable management of the print environment ....................................... 9
Scalability of printing across an enterprise .............................................. 9
SAP clients and features ........................................................................... 9
SAP R/3 GUI keyboard shortcuts ............................................................. 10

2 Installing and configuring InfoPrint Manager’s OMS

InfoPrint Manager’s OMS support ........................................................... 13
  An overview of SAP R/3 and OMS ......................................................... 13
  Installing the SAP Print Feature on the InfoPrint Manager server .......... 14
    Installing InfoPrint fonts for printing with the SAP transform .............. 15
    Configuring the SAP R/3 transform ..................................................... 16
  Installing the InfoPrint Manager OMS support when SAP runs on HP-UX or Sun Solaris ......................................................... 18
    Configuring the InfoPrint Manager Server ......................................... 18
    Configuring the SAP system server .................................................... 21
  Installing the InfoPrint Manager OMS support when SAP runs on AIX ................................................................. 23
  Installing the InfoPrint Manager OMS support when SAP runs on Linux ................................................................. 24
  Installing the InfoPrint Manager OMS support when SAP runs on Windows ................................................................. 26
  Configuring and using the OMS ............................................................. 28
    Required configuration tasks ............................................................. 28
    Using OMS support tasks .................................................................. 40
    Optional OMS configuration tasks ...................................................... 42

3 InfoPrint Manager non-OMS support

Understanding SAP access method L support ........................................ 57
Installing InfoPrint SAP Client support when SAP runs on HP-UX, Linux, or Sun Solaris ......................................................... 57
  Configuring the InfoPrint Manager server ......................................... 58
Introduction

Important

To the maximum extent permitted by applicable laws, in no event will the manufacturer be liable for any damages whatsoever arising out of failures of this product, losses of documents or data, or the use or non-use of this product and operation manuals provided with it.

Make sure that you always copy or have backups of important documents or data. Documents or data might be erased due to your operational errors or malfunctions of the software. Also, you are responsible for taking protective measures against computer viruses, worms, and other harmful software.

In no event will the manufacturer be responsible for any documents created by you using this product or any results from the data executed by you.

Cautions regarding this guide

• Some illustrations or explanations in this guide could differ from your product due to improvement or change in the product.

• The contents of this document are subject to change without notice.

• No part of this document may be duplicated, replicated, reproduced in any form, modified, or quoted without prior consent of the supplier.

• Throughout this publication, references to directory paths indicate the default paths only. If you install InfoPrint Manager or any of its components in a different location, including a different drive, you must adjust the paths accordingly.
  
  For example, if you install InfoPrint Manager on the D: drive of a computer running a Windows operating system, replace C: with D: in the directory paths.

Guides for this application

This publication provides information about InfoPrint Manager for AIX, Linux, and Windows, Version 4.9 (Program Number 5648-F40).

This publication includes an overview of InfoPrint Manager and installation and configuration information about the product.

Instruction manuals

These instruction manuals are included:

For information about InfoPrint Manager, see these documents:

• InfoPrint Manager for Windows: Planning Guide, G550-1071
• InfoPrint Manager for Windows: Getting Started, G550-1072
• InfoPrint Manager for Windows: Procedures, G550-1073
• InfoPrint Manager for Linux: Planning Guide, G550-20262
• InfoPrint Manager for Linux: Getting Started, G550-20263
• InfoPrint Manager for Linux: Procedures, G550-20264
Help

Property help is available on many screens to provide information for specific tasks and settings.

In addition, the Help menu provides access to the HTML version of the instruction manual directly from the user interface.

• A PDF reader, such as Adobe Reader, must be installed to view the PDF documentation.

For more information about RICOH printing products, see:


How to read the documentation

Displaying the instruction manual

Use this procedure to view the instruction manuals.

Displaying the instruction manual in PDF format

• InfoPrint Manager includes publications in PDF format on the DVD-ROM supplied with the product.

Displaying the instruction manual in HTML format

• The HTML version of the instruction manual is available directly from the user interface. Start the application, and then click button at the right of the banner and select Help.
Displaying property help

Click the button next to a property on the user interface to display the property help for that item.

Symbols

The following symbols are used in this manual to help you to identify content quickly.

This symbol indicates points to pay attention to when using the product. Be sure to read these explanations.

This symbol indicates helpful supplementary information that is not essential to completing a task.

Bold

Bold type indicates the names of dialogs, menus, menu items, settings, field labels, buttons, and keys.

Italic

Italic type indicates the titles of manuals and variables that you must replace with your own information.

Monospace

Monospace type indicates computer input and output.

Abbreviations

AFP

Advanced Function Presentation

IP

Internet Protocol

PDF

Portable Document Format

PCL

Printer Command Language

GIF

Graphical Interchange Format

JPEG

Joint Photographic Experts Group

TIFF

Tagged Image File Format
Trademarks

These terms are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both:

- AIX
- DFS
- HACMP
- IBM
- MVS
- OS/2
- OS/390
- POWER
- PowerHA SystemMirror
- Print Services Facility
- pSeries
- S/370
- S/390
- z/OS

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

CUPS is a trademark of Apple Inc. in the United States, other countries, or both.

Linux is the registered trademark of Linus Torvalds in the U.S. and other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

SafeNet code: The license management portion of this Licensee Application is based upon one or more of the following copyrights:

Sentinel RMS
Copyright 1989-2006 SafeNet, Inc.
All rights reserved.

Sentinel Caffe (TM)
Copyright 2008-2009 SafeNet, Inc.
All rights reserved.

Sentinel EMS
Copyright 2008-2009 SafeNet, Inc.
All rights reserved.

Other company, product, or service names may be trademarks or service marks of others.
1. Overview of the SAP R/3 print feature

- InfoPrint Manager and SAP R/3
- Reliable notification of job status to SAP users
- Adding electronic forms, logos, and electronic signatures to text documents
- Reliable management of the print environment
- Scalability of printing across an enterprise
- SAP clients and features
- SAP R/3 GUI keyboard shortcuts

This section describes the benefits derived by business enterprises that use SAP R/3 and InfoPrint Manager for AIX, InfoPrint Manager for Linux, or InfoPrint Manager for Windows to manage their print environments.

Ricoh is a valuable SAP software solution partner, and InfoPrint Manager is a SAP-certified integration solution with the SAP NetWeaver technology platforms.

Figure 1 show the SAP R/3 partner logo, and Figure 2 shows the SAP Certified Powered by SAP NetWeaver technology logo.

SAP R/3 partner logo.

SAP Certified Powered by SAP NetWeaver technology logo.

**InfoPrint Manager and SAP R/3**

A large international corporation is committed to an SAP R/3 enterprise to manage their data processing across all departments. They especially appreciate the SAP R/3 option provided by InfoPrint Manager. InfoPrint Manager and SAP R/3 combine to provide a robust solution that manages all printing the way SAP R/3 manages and keeps track of their entire business, from external documents sent to customers, to reports created for internal distribution and printed at the desktop. Because InfoPrint Manager can manage both the high-end production printers and the low-end desktop (network) printers, it meets their needs like no other print application on the market today.
SAP R/3 has become a popular choice for medium to large-sized companies that require an integrated software product to provide basic business automation. The R/3 client/server application provides business a series of integrated modules that span the major functions of finance, manufacturing, sales distribution, and human resources. InfoPrint’s four decades of experience in printing and data management translates into billions of pages printed annually in more than 130 countries, solidifying our leadership position in the enterprise printing environment. Integrate InfoPrint’s printing expertise with SAP’s leading business application software for a winning combination.

Reliable notification of job status to SAP users

SAP R/3 (Release 4 and later) provides support to closely integrate an external Output Management System (OMS) with an SAP system. InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows provide SAP OMS support.

Using InfoPrint Manager SAP OMS support, your SAP users can receive notifications on the jobs that they have submitted for printing. It also provides support to allow an SAP user to:

- Cancel one or more jobs
- Query the status of one or more jobs
- Query the status of an InfoPrint printer and its jobs

Adding electronic forms, logos, and electronic signatures to text documents

The Advanced Function Presentation (AFP) data stream that emerges from the InfoPrint SAP transform contains text records that you can enhance through the addition of electronic forms, logos, and electronic signatures. In addition to the AFP resources, the InfoPrint Manager SAP transform has been enhanced to support both raw image data (bitmap images) and box shading. The expanded support for different levels of box shading and the print images that SAP R/3 users have come to expect and appreciate provides a strong, industry standard for printing from SAP R/3. Print SAP color images in...
black and white, using the native Output Text Format (OTF) data stream in either one-, four-, or eight-bit pixel images: InfoPrint Manager can handle it all. And InfoPrint Manager’s globalization enablement supports these scripts:

- Latin
- Japanese (Shift-JIS encoding)
- Korean
- Simplified Chinese
- Traditional Chinese
- Cyrillic

Even if you are printing on PCL and PPDS non-impact printers, the SAP Print Feature provides benefit by allowing you to print bar codes without installing expensive bar code SIMMs on each printer. InfoPrint Manager allows a world-class set of business application modules designed for a client-server environment the ability to achieve world-class printing.

### Reliable management of the print environment

With InfoPrint Manager, you can manage printers and devices from a single point of control. You can track and manage jobs across your enterprise from job submission to printed output. When output does not print, operators no longer have to determine whether a spool request was generated. Instead of having to walk over to the printer, they can use the InfoPrint Manager graphical user interface (GUI) to pinpoint where in the process the job is delayed and determine the appropriate action to resolve the problem. InfoPrint Manager provides automatic workload balancing among printers that you have defined with the same characteristics. For more information about how to configure printers and monitor printing across an installation, see InfoPrint Manager for AIX: Procedures, InfoPrint Manager for Linux: Procedures, or InfoPrint Manager for Windows: Procedures.

The InfoPrint Manager SAP OMS support also lets you easily:

- Switch the InfoPrint Manager system to which you are sending jobs
- Send jobs to multiple InfoPrint Manager systems
- Failover to other InfoPrint Manager servers in the same InfoPrint Manager system

### Scalability of printing across an enterprise

InfoPrint Manager allows SAP R/3 customers to access the full range of InfoPrint printers (low-speed to high-speed, simplex or duplex, continuous forms, or cut sheet) as well as other printers, such as Hewlett-Packard and Lexmark. You can leverage your investment in printers by sharing your InfoPrint-managed printers with other host, and LAN-based applications. InfoPrint Manager provides the SAP R/3 enterprise with comprehensive print management across an enterprise of any size, providing print integrity through built-in error recovery. InfoPrint Manager supports SAProuter function for a better control, security and performance of your SAP system environment.

### SAP clients and features

InfoPrint Manager provides client support for SAP systems running on AIX, HP-UX, Linux, Sun Solaris, and Windows. By installing an InfoPrint Manager SAP client, you can always print PCL and PostScript jobs, but to gather the additional support cited in Table SAP Print Feature functions and operating systems, p. 10, you must install the SAP Print Feature on your InfoPrint server. The InfoPrint Manager for AIX, InfoPrint Manager for Linux, and the InfoPrint Manager for Windows SAP Print Features contain...
both the SAP Output Management support and the SAP transform that allows SAPGOF device type output to be transformed to AFP for printing on PCL and IPDS printers.

**SAP Print Feature functions and operating systems**

<table>
<thead>
<tr>
<th>InfoPrint Manager server systems</th>
<th>OMS support</th>
<th>SAPGOF device type (OTF and ABAP) Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Linux</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Windows</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

**SAP R/3 GUI keyboard shortcuts**

Table SAP R/3 keyboard shortcuts, p. 10 provides a list of keyboard shortcuts that can be used while doing some of the procedures described in this book. Because this is an InfoPrint Manager publication, these shortcuts are not a complete list of all options available on the SAP R/3 GUI for all releases. The SAP R/3 GUI Window or Windows column lists particular windows in the SAP R/3 GUI where these shortcuts work, but does not imply that the shortcut is exclusive for a particular panel or task. In addition, the SAP R/3 GUI might change keyboard shortcuts from release to release. We recommend that you consult the SAP R/3 online documentation that comes with the product to verify keyboard shortcuts for your particular SAP R/3 release.

**SAP R/3 keyboard shortcuts**

<table>
<thead>
<tr>
<th>Shortcut key or combination</th>
<th>Task</th>
<th>SAP R/3 GUI window or windows where applicable</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2</td>
<td>Choose (checkmark with a clock) icon</td>
<td>Spool Administration windows</td>
</tr>
<tr>
<td>F5</td>
<td>Events icon</td>
<td>Status Description window</td>
</tr>
<tr>
<td>F6</td>
<td>Extended Admin.:</td>
<td>Spool Administration windows</td>
</tr>
<tr>
<td>F8</td>
<td>Change (red pencil) icon</td>
<td>Spool Administration windows</td>
</tr>
<tr>
<td>F8</td>
<td>Query icon</td>
<td>Status Description pop-up window (derived from Spool Output Requests for Spool Request XXXXXX)</td>
</tr>
<tr>
<td>F8</td>
<td>Test RFC connection</td>
<td>RFC Destination dest_name window</td>
</tr>
<tr>
<td>F11</td>
<td>Save</td>
<td>RFC Destination dest_name window</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save (open folder) icon</td>
<td>SAP R/3 GUI</td>
</tr>
<tr>
<td>Ctrl + F1</td>
<td>Extended config. (photo film with two cards superimposed on top) icon</td>
<td>Spool Administration windows</td>
</tr>
<tr>
<td>Shortcut key or combination</td>
<td>Task</td>
<td>SAP R/3 GUI window or windows where applicable</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------</td>
</tr>
<tr>
<td>shift + F2</td>
<td>Trash can icon</td>
<td>Spool Output Requests for Spool Request XXXXXXX</td>
</tr>
<tr>
<td>shift + F5</td>
<td>Transport (truck) icon</td>
<td>Spool Admin.: Real Output Management System</td>
</tr>
<tr>
<td>shift + F6</td>
<td>Transport all (truck) icon</td>
<td>Spool Admin.: Real Output Management System</td>
</tr>
<tr>
<td>shift + F6</td>
<td>Spool Requests icon</td>
<td>Spool Administration: List of Output Devices window</td>
</tr>
</tbody>
</table>
2. Installing and configuring InfoPrint Manager's OMS

- InfoPrint Manager's OMS support
- Installing the SAP Print Feature on the InfoPrint Manager server
- Installing the InfoPrint Manager OMS support when SAP runs on HP-UX or Sun Solaris
- Installing the InfoPrint Manager OMS support when SAP runs on AIX
- Installing the InfoPrint Manager OMS support when SAP runs on Linux
- Installing the InfoPrint Manager OMS support when SAP runs on Windows
- Configuring and using the OMS

InfoPrint Manager's OMS support

SAP R/3 Release 4 and later provides support to closely integrate an external output management system (OMS) with an SAP system. InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows are SAP OMSs that provide synchronous functions for submitting jobs, canceling jobs, querying jobs, and querying devices, as well as asynchronous event information. InfoPrint Manager SAP Callback daemon (on AIX and Linux) or process (on Windows) collects and delivers these events to the R/3 system.

1. This support is not currently available on an SAP R/3 Release 3 system. If you are either using an SAP R/3 Release 3 system or do not want to use the OMS support, see InfoPrint Manager non-OMS support, p. 57.

2. Support for SAP R/3 Release 3.1h is still available. For more information, contact your service representative.

An overview of SAP R/3 and OMS

The InfoPrint Manager SAP OMS support consists of a command-line interface and either an SAP callback daemon (on AIX and Linux) or an SAP callback process (on Windows) that logs onto an SAP system and delivers InfoPrint Manager notifications back to SAP R/3 by making RFCs (remote function calls). As print, cancel job, query job, and device query requests are made by SAP users, the SAP Spool Work Process (SWP) invokes the InfoPrint Manager commands. As the job progresses through the InfoPrint Manager system, notifications are sent back to SAP through the InfoPrint Manager SAP Callback daemon (sapcbd) or the SAP Callback process (sapcbd.exe). Only one SAP Callback daemon or process needs to be started for each SAP system, regardless of how many application servers make up that system. The SAP Callback daemon or process runs on the same server where InfoPrint Manager is running.

In InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows, the InfoPrint Manager SAP Print Feature contains:

- Command-line interface
- SAP Callback daemon (sapcbd) on AIX and Linux, and the SAP Callback process (sapcbd.exe) on Windows
- SAP (sap2afp) transform

The InfoPrint Manager SAP Clients contain the command-line interface.

To allow either the sapcbd daemon or the sapcbd.exe process to deliver InfoPrint Manager notifications to an SAP system, you must install the SAP Print Feature on at least one system where the InfoPrint
Manager servers are running. To allow SAPGOF device type output (both OTF and ABAP data streams) to be transformed and processed by InfoPrint Manager, you must install the SAP Print Feature on every system where InfoPrint Manager actual destinations are going to transform SAP data.

To install the SAP Print Feature on an InfoPrint server, see Installing the SAP Print Feature on the InfoPrint Manager server, p. 14.

To allow SAP to issue the InfoPrint Manager commands, you must install a InfoPrint Manager SAP Client on every SAP server where an SAP application server will issue the commands. This includes every application server with an SWP managing R/3 devices that have been configured to use the InfoPrint Manager OMS. If you have configured your SAP R/3 system to use alternate servers, you must repeat these installation tasks on the alternate servers as well.

To install and configure InfoPrint Manager as an SAP R/3 OMS when SAP:

- Runs on other HP-UX, Linux, or Sun Solaris servers, follow the procedures described in Installing the InfoPrint Manager OMS support when SAP runs on HP-UX or Sun Solaris, p. 18
- Runs on an AIX operating system, follow the procedures described in Installing the InfoPrint Manager OMS support when SAP runs on AIX, p. 23
- Runs on a Windows operating system, follow the procedures described in Installing the InfoPrint Manager OMS support when SAP runs on Windows, p. 26

Notes

1. The SAP Print Feature is available on InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows as a separately-priced feature that can be installed from the InfoPrint Manager: SAP Print Feature DVD-ROM, LCD4-5646.

2. The AIX, Linux, and Windows SAP clients are available to install from the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642.
   The SAP clients for HP-UX, Linux, and Sun Solaris systems are available on the SAP Print Feature and are specific to either InfoPrint Manager for AIX servers, InfoPrint Manager for Linux servers, or InfoPrint Manager for Windows servers.

3. If you are using an InfoPrint Windows server, use FTP to send the files to the HP-UX, Linux, or Sun Solaris system before editing the files as described in Configuring the SAP system server, p. 21. If you edit the files on a Windows system, the format will not be correct for the HP-UX, Linux, or Sun Solaris systems.

4. These procedures presume that you have already installed and configured InfoPrint Manager on a separate AIX, Linux, or Windows server.

5. An SAP OMS interface restriction requires that your InfoPrint server (pdserver) name be no longer than nine characters.

Installing the SAP Print Feature on the InfoPrint Manager server

To run an InfoPrint Manager for AIX SAP callback daemon, InfoPrint Manager for Linux SAP callback daemon, or an InfoPrint Manager for Windows SAP callback process, you must install the SAP Print Feature on at least one of your InfoPrint servers, if you have not already done so.

If you are printing either Output Text Format (OTF) or Advanced Business Application Programming (ABAP) data, make sure that you have installed the sap2afp transform and the fonts necessary for printing. To install the transform, you must install the SAP Print Feature on each InfoPrint Manager AIX
server, InfoPrint Manager for Linux server, or InfoPrint Manager Windows server with actual destinations that will be transforming data.

**Note**

- If your SAP Server runs in IPv6 mode, in order for the SAP Callback Daemon to work, you must set the environment variable `SAP_IPv6_ACTIVE` with the value 1, both on the SAP Server machine and also on the InfoPrint Manager server machine. In this case, the InfoPrint Manager server must also run on a machine that is IPv6 enabled.

- At a minimum, on every AIX or Linux system on which you will be running the SAP (sap2afp) transform (on your InfoPrint Manager servers), you must have the ICU (InfoPrint Manager UCONV) fileset or package installed.

To install the InfoPrint Manager for AIX SAP Print Feature on your AIX server, see InfoPrint Manager for AIX: Getting Started.

To install the InfoPrint Manager for Linux SAP Print Feature on your Linux server, see InfoPrint Manager for Linux: Getting Started.

To install the SAP Print Feature on your InfoPrint Manager Windows server, follow the directions under the Installing InfoPrint Manager server software topic in InfoPrint Manager for Windows: Getting Started.

To install the necessary fonts and configure the SAP transform on the InfoPrint Manager AIX server, InfoPrint Manager for Linux server, and the InfoPrint Manager Windows server, see the rest of this chapter.

### Installing InfoPrint fonts for printing with the SAP transform

The InfoPrint Font Collection consists of character sets and Advanced Function Presentation (AFP) code pages that let you print standard documents using familiar typefaces such as Helvetica, Times New Roman, and Courier. The code pages allow you to print in more than 50 languages. To support certain applications or low-resolution AFP/Intelligent Print Data Stream (IPDS) printers that use raster fonts, the InfoPrint Font Collection also includes AFP raster fonts. AFP outline fonts, which are delivered as part of the InfoPrint Font Collection, can be substituted for raster fonts in certain situations to enable higher resolution output. In addition, the InfoPrint Font Collection provides WorldType fonts, which are TrueType/OpenType fonts that deliver the greatest flexibility for designing documents with exactly the appearance you want.

You can obtain these resources by ordering the AFP Asian Classic TrueType Collection and OpenType and the InfoPrint Font Collection, Version 3.6.0, from your sales representative. For your convenience, the InfoPrint Font Collection and AFP Asian Classic TrueType Collection and OpenType are shipped with InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows:

- InfoPrint Font Collection: AFP Outline Fonts, LCD4-5683 (DVD). This DVD includes AFP Outline fonts, CID fonts, and Type1 fonts.
- InfoPrint Font Collection: AFP Classic Fonts, LCD2-20029 (DVD). This DVD includes AFP Classic with Courier, Helvetica and Times New Roman typefaces in a True-Type/OpenType font format fonts.
- InfoPrint Font Collection: WorldType Fonts, LCD4-5684-06 (DVD). This DVD includes TrueType/OpenType fonts.
• Infoprint Font Collection: AFP Raster Fonts, LCD4-5700-02 (DVD). This DVD includes AFP Raster fonts.

• AFP Asian Classic TrueType Collection and OpenType fonts, LCD2-20055-01 (DVD). This DVD includes AFP Asian Classic TrueType Collection and OpenType fonts.


To install the fonts that are required to transform OTF or ABAP data from SAP R/3 on an InfoPrint Manager system, use the installation procedure that comes with the InfoPrint Font Collection documentation (Readme.pdf).

### Configuring the SAP R/3 transform

Depending upon the types of data you are printing, you might need to configure some of the files that are provided with the SAP transform. For example:

- To use form definitions that are mapped to SAP Formats (Paper Types), you must configure the pagedef.tab file as described in Changing document print orientation, p. 71.
- If you have created a new font in an SAP R/3 document, you must configure the fonts.tab file as described in Setting up your SAP R/3 system to support new OTF user fonts, p. 88.
- To expand or shorten the width of a barcode for printing, you must configure the barcode.tab file as described in Bar codes and printing from SAP R/3 through InfoPrint Manager, p. 96.

The SAP transform includes two types of files:

- An executable named sap2afp, which converts Output Text Format (OTF) data into MO:DCA-P output data and Advanced Business Application Programming (ABAP) list format data into line data. On an InfoPrint Manager AIX server or InfoPrint Manager Linux server, this file is installed in the /usr/lpp/psf/bin directory. On an InfoPrint Manager Windows server, this file is installed in the install_path\bin path.
- SAP (sap2afp) transform configuration files for AIX or Linux, p. 16 shows the configuration files that are installed in either the /usr/lpp/psf/sap2afp directory on an InfoPrint Manager AIX server and InfoPrint Manager Linux server, or the install_path\sap2afp path on an InfoPrint Manager Windows server.

#### SAP (sap2afp) transform configuration files for AIX or Linux

<table>
<thead>
<tr>
<th>Configuration file</th>
<th>Purpose</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>barcode.tab</td>
<td>Provides list of valid SAP bar codes.</td>
<td>OTF data only</td>
</tr>
<tr>
<td>xxxxxxxx.tab</td>
<td>Maps ASCII code pages to EBCDIC code pages.</td>
<td>OTF data only</td>
</tr>
<tr>
<td>fonts.tab</td>
<td>Provides a list of raster fonts with the appropriate character set and code page.</td>
<td>OTF data only</td>
</tr>
<tr>
<td>Configuration file</td>
<td>Purpose</td>
<td>Use</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>6400fonts.tab</td>
<td>Provides a list of raster fonts that apply exclusively to the 6400 printer, with the appropriate character set and code page.</td>
<td>OTF data only</td>
</tr>
<tr>
<td>image.tab</td>
<td>Defines the dither matrix for half-tone color print jobs.</td>
<td>OTF data only</td>
</tr>
<tr>
<td>pagedef.tab</td>
<td>Defines the form definition (SAP PAPER TYPE) used, as well as the page definition and fonts for jobs that go through ACIF.</td>
<td>ABAP/OTF</td>
</tr>
<tr>
<td>pagedef.tab.unicode</td>
<td>Processes ABAP files in Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>pagedef.tab.japan</td>
<td>Processes ASCII-encoded ABAP files containing Japanese characters in a non-Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>pagedef.tab.korea</td>
<td>Processes ASCII-encoded ABAP files containing Korean characters in a non-Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>pagedef.tab.spchinese</td>
<td>Processes ASCII-encoded ABAP files containing Simplified Chinese characters in a non-Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>pagedef.tab.tdchinese</td>
<td>Processes ASCII-encoded ABAP files containing Traditional Chinese characters in a non-Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>pagedef.tab.cyr</td>
<td>Processes ASCII-encoded ABAP files containing Cyrillic characters in a non-Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>defcp.tab</td>
<td>Converts ASCII into EBCDIC characters.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>defcp.tab.unicode</td>
<td>Processes ABAP files in Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>defcp.tab.japan</td>
<td>Processes ASCII-encoded ABAP files containing Japanese characters in a non-Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>defcp.tab.korea</td>
<td>Processes ASCII-encoded ABAP files containing Korean characters in a non-Unicode environment.</td>
<td>ABAP data only</td>
</tr>
</tbody>
</table>
### Configuration file

<table>
<thead>
<tr>
<th>Configuration file</th>
<th>Purpose</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>defcp.tab.spchinese</td>
<td>Processes ASCII-encoded ABAP files containing Simplified Chinese characters in a non-Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>defcp.tab.tdchinese</td>
<td>Processes ASCII-encoded ABAP files containing Traditional Chinese characters in a non-Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>defcp.tab.cyr</td>
<td>Processes ASCII-encoded ABAP files containing Cyrillic characters in a non-Unicode environment.</td>
<td>ABAP data only</td>
</tr>
<tr>
<td>userenv</td>
<td>Specifies the environment for the ASCII-encoded ABAP files</td>
<td>ABAP</td>
</tr>
</tbody>
</table>

### Installing the InfoPrint Manager OMS support when SAP runs on HP-UX or Sun Solaris

SAP R/3 installations that run on HP-UX or Sun Solaris systems work with InfoPrint Manager when these installations are configured to invoke commands remotely on the InfoPrint server.

To use the OMS support of the SAP Print Feature with an SAP R/3 system running on a non-AIX UNIX system, you must install the SAP feature on the InfoPrint server and do these tasks:

1. Configuring the InfoPrint Manager Server, p. 18
2. Configuring the SAP system server, p. 21

### Configuring the InfoPrint Manager Server

Follow the appropriate procedure depending on which version of InfoPrint Manager you are using:

- Configuring the InfoPrint Manager AIX server, p. 18
- Configuring the InfoPrint Manager Linux server, p. 19
- Configuring the InfoPrint Manager Windows server, p. 20

### Configuring the InfoPrint Manager AIX server

To configure the AIX server that has already installed InfoPrint Manager with the SAP Print Feature:

1. Add a user called sapuser. This user does not have to be part of any special groups.
2. Authorize the sapuser userid to issue remote commands by adding this entry to the /etc/hosts.equiv file:

```
+ sapuser
```
3. Authorize all remote servers running the SAP R/3 application to specify remote commands on the InfoPrint Manager AIX server as sapuser:

   1. Add an .rhosts file with permissions of 600 to the /home/sapuser directory.
   2. Edit the .rhosts file and add a line for each non-AIX server running an SAP R/3 application with a plus (+) sign appended to it.

For added accountability among SAP systems and print jobs, you can create separate AIX users for each SAP system or SAP R/3 application server. Follow the three steps specified in this topic to create additional users (like sapuser) that are mapped to each application server from which you will be using InfoPrint Manager to print.

For more information about using the rsh and rcp commands to connect to the InfoPrint Manager AIX server and send files between servers, see your AIX Operating System documentation.

**Turning off GOCA support on an AIX server**

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an AFP data architecture used to represent pictures generated by computer. If your installation uses older printers (for example, 3900 printers as opposed to InfoPrint 4000 printers), GOCA support can cause the printers to print at less than rated speed. If your applications do not require GOCA support features, such as box shading, you might want to improve performance by turning off the GOCA support.

If your HP-UX or Sun Solaris client is connected to an InfoPrint Manager AIX server, go to the AIX server and use this procedure:

1. Access the ipm_submit file that reside in the /usr/lpp/pd/bin directory.
2. Using your AIX editor of choice, comment out the `otheroptions="other-transform-options=-g";` line by placing a hash mark (#) in front of the line.

You can also turn off this support at a later date, as described in Adding box shading values to printed output, p. 91.

**Configuring the InfoPrint Manager Linux server**

To configure the Linux server that has already installed InfoPrint Manager with the SAP Print Feature:

1. Add a user called sapuser. This user does not have to be part of any special groups.
2. Authorize the sapuser userid to issue remote commands by adding this entry to the /etc/hosts.equiv file:

   ```
   + sapuser
   ```

3. Authorize all remote servers running the SAP R/3 application to specify remote commands on the InfoPrint Manager Linux server as sapuser:

   1. Add an .rhosts file with permissions of 600 to the /home/sapuser directory.
   2. Edit the .rhosts file and add a line for each non-Linux server running an SAP R/3 application with a plus (+) sign appended to it.

For added accountability among SAP systems and print jobs, you can create separate Linux users for each SAP system or SAP R/3 application server. Follow the three steps specified in this topic to create additional users (like sapuser) that are mapped to each application server from which you will be using InfoPrint Manager to print.
For more information about using the rsh and rcp commands to connect to the InfoPrint Manager Linux server and send files between servers, see your Linux Operating System documentation.

**Turning off GOCA support on an Linux server**

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an AFP data architecture used to represent pictures generated by computer. If your installation uses older printers (for example, 3900 printers as opposed to InfoPrint 4000 printers), GOCA support can cause the printers to print at less than rated speed. If your applications do not require GOCA support features, such as box shading, you might want to improve performance by turning off the GOCA support.

If your HP-UX or Sun Solaris client is connected to an InfoPrint Manager Linux server, go to the Linux server and use this procedure:

1. Access the ipm_submit file that reside in the /usr/lpp/pd/bin directory.
2. Using your Linux editor of choice, comment out the `othertoptions="other-transform-options='-g'"` line by placing a hash mark (#) in front of the line.

You can also turn off this support at a later date, as described in Adding box shading values to printed output, p. 91.

**Configuring the InfoPrint Manager Windows server**

The rshd and rexecd services are prerequisites for HP-UX and Sun Solaris SAP client support.

Use this procedure to configure the Windows server that has already installed InfoPrint Manager with the SAP Print Feature:

1. Install both an rshd and rexecd service on your InfoPrint Manager Windows server.

   **Note**

   During the installation of these services, make sure that remote users are defined users on the InfoPrint Manager for Windows system so that it is possible to write to this server from the Windows SAP client system.

2. From the Start menu, access the Programs → Administrative Tools → User Manager path.
3. Create a new user named sapuser.

   **Note**

   This user does not have to be part of any special groups.

4. Authorize the sapuser userid to issue remote commands by adding this entry to the .rhosts or equivalent file: `+sapuser`.
5. Authorize all remote servers running the SAP R/3 applications to specify remote commands on the InfoPrint Manager Windows server by specifying:

   ```
   fully_qualified_server_name +
   ```

   where fully_qualified_server_name is either the IP address (in dotted decimal format) or the host name of the server.
Notes

1. If you use a host name, TCP/IP must be able to resolve that name through either the security file or through a Domain Name Server (DNS).

2. If a DNS is not being used, but the host name is specified in the hosts file, specify the fully qualified name in the .rhosts or equivalent file.

3. If a DNS is not being used, and the host name is not specified in the hosts file, you must specify an IP address in the .rhosts or equivalent file (for example, 172.16.8.10 +).

For added accountability among SAP systems and print jobs, you can create separate users for each SAP system or SAP R/3 application server. Repeat steps two through five below to create new user IDs that you can map to each SAP application server from which you plan to use InfoPrint Manager to print.

Turning off GOCA support on a Windows server

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an AFP data architecture used to represent pictures generated by computer. If your installation uses older printers (for example, 3900 printers as opposed to InfoPrint 4000 printers), GOCA support can cause the printers to print at less than rated speed. If your applications do not require GOCA support features, such as box shading, you might want to improve performance by turning off the GOCA support.

If your HP-UX or Sun Solaris client is connected to an InfoPrint Manager Windows server, access the ipmcfg file from the directory where you installed InfoPrint Manager. When you click this file, it displays the IPM Server Settings dialog. From here, you can click IPM GOCA Support to remove the check.

You can also turn off this support at a later date, as described in Adding box shading values to printed output, p. 91.

Configuring the SAP system server

To allow SAP on HP-UX or Sun Solaris to issue the InfoPrint Manager commands, you must install the InfoPrint Manager SAP Client on every SAP server where an SAP application server will issue the commands. This includes every application server with a spool work process (SWP) managing R/3 devices that have been configured to use the InfoPrint Manager OMS. If you have configured your SAP R/3 system to use alternate servers, you must repeat these installation tasks on the alternate servers as well.

Use this procedure to configure remote servers (HP-UX, Sun) running the SAP R/3 application so you can print with InfoPrint Manager:

1. Obtain access to each HP-UX or Sun Solaris server running SAP R/3 and log on.

2. Verify that you can ping the InfoPrint Manager server by host name:

   ```
   ping -c 3 hostname
   ```

   where hostname is the unqualified name for the InfoPrint Manager server, such as nwser.

   If the response shows that a good communication path exists, you will see this:

   ```
   ----tcpip_addr PING Statistics----
   packets transmitted, 3 packets received, 0% packet loss
   ```
round-trip min/avg/max = 7/7/7 ms

3. If you cannot ping the InfoPrint Manager server by host name, edit the /etc/hosts file and add the host name and IP address of the InfoPrint Manager server:

For IPv4:

/etc/hosts: 9.99.11.109 nwser

For IPv6:

[2001:0ce8:58a3:0000:0000:6a2e:0370:3734]

4. Create a directory named /usr/lpp/pd/bin:

```
mkdir /usr/lpp/pd/bin
```

5. Use the file transfer protocol (FTP) client of your choice to copy either the /usr/lpp/pd/bin/ipm.omsdesc file from the InfoPrint Manager AIX server and InfoPrint Manager Linux server, or the install_path\bin\ipm.omsdesc from the InfoPrint Manager Windows server to at least one of the SAP R/3 servers running the SAP R/3 application.

This file contains the InfoPrint Manager OMS definition that is loaded into the SAP R/3 System.

Make sure that the file is readable by the sysadmin (where sys is the three-character SAP system name) on the SAP R/3 application system.

6. Use the FTP client of your choice to copy these files from the InfoPrint Manager server to an SAP R/3 application server in your configuration. If you are using an InfoPrint Manager AIX server or InfoPrint Manager Linux server, these files reside in the /usr/lpp/pd/bin directory. If you are using an InfoPrint Manager for Windows server, these files reside in the install_path\bin folder:

- ipm_submit.sys
- ipm_job_cancel.sys
- ipm_job_query.sys
- ipm_dev_query.sys

For the secondary qualifier (sys), specify the name of the system where your SAP applications are running: hp for HP-UX or sun for Sun Solaris.

7. Make sure that each file copied in Step 6 is executable.

8. On the SAP application server in your installation, edit both files so they specify the name of the user (sapuser) and host name where InfoPrint Manager is running. If you want the SAP Client for HP-UX or Sun Solaris to use the secure shell (SSH) and secure copy (SCP) commands, you must edit these files so that they specify the secure shell commands. The default behavior of the SAP Clients is to use the remote shell commands (RSH).

To use the secure shell commands, you must change the value rsh to ssh:

```
# change the line below from "rsh" to "ssh" for secure shell
remote_shell="rsh"
```

9. Copy the four edited SAP command files to any other SAP application servers in your installation that use the InfoPrint Manager server.

10. To complete the configuration, complete the procedures in Configuring and using the OMS, p. 28.
Installing the InfoPrint Manager OMS support when SAP runs on AIX

To allow SAP on AIX to issue the InfoPrint Manager commands, you must install the InfoPrint Manager SAP Client on every SAP server where an SAP application server will issue the commands. This includes every application server with an SWP managing R/3 devices that have been configured to use the InfoPrint Manager OMS. If you have configured your SAP R/3 system to use alternate servers, you must repeat these installation tasks on the alternate servers as well.

To install the SAP Client for AIX on your SAP application servers, use this procedure:

1. Log into the AIX system as root.
2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642 into the DVD-ROM reader.
3. Open a terminal window.
   
   If you are using the Common Desktop Environment (CDE), you can open a terminal window by clicking on the terminal icon contained in the front panel. (The front panel is the task bar that appears at the bottom of the screen.) By default, the terminal icon is contained in a pop-up menu above the text editor icon that appears on the front panel.

4. The first time you run the Installer, follow this procedure:
   
   1. Type this on the command line:
      ```sh
      smit cdrfs
      ```
   
   2. Select **Add a CDROM File System** from the list of choices presented.
   
   3. Click the List button and select your DVD-ROM device name (cd0, for example).
   
   4. Type this in the **MOUNT POINT** field:
      ```sh
      /cdrom
      ```

5. Click **OK**. The running person will raise his arms to indicate success. If he instead falls down and you see `crfs: 0506-909 /cdrom file system already exists`, do not interpret this as a failure. (The existing /cdrom file system should be usable.)

6. Press the F12 key to exit SMIT.

5. Type this on the command line:

   ```sh
   mount /cdrom
   ```

6. The SAP Client package (ipr.sapclient) is installed at the command line by specifying `setup -x`.

   During the course of the install, you are prompted to specify values for both PDHOST and PD_SOCKET.

   These environment variables become effective the next time you reboot the system. To start using the OMS support without rebooting, edit these four files that are found in the /usr/lpp/pd/bin directory:

   - ipm_submit
   - ipm_job_query
   - ipm_job_cancel
   - ipm_dev_query
Locate and uncomment the lines:

```
#export PDHOST
#export PD_SOCKET
```

Specify the same values that you specified during the install.

For another way to specify or change the InfoPrint Manager host and socket information to point to another InfoPrint Manager system or server, see Switching InfoPrint Manager servers, p. 47. You can also provide a failover connection to another InfoPrint Manager server in the same InfoPrint Manager system (see Failing over to other servers in the same InfoPrint Manager system, p. 49) and how to send jobs to more than one InfoPrint Manager system at the same time (see Supporting multiple InfoPrint Manager systems, p. 44).

**Notes**

1. The SAP Client package cannot be installed if other ipr* filesets reside on an SAP application server.

2. If your installation uses older printers (for example, 4000 printers instead of InfoPrint 4100 printers), the GOCA support can cause the printers to print at less than rated speed. If your applications do not require GOCA support features, such as box shading, you might want to improve performance by turning off the GOCA support. For instructions on turning off this support after installing the SAP Client, see Adding box shading values to printed output, p. 91.

To complete the configuration, complete the procedures described in Configuring and using the OMS, p. 28.

**Important**

- If you are upgrading your SAP client, make sure that you follow these steps:
  1. Use the `/etc/rc.iprsap` command to start all sap-daemons contained in the `/etc/rc.iprsap.daemons` file.
  2. Update the `/etc/rc.iprsap.daemons` file containing the startcbd commands incl. parameters:
     - Access the rc.iprsap.daemons file in the `/etc` directory.
     - Edit the file and add this command: "/usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User Client Password Language".
  3. Edit the `/etc/hosts` file and add the host name and the IP address of the SAP server (for example, `192.168.11.109 sapsrv`).
  4. Update the `inittab` file to remove custom startcbd references.

### Installing the InfoPrint Manager OMS support when SAP runs on Linux

To allow SAP on Linux to issue the InfoPrint Manager commands, you must install the InfoPrint Manager SAP Client on every SAP server where an SAP application server will issue the commands. This includes every application server with an SWP managing R/3 devices that have been configured to use the InfoPrint Manager OMS. If you have configured your SAP R/3 system to use alternate servers, you must repeat these installation tasks on the alternate servers as well.
To install the SAP Client for Linux on your SAP application servers, use this procedure:

1. Log into the Linux system as root.
2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642, into the drive.
3. Open a terminal window.
4. The first time you run the Installer, follow this procedure:
   1. If you are installing from the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642:
      1) Insert the DVD-ROM into the drive.
      2) Mount the file system by typing:
         ```
         cd /media/<mount_point>/linux
         ```
      4) Install the Linux SAP Client package, 32-bit or 64-bit depending on your operating system, by typing:
         ```
         rpm -i ipr-client-sap.4.5.m-n.i686.rpm (32 bit)
         ```
         ```
         rpm -i ipr-client-sap.4.5.m-n.x86_64.rpm (64 bit)
         ```
         where \( m \) and \( n \) represent the service update level.
      5) If you are upgrading the InfoPrint Manager: Linux SAP Client from a previous version, you need to run:
         ```
         rpm -U ipr-client-sap.4.5.m-n.i686.rpm (32 bit)
         ```
         ```
         rpm -U ipr-client-sap.4.5.m-n.x86_64.rpm (64 bit)
         ```
         where \( m \) and \( n \) represent the service update level.
      6) Unmount the media/<mount_point>/ file system.
      7) Remove the Common Client DVD-ROM.

2. Test the system:
   1) Log off and log back on to pickup the changes.
   2) Issue one of the commands, followed by the -h flag to display the syntax of that command and verify the installation.
      For example:
      ```
      pdls -h
      ```

These environment variables become effective the next time you reboot the system. To start using the OMS support without rebooting, edit these four files that are found in the /usr/lpp/pd/bin directory:

- ipm_submit
- ipm_job_query
- ipm_job_cancel
• ipm_dev_query

Locate and uncomment the lines:

```
#export PDHOST
#export PD_SOCKET
```

Specify the same values that you specified during the install.

For another way to specify or change the InfoPrint Manager host and socket information to point to another InfoPrint Manager system or server, see Switching InfoPrint Manager servers, p. 47. You can also provide a failover connection to another InfoPrint Manager server in the same InfoPrint Manager system (see Failing over to other servers in the same InfoPrint Manager system, p. 49) and how to send jobs to more than one InfoPrint Manager system at the same time (see Supporting multiple InfoPrint Manager systems, p. 44).

### Notes

1. The SAP Client package cannot be installed if other `ipr-client-sap.*` rpm package reside on an SAP application server.

2. If your installation uses older printers (for example, 4000 printers instead of InfoPrint 4100 printers), the GOCA support can cause the printers to print at less than rated speed. If your applications do not require GOCA support features, such as box shading, you might want to improve performance by turning off the GOCA support. For instructions on turning off this support after installing the SAP Client, see Adding box shading values to printed output, p. 91.

To complete the configuration, complete the procedures described in Configuring and using the OMS, p. 28.

### Important

• If you are upgrading your SAP client, make sure that you follow these steps:

1. Use the `/etc/rc.iprsap` command to start all sap-daemons contained in the `/etc/rc.iprsap.daemons` file.

2. Update the `/etc/rc.iprsap.daemons` file containing the startcbd commands incl. parameters:
   - Access the rc.iprsap.daemons file in the `/etc` directory.
   - Edit the file and add this command: 
     ```
     /usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User Client Password Language
     ```

3. Edit the `/etc/hosts` file and add the host name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).

### Installing the InfoPrint Manager OMS support when SAP runs on Windows

To allow SAP on Windows to issue the InfoPrint Manager commands, you must install the InfoPrint Manager SAP Client on every SAP server where an SAP application server will issue the commands. This includes every application server with an SWP managing R/3 devices that have been configured to use the InfoPrint Manager OMS. If you have configured your SAP R/3 system to use alternate servers, you must repeat these installation tasks on the alternate servers as well.
To install the InfoPrint Manager SAP Client for Windows on your Windows SAP system, use this procedure:

1. Log in as the Administrator user.
2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642 into your DVD-ROM drive.
3. From the InfoPrint Manager: Common Clients window, click **Install InfoPrint Manager Products**.
4. Click **InfoPrint Manager SAP Clients**.
5. Select a location for installing the clients (the default is install_path \Infoprint Manager SAP Clients \).
6. From the IPM Server Settings pop-up dialog, specify either the fully qualified host name or the IP address of the InfoPrint Manager server to which you will be sending jobs. The **IPM Hostname** field defaults to showing the loop back address and must be changed. The **IPM Server Port Number** field defaults to 6874, which you do not need to change.

For another way to specify or change the InfoPrint Manager host and socket information to point to another InfoPrint Manager system or server, see . You can also provide a failover connection to another InfoPrint Manager server in the same InfoPrint Manager system (see Failing over to other servers in the same InfoPrint Manager system, p. 49 ) and how to send jobs to more than one InfoPrint Manager system at the same time (see Supporting multiple InfoPrint Manager systems, p. 44).

### Notes

- When the User Account Control (UAC) Windows system setting is active, you can change the SAP Client configuration settings only when running as Administrator. To use this option, start the InfoPrint Select SAP Clients application by right clicking on the icon and selecting "Run as Administrator". The Local Security Policy settings could influence the permission to update the configuration settings. For more information consult the UAC and Local Security Policy Windows documentation.

- Enable the **IPM LDAP Mode** if you are using the InfoPrint Manager Pull Print feature with your InfoPrint Manager server. For more information, see Enabling LDAP mode, p. 88.

- Do not check the **IPM Debug Mode** checkbox unless instructed to do so by technical support.

- Remove the check in the **IPM GOCA Support** checkbox only if you want to turn off GOCA support in the SAP transform.

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an AFP data architecture used to represent pictures generated by computer. If your installation uses older printers (for example, 3900 printers instead of InfoPrint 4000 printers), the GOCA support can cause the printers to print at less than rated speed. If your applications do not require GOCA support features, such as box shading, you might want to improve performance by turning off the GOCA support. For instructions on turning off this support after installing the SAP Client, see Adding box shading values to printed output, p. 91.

Once you have set the appropriate values, click **OK** to close this dialog.

7. When the SAP client has been installed, click **Finish**.
8. To exit the install process, click **Back**, and then click **Exit** on the next screen.
9. To complete the OMS configuration, complete the tasks in Configuring and using the OMS, p. 28.
Configuring and using the OMS

These sections describe how you can configure, customize, and use your SAP R/3 InfoPrint Manager environment to report enhanced job status that meet the particular criteria of your installation.

The first set of topics (Required configuration tasks, p. 28) must be done on both the SAP application servers and the InfoPrint Manager servers for enhanced status reporting to work correctly. The second set of topics (Using OMS support tasks, p. 40) describes how to use the OMS to get more information about your print jobs, including obtaining job status, device status, and the capability to cancel jobs. The third set of topics (Optional OMS configuration tasks, p. 42) cover a variety of useful administration functions, including:

- Activating end-user pop-ups, p. 42
- Selecting event report levels, p. 43
- Organizing OMS output devices into LOMSs, p. 43
- Moving OMS definitions among SAP systems, p. 47
- Switching InfoPrint Manager servers, p. 47
- Failing over to other servers in the same InfoPrint Manager system, p. 49
- Customizing a SAP daemon error log on AIX or Linux, p. 51
- Customizing an SAP callback process error log on Windows, p. 52
- Shutting down the callback daemon on AIX, p. 54
- Shutting down the callback daemon on Linux, p. 54
- Shutting down the callback process on Windows, p. 55
- Deleting an SAP callback process on Windows, p. 55

Use these topics with relevant SAP R/3 online product documentation.

Required configuration tasks

This section consists of the required configuration tasks that you must do to receive OMS callback reports.

When you finish defining the InfoPrint Manager OMS to your SAP R/3 system, you can define devices so you can print with InfoPrint Manager as described in Defining devices for InfoPrint Manager that use the InfoPrint OMS, p. 39.

Defining the InfoPrint Manager OMS to SAP R/3 on the SAP system server

InfoPrint Manager provides a configuration file (ipm.omsdesc) to assist in defining InfoPrint Manager as an OMS on your R/3 system. These two procedures are performed on your SAP application server to:

- Define InfoPrint Manager as a real output management system (ROMS) for your SAP R/3 installation
- Define your first logical output management system (LOMS) so you can define access method E devices in SAP R/3
Defining a real output management system

Use this procedure to define a real output management system (ROMS) for SAP R/3:
1. Log onto your SAP R/3 Release 4 or later system.
2. Import the InfoPrint Manager OMS configuration file by entering transaction SA38.
3. From the ABAP: Execute Program window, specify RSP0XOMS in the Program field and click Execute (checkmark with a clock).
4. From the Spool: Saving and Loading of Definitions window, do one of these tasks:
   - If configuring for SAP on UNIX, make these changes to the Spool: Saving and Loading of Definitions window:
     - Specify /usr/lpp/pd/bin/ipm.omsdesc in the Export/Import file name field.
     - Set the File system info pane to Server.
     - Set the Operation pane to Import.
     - Check both the Execute import and Generate log options in the Options pane.
     Once you have set these options, click Execute (checkmark with a clock).
   - If configuring for SAP on Windows, make these changes to the Spool: Saving and Loading of Definitions window:
     - Make sure that the Operation pane is set to Import.
     - Specify C:\Program Files\IBM\InfoPrint Manager SAP Clients\ipm.omsdesc in the Export/import file name field.
     - Make sure that the File system info pane is set to Frontend computer.
     - Check both the Execute import and Generate log options in the Options pane.
     Once you have set these options, click Execute (checkmark with a clock).
5. Running the report displays a list of the ROMS and LOMS that have been imported into the system.

Defining a logical output management system

Use this procedure to define a logical output management system (LOMS) for SAP R/3:
1. From the SAP R/3 graphical user interface, complete the logical output management system definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click Extended admin and click Logical OMS from the Output management systems pane to obtain a list of the logical output management systems (LOMS) available on your installation.
3. From the Spool Administration: List of Logical Output Management Systems window, select the IPM001 LOMS and click Choose (checkmark with a clock).
4. From the Spool Administration: Logical Output Management (Display) window, click Change (red pencil).
5. From the Spool Administration: Logical Output Management (Change) window on the SAP Configuration tab:
• Select a value from the pulldown list of all SAP application servers for both the **Tasking target** field and the **Callback target** field in the format: hostname_systemname_instanceID, such as sap12_MBS_00. 
The **Tasking target** field specifies where the commands are invoked, while the **Callback target** field specifies where the asynchronous callbacks are delivered.

• Click **Extended config.** icon and specify a value for the **Event report level** field in the **SAP configuration** pane.

**Note**

Once you click **Extended config.**, it disappears from the view and the Event report level field is always displayed. You must select one of these values:
- Final messages
- Also problems
- Also warnings
- Also status changes
- Also information
- All information options

In earlier versions of the SAP GUI, the **Event report level** field consists of numeric message levels. For the earlier SAP GUI, use the down arrow to determine the message level you want (1 is the least and 5 is the most).

6. To make sure that users on your SAP R/3 system receive pop-up windows for both problem and completion notification messages about a job’s status, check the **Status dialog box** field in the Jobs pane.

**Note**

Until SAP R/3 Release 4.5B, the pop-up message is always reported only to users in the client where the OMS callback daemon has logged on. You defined this client when you Defining a SAP user for the OMS callback daemon or process, p. 30. Beginning with SAP R/3 Release 4.5B, SAP delivers asynchronous pop-ups to users who are logged onto any SAP client.

7. From the **OMS Configuration** tab, you can specify how often (**Send period** field) in seconds or how many (**Number of events** field) notification events the InfoPrint Manager callback daemon should collect before delivery to the SAP R/3 system. In other words, the callback daemon will only deliver events for jobs on printers associated with this LOMS if it has collected x number or x seconds have passed since the last delivery.

8. Save this information by clicking **Save** (diskette) icon.

9. Now you can use the SAP GUI for Defining a SAP user for the OMS callback daemon or process, p. 30.

**Defining a SAP user for the OMS callback daemon or process**

Because the OMS callback daemon must logon to the SAP system and its external management interface (XMI) to make RFC requests, you must define a user for it. You will need this user information when Starting the SAP callback daemon or process, p. 32.
The user should be a CPIC (or System) type and requires XOMI permissions to log into the CCMS system management XOM application programming interface. These authorizations can be provided in the S_XMI_XOM_A profile.

This profile has the S_RFC and S_XMI_PROD authorization objects. To make the profile compatible with the SAP NWRFC protocols, add these values for the authorization object: S_RFC.

ACTVT: 16
RFC_NAME: RFC1, SDIFRUNTIME
RFC_TYPE: FUGR

If you ever change or modify this SAP user, remember to make the changes where the SAP callback daemon is running:

- If on InfoPrint Manager for AIX, edit the rc.iprsap.daemon file in the /etc directory.
- If on InfoPrint Manager for Linux, edit the rc.iprsap file in the /etc directory. Also, you can use the Management Interface (IPMMI) to left-click SAP Callback Processes from the Objects view, which lets you access the SAP Callback Processes in the main view. From the main view, you can right-click and select Open.
- If on InfoPrint Manager for Windows, use the InfoPrint Manager Management Console to left-click SAP Callback Processes from the Objects view, which lets you access the SAP Callback Processes in the main view. From the main view, you can right-click and select Open.

Collecting information necessary to start an SAP callback daemon or process

These tables display the variables needed to start an SAP callback daemon or process. All the variables in the tables are examples and will differ from the values that you specify, unless otherwise noted. These variables are grouped into two categories:

1. **SAP R/3 instance where the callback daemon logs on**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>MBS</td>
<td>The three-character system name</td>
</tr>
<tr>
<td>sap12 or /H/host/S/service/W/pass</td>
<td>The host name or the SAProuter route string.</td>
</tr>
<tr>
<td>00</td>
<td>The instance ID</td>
</tr>
</tbody>
</table>

Note: If you are starting multiple SAP callback daemons and SAP callback processes to run on different SAP application servers, you must make sure that there is a unique SAP R/3 instance (system name, host name, and instance ID) for each SAP callback userid as shown in Callback daemon or process user ID information, p. 32.

If you don't know what values you can specify for these variables, you can refer to the drop-down list for the Callback target field from the Spool Administration: Change Logical Output Management System window (for an example, see step 5 of Defining a logical output management system, p. 29).

A standard example of a SAProuter route string is /H/host/S/service/W/pass, where:
• /H/host indicates the host name.
• /S/service is used for specifying the service (port). It is an optional entry, the default value is 3299.
• /W/password indicates the password for the connection between the predecessor and successor on the route; this is optional. The default value is ”” (no password)

To use the SAProuter, you need to install and configure SAProuter on your SAP system.

The standard entries in a route permission table are P/S/D <source host> <dest host> <dest serv> <password>. The <source-host> and <dest-host> entries could be SAProuters.

For more information about installing and configuring the SAProuter, go to the help page from the SAP portal (http://help.sap.com).

2. Callback daemon or process user ID information
You defined the information for Table Callback daemon or process user ID information, p. 32 when you did the step described in Defining a SAP user for the OMS callback daemon or process, p. 30.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>infoprint</td>
<td>The User value. This value and the two that follow were originally defined when you created an SAP userid for the OMS callback daemon.</td>
</tr>
<tr>
<td>030</td>
<td>The Client value</td>
</tr>
<tr>
<td>newname</td>
<td>The Password value</td>
</tr>
<tr>
<td>En</td>
<td>The Language value: in this example, English</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>If you are creating an SAP callback process on Windows, this value is not required.</td>
</tr>
</tbody>
</table>

Starting the SAP callback daemon or process

Each SAP R/3 system using the InfoPrint Manager callback support needs to have one callback daemon running. If your callback support runs on an InfoPrint Manager for AIX server or InfoPrint Manager for Linux server, you must do both of these procedures:

• Starting the SAP callback daemon on AIX, p. 33
• Starting the SAP callback daemon from command line, p. 34
• Configuring to start callback daemons at system reboot on AIX, p. 35
• Configuring to start callback daemons at system reboot on Linux, p. 36

If your callback support runs on an InfoPrint Manager for Windows server, you must complete the Starting the SAP callback process on Windows, p. 37 procedure.
If your logical destination does not receive a job sent from your SAP device, delete and recreate the SAP callback daemon with the same settings on the InfoPrint Manager server.

When using SAP 4.x kernel and you start the sapcbd daemon, you might get a connection failure and the error message "CALL_FUNCTION_SIGNON_REJECTED", even if the login credentials are correct. To avoid this error, you must install the latest patch for the corresponding kernel. For more information, consult the SAP notes 171805 (http://search.sap.com/notes?id=0000171805) and 19466 (http://service.sap.com/sap/support/notes/19466).

For more information on general authorization rights needed to start SAP callback daemon or process, see: http://search.sap.com/notes?id=0000171805.

Starting the SAP callback daemon on AIX

To start the SAP callback daemon, run these commands as an authorized user or as root.

1. From the AIX command line, verify that you can ping the SAP server by host name:

   ```
   ping -c3 hostname
   ```

   where `hostname` is the unqualified name for the SAP server, such as `sapsrv`.

   If you cannot ping the SAP server by the host name, edit the `/etc/hosts` file and add the host name and the IP address of the SAP server (for example, `192.168.11.109 sapsrv`).

2. Run the SAP callback daemon.

   ```
   /usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User \ 
   Client Password Language
   ```

   For more information, see Defining an SAP user for the OMS callback daemon or process, p. 30.

   Specify the same values you used in Collecting information necessary to start an SAP callback daemon or process, p. 31.

   If the callback daemon has started correctly, you should see this response:

   ```
   5010-428 Successfully started SAPCBD
   ```

   If you receive any other message, the daemon has not started correctly. To solve the problem, refer any messages displayed in either the message column or by selecting the Server Log object from the left pane of the InfoPrint Manager Management Console to access the Server Log view. Correct the problems cited, and try to start the callback daemon again. If it still does not start correctly, contact your service representative.

   - The Host Name Resolution must be enabled and functional for the sapcbd daemon to communicate correctly with the SAP systems.

   - If the SAP callback daemon has been configured to start at system startup, but it is not running, you can start it by running `/etc/rc.iprsap` command. This command starts all configured SAP callback daemons.
Starting the SAP callback daemon on Linux

The SAP callback daemon can be started from the Linux command line or using the Management Interface application.

Starting the SAP callback daemon from command line

To start the SAP callback daemon, run these commands as an authorized user or as root.

1. From the Linux command line, verify that you can ping the SAP server by host name:

   \[\text{ping } -c3 \text{ hostname}\]

   where hostname is the unqualified name for the SAP server, such as sapsrv.

   If you cannot ping the SAP server by the host name, edit the /etc/hosts file and add the host name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).

2. Run the SAP callback daemon:

   \[\text{/usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User} /\text{Client Password Language}\]

   For more information, see Defining an SAP user for the OMS callback daemon or process, p. 30.

   Specify the same values you used in Collecting information necessary to start an SAP callback daemon or process, p. 31.

   If the callback daemon has started correctly, you should see this response:

   \[5010-428 \text{ Successfully started SAPCBD}\]

   If you receive any other message, the daemon has not started correctly. To solve the problem, refer any messages displayed in either the message column or by selecting the Server Log object from the left pane of the InfoPrint Manager Management Console to access the Server Log view. Correct the problems cited, and try to start the callback daemon again. If it still does not start correctly, contact your service representative.

   • The Host Name Resolution must be enabled and functional for the sapcbd daemon to communicate correctly with the SAP systems.

   • If the SAP callback daemon has been configured to start at system startup, but it is not running, you can start it by running /etc/rc.iprsap command. This command starts all configured SAP callback daemons.

Starting the SAP callback daemon using the Management Interface application

1. From the Linux command line, verify that you can ping the SAP server by host name:

   \[\text{ping } -c3 \text{ hostname}\]

   where hostname is the unqualified name for the SAP server, such as sapsrv.

   If you cannot ping the SAP server by the host name, edit the /etc/hosts file and add the host name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).

Enter the appropriate SAP System and user information for the SAP Callback daemon:

- **System Name**: The three character SAP system name
- **Host Name**: The SAP HostName
- **Instance ID**: The two digit SAP Instance ID
- **User**: The SAP CPIC (System) User
- **Client**: The three digit SAP Client
- **Password**: The User password
- **Language**: The Language the SAP Callback daemon will run
- **Startup Options**: Start Now

If you receive any message, the daemon has not started correctly. To solve the problem, refer any messages displayed in either the message column or by selecting the Server Log object from the left pane of the InfoPrint Manager Management Interface to access the Server Log view. Correct the problems cited, and try to start the callback daemon again. If it still does not start correctly, contact your service representative.

The **Host Name Resolution** must be enabled and functional for the **sapcbd** daemon to communicate correctly with the SAP systems.

### Configuring to start callback daemons at system reboot on AIX

The SAP callback daemon needs to run all the time. A monitor makes sure that it is restarted if it ever stops after it is started.

To start the SAP callback daemon at system startup, you must edit the `/etc/rc.iprsap.daemons` file from the AIX command line from the InfoPrint Manager AIX server as an authorized user or as root.

1. From the AIX command line, verify that you can ping the SAP server by host name:

```
ping -c3 hostname
```

where `hostname` is the unqualified name for the SAP server, such as `sapsrv`.

If you cannot ping the SAP server by the host name, edit the `/etc/hosts` file and add the host name and the IP address of the SAP server (for example, `192.168.11.109 sapsrv`).

2. Access the `rc.iprsap.daemons` file in the `/etc` directory. Edit the file and add this command:

```
/usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User \ Client Password Language
```
Configuring to start callback daemons at system reboot on Linux

The SAP callback daemon needs to run all the time. A monitor makes sure that it is restarted if it ever stops after it is started.

You have two options for configuring the SAP callback daemon at system startup:

- Configuring the SAP callback daemon to start at system startup from Linux command line interface, p. 36
- Configuring the SAP callback daemon to start at system startup from Management Interface application, p. 37

Configuring the SAP callback daemon to start at system startup from Linux command line interface

1. From the Linux command line, verify that you can ping the SAP server by host name:

```
ping -c3 hostname
```

   where hostname is the unqualified name for the SAP server, such as sapsrv.

   If you cannot ping the SAP server by the host name, edit the /etc/hosts file and add the host name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).

2. Start the SAP callback daemon. See Starting the SAP callback daemon on Linux, p. 34.

3. Create new startup script `/var/pd/sapcb.SystemName/startup.sh` for this callback daemon where SystemName is the three character SAP system name. Make sure that the `/var/pd/sapcb.SystemName/startup.sh` is an executable and that it is owned by the authorized user and by the group sys. The script should contain:

```bash
#!/bin/bash
/usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User Client Password Language
if [ $? -eq 0 ]
then
  exit 0
else
  exit 1
fi
```

For more information, see Defining an SAP user for the OMS callback daemon or process, p. 30.

Specify the same values you used in Collecting information necessary to start an SAP callback daemon or process, p. 31.
4. Add the `/var/pd/sapcb.SystemName/startup.sh` command to the `/etc/rc.iprsap.daemons` file.

5. To start the SAP callback daemon, see Starting the SAP callback daemon on Linux, p. 34.

**Configuring the SAP callback daemon to start at system startup from Management Interface application**

1. If the SAP callback daemon has been configured but not set to start at system startup, start the Management Interface from **Applications->InfoPrintManager->Management Interface->SAP Callback Daemons**. Right-click the SAP callback daemon, choose **Start**. If the **Start** option is disabled, stop the SAP callback daemon first using **Stop** option. Choose **Start at reboot**.

2. If the SAP callback daemon has not been configured:
   1. From the Linux command line, verify that you can ping the SAP server by host name:

   ```
   ping -c3 hostname
   ```

   where `hostname` is the unqualified name for the SAP server, such as `sapsrv`.
   
   If you cannot ping the SAP server by the host name, edit the `/etc/hosts` file and add the host name and the IP address of the SAP server (for example, `192.168.11.109 sapsrv`).

   2. Start the SAP callback daemon using the Management Interface from **Applications->InfoPrintManager->Management Interface->SAP Callback Daemons**. Right-click **New**.

   Enter the appropriate SAP System and user information for the SAP Callback daemon:
   
   - **System Name**: The three character SAP system name
   - **Host Name**: The SAP HostName
   - **Instance ID**: The two digit SAP Instance ID
   - **User**: The SAP CPIC (System) User
   - **Client**: The three digit SAP Client
   - **Password**: The User password
   - **Language**: The Language the SAP Callback daemon will run
   - **Startup Options**: Start both or Start at reboot

   **Note**

   - The **Host Name Resolution** must be enabled and functional for the `sapcbd` daemon to communicate correctly with the SAP systems.
   
   - If the **Startup Option** is **Start at reboot** and you want to start the SAP callback daemon, see Starting the SAP callback daemon on Linux, p. 34.

**Starting the SAP callback process on Windows**

Each SAP R/3 system using the InfoPrint Manager callback support needs to have one callback process running. To start the SAP callback process on an InfoPrint Manager Windows server, you must access the SAP Callback Processes from the InfoPrint Manager Management Console.
The **SAP Callback Processes** object is only visible if you have installed the optional InfoPrint Manager: SAP Print Feature, LCD4-5646.

1. Verify that you can ping the SAP server by host name:
   1. From a either a Command or a Command Prompt window, specify `ping hostname`, where hostname is the unqualified name for the SAP server, such as `sapsrv`.
   2. If you cannot ping the SAP server by host name, edit the `hosts` file in the `C:\Windows\system32\drivers\etc` folder and add both the host name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).
2. From the Start menu, select **Programs → InfoPrint Manager → Management Console**.
3. Right-click **SAP Callback Processes** in the **Objects** view in the left pane of this window and click **New**.
4. Specify the values that you gathered in *Collecting information necessary to start an SAP callback daemon or process, p. 31*, click **OK**, and wait.
5. If the callback process has started correctly, the main panel should show a state of **RUNNING**.
   - If the state shows **Failed To Start**, the process has not started correctly. To resolve the problem, if the message displayed does not provide enough information to correct the problem, you can switch to the **Server Log** view for additional messages.
   - See *Expanding server ports for SAP callback processes, p. 38* if you receive this message: **5010-760: There are no available port numbers**
     - For all other messages, correct the problems cited, and try to start the callback process again. If it still does not start correctly, contact your service representative.

**Note**

- If you are running the callback process on InfoPrint Manager for Windows, you do not need to configure to start SAP Callback Processes on a system reboot because at reboot the InfoPrint Manager SAP service is always started and the service will restart any SAP callback process that was not manually stopped.
- The **Host Name Resolution** must be enabled and functional for the `sapcbd` daemon to communicate correctly with the SAP systems.

**Expanding server ports for SAP callback processes**

Creating and managing SAP callback processes on your InfoPrint Manager for Windows server might require that you increase the number of server communication ports available on your system. This procedure shows how to do this task.

Use this procedure to increase the number of server ports available on your InfoPrint Manager for Windows server.

1. From the InfoPrint Manager Management Console, stop the InfoPrint Manager server by selecting **File → Stop Server** from the main menu.
2. Select **Edit → Service Configuration → Communication Ports**.
3. In the **Server Interface Ports** field, increase the range to include twenty ports and save your results.
The server interface ports default values range from 6880 to 6889. To make sure that you have enough server communication ports for all SAP callback processes, you should increase the final number in the range to 6899.

4. Use the InfoPrint Manager Management Console to start the InfoPrint Manager server by selecting **File → Start Server** from the main menu.

**Defining devices for InfoPrint Manager that use the InfoPrint OMS**

Use this procedure to define devices to SAP R/3. For more information, consult the “Connecting a Printer to an External Output Management System” topic in the SAP R/3 online documentation.

1. Make sure that you have a logical destination defined in InfoPrint Manager that sends jobs to your actual destination device.
2. From the SAP R/3 graphical user interface, specify the **spad** transaction.
3. From the Spool Administration: Initial screen (Change) window:
   * Click **Devices/servers**
   * Click **Output devices**
   * Click **Create** next to the trash can icon
4. From the Spool Administration: Create Output Device window, fill in these pieces of information for device attributes and access method:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output device</td>
<td>Specify a long name for the device.</td>
<td>Device Number 1</td>
</tr>
<tr>
<td>Short name</td>
<td>Specify a short name.</td>
<td>DEV1</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Optionally, you can allow the system to generate a short name.</td>
<td></td>
</tr>
<tr>
<td>Device type</td>
<td>Specifies the driver that generates the output data stream.</td>
<td>SAPGOF</td>
</tr>
<tr>
<td>Host printer</td>
<td>Specify the InfoPrint Manager logical destination.</td>
<td>printer-ld</td>
</tr>
<tr>
<td>Access method to host spool</td>
<td>Make sure you specify this Access Method.</td>
<td>E</td>
</tr>
<tr>
<td>Field</td>
<td>Explanation</td>
<td>Example value</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>LOMS</td>
<td>Specify the LOMS to which this device should be assigned. You specified this value on the Spool Administration: Logical Output Management System window under Define the InfoPrint Manager OMS to SAP R/3.</td>
<td>IPM001</td>
</tr>
<tr>
<td>Spool server</td>
<td>Select an applicable spool server from the entries list on the field.</td>
<td>sap12_MBS_00</td>
</tr>
</tbody>
</table>

5. Save this information by clicking on the **Save** (diskette) icon, then exit the interface.

Once you have saved these changes, you have a device that will print to InfoPrint Manager using Access Method E.

**Note**

If your logical destination does not receive a job sent from your SAP device, delete and recreate the SAP callback daemon with the same settings on the InfoPrint Manager server.

Once you have defined this device to send jobs to InfoPrint Manager, you can do these tasks:

- Viewing enhanced job status, job events, and querying jobs, p. 40
- Displaying device status, p. 41
- Canceling jobs, p. 41

**Using OMS support tasks**

This section contains the procedures that are available once you have configured your SAP OMS to obtain job status about your print environment.

**Viewing enhanced job status, job events, and querying jobs**

This procedure describes OMS support for obtaining information about a print job sent to InfoPrint Manager. By using this feature, you can see asynchronous events and synchronous queries about jobs reported to your SAP R/3 system.

To view the status of an output request, use this procedure from the SAP R/3 graphical user interface:

1. From the Output Requests for Spool Request xxxxxx window (where xxxxxx refers to the SAP spool ID), double-click the output request you want to view in the Status column on the far right.
2. From the Status Description pop-up window, you can see current information about the job, including the last event received.
3. Click **Events** on the Status Description window to get the Events for Output Requests window. From the Events for Output Requests pop-up window and, you can view all the events concerning this job.

This Events for Output Requests pop-up window is displayed twice to show (1) the right side of the window with the date, time, and current status of the job, and (2) the left-side of the window with its message text.

4. From the Status Description pop-up window, you can also click **Query** and issue a query to return the current information for a job, including its position in the queue. For example, the Status Description window displays the result of a query for a job that has been successfully submitted for printing. Notice that the first line shows the job’s position in the print queue.

When you close this query Status Description window, the system updates the latest status for that job in other displays.

### Displaying device status

To display the status of InfoPrint Manager printers and the queue of jobs that have been sent to an InfoPrint printer, use this procedure from the SAP R/3 graphical user interface:

1. From the R/3 main menu, access the Spool Administration: Initial Screen window by selecting the **Tools** main menu and then selecting the **Tools → Administration → Spool → Spool Administration** path or typing `/nSPAD` in the ok-Code field.

2. From the Spool Administration: Initial Screen window, click **Output devices** from the Configuration area.

3. From the Spool Administration: List of Output Devices window, do this:
   1. Highlight your InfoPrint printer from the Devices column.
   2. Click the **Output device** pull-down menu and select **Choose**.

4. From the Spool Administration: Change Output Device (Display) window, click **External jobs**.

5. The Device Information of Host Spool pop-up window displays the status of this device.

The Device Information of Host Spool pop-up window is displayed twice to capture both the right and the left sides. (1) This section indicates that there are six jobs in the InfoPrint Manager queue, two of which are being processed by printers. (2) This section shows information about each job, including its current status in InfoPrint Manager.

### Canceling jobs

This procedure describes how you can cancel SAP print jobs that you have sent to the InfoPrint Manager server. Use this procedure from the SAP R/3 graphical user interface. This procedure provides only one of many methods for accessing the Spool Output Requests for Spool Request XXXXXXXXXX window, where XXXXXXXXXX is the number of your SAP spool request.

1. From the R/3 main menu, access the Spool Administration: Initial Screen window by typing `/nspad` in the ok-Code field.

2. From the Spool Administration: Initial Screen window, click **Output devices** from the Configuration area.
3. From the Spool Administration: List of Output Devices window, do this:
   1. From the Devices column, use the mouse to highlight the SAP device that you used to send
      your job to InfoPrint Manager.
   2. Click Spool Requests.
   4. From the Spool Requests for Device XXX window (where XXX is the name of the device that you
      selected), double-click the spool request of the output request that you want to cancel.
   5. From the Spool: Attributes window, click Output requests.
   6. From the Spool Output Requests for Spool Request XXXXXXXXXX window (where XXXXXXXXXX is
      the number of your SAP spool request), click the output request you want to cancel to highlight it
      and then click the trash can icon to delete the output request from InfoPrint Manager.

   This step invokes the InfoPrint Manager command for canceling a job (pdrm).

Optional OMS configuration tasks

These sections describe useful administrative functions, including ways of configuring your OMS to
improve performance. Be sure to consult your SAP R/3 Release 4 documentation with any procedures
described in this section.

Activating end-user pop-ups

InfoPrint Manager delivers information to SAP R/3 about output requests (print jobs) as they process.
SAP will alert job owners about problem and job completion information delivered from InfoPrint
Manager through end-user pop-up messages.

Note

Until SAP R/3 Release 4.5B, the pop-up message is always reported only to users in the client where
the OMS callback daemon has logged on. You defined this client when you Defining a SAP user for the
OMS callback daemon or process, p. 30. In SAP R/3 Release 4.5B, SAP delivers asynchronous pop-
ups to users who are logged onto any SAP client.

To activate this support, make sure that you have done these steps while installing and configuring
InfoPrint Manager with SAP R/3:

1. From the SAP R/3 graphical user interface, modify the logical output management system
   (LOMS) definitions by specifying the Spad transaction.
2. From the Spool Administration: Initial Screen window, click Extended admin and click Logical
   OMS from the Output management systems pane to obtain a list of the logical output
   management systems (LOMS) available on your installation.
3. From the Spool Administration: List of Logical Output Management Systems window, select
   IPM001 LOMS or another appropriate LOMS and click Choose.
4. From the Spool Administration: Logical Output Management (Display) window, click Change.
5. From the Spool Administration: Logical Output Management System window that is displayed
   below, check the Status dialog box field in the Jobs pane and save the changes.
6. Once you have specified this setting, information from the InfoPrint Manager sent back to your SAP R/3 application server will be delivered in the form of a pop-up window. For example, if an output request was canceled, a pop-up Info window should appear on the output requesters’ SAPGUI.

**Note**

All pop-up window text is scrollable, however an SAP R/3 limitation limits the text of the InfoPrint Manager messages (as well as those received from any OMS) to 50 characters.

### Selecting event report levels

This procedure describes how you can specify the level of events that the callback daemon reports for jobs submitted through InfoPrint Manager:

1. From the SAP R/3 graphical user interface, modify the logical output management system (LOMS) definitions by specifying the `spad` transaction.

2. From the Spool Administration: Initial Screen window, click **Extended admin** and click **Logical OMS** from the Output Management Systems pane to obtain a list of the logical output management systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, select **IPM001 LOMS** and click **Choose** (checkmark with a clock).

4. From the Spool Administration: Logical Output Management (Display) window, click **Change** (red pencil).

5. From the Spool Administration: Logical Output Management (Change) window displayed below, specify a value for the **Event report level** field in the SAP configuration tab. Use the menu field to select the most appropriate value for your installation.

   When you have finished, be sure to save your changed LOMS definition by clicking the **Save** folder icon.

### Organizing OMS output devices into LOMSs

While you can assign all of your R/3 OMS output devices to a single logical output management system (LOMS), it might be useful to group output devices into separate LOMS, each with different SAP devices assigned to them. After you define one or more LOMS on your system (see Defining another logical output management system, p. 43), you can assign different SAP devices to each one, depending on the functions they perform, such as:

- Using different report levels or event delivery criteria, p. 44
- Using different OMS services, p. 44
- Distributing the callback workload, p. 44
- Supporting multiple InfoPrint Manager systems, p. 44

### Defining another logical output management system

Use this procedure to define another logical output management system for SAP R/3:

1. From the SAP R/3 graphical user interface, copy a logical output management system (LOMS) definition by specifying the `spad` transaction.
2. From the Spool Administration: Initial Screen window, click Extended admin and click Logical OMS from the Output Management Systems pane to obtain a list of the logical output management systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, click Change (red pencil).

4. From the Spool Administration: List of Logical Output Management Systems (Change) window:
   1. Highlight the Name field of the LOMS from which you want to copy.
   2. Specify the Logical OMS → Create using template path.
   3. From the Spool Administration: Copy Logical OMS from OMS_Name window, specify the name for your new LOMS in the Logical OMS field and click the Save (Diskette) icon.

5. By returning to the Spool Administration: List of Logical Output Management Systems window, you can see your new LOMS displayed.

Using different report levels or event delivery criteria

You can define LOMSs to specify different report levels on the Spool Administration: List of Logical Output Management Systems (Change) window, as described in Selecting event report levels, p. 43. On the second screen of this same window, you can also define LOMSs to specify different Event Delivery Criteria. This allows you to determine how often and how many events are delivered together by the callback daemon to your SAP system. Before implementing this feature, consult both Defining another logical output management system, p. 43 and the online documentation about LOMS that is provided with your SAP R/3 system.

Using different OMS services

You can define LOMSs to allow for the use of different OMS services by a group of printers. For example, you can restrict access to a particular ROMS feature like job cancellation. By creating a LOMS and turning off job cancellation, you can prevent SAP R/3 users from deleting output requests that are sent to the devices of the LOMS. Before implementing this feature, consult both Defining another logical output management system, p. 43 and the online documentation about LOMS that is provided with your SAP R/3 system.

Distributing the callback workload

You can define separate LOMSs to distribute the workload of processing status reports from the InfoPrint callback daemon. For each LOMS, specify a different R/3 server as the callback target. Before implementing this feature, consult both Defining another logical output management system, p. 43 and the online documentation about LOMS that is provided with your SAP R/3 system.

Supporting multiple InfoPrint Manager systems

InfoPrint Manager provides you with the ability to send jobs to multiple InfoPrint systems from the same SAP system. An InfoPrint Manager system consists of one or more InfoPrint Manager servers residing on either the same or different machines that are set up to interoperate by sharing the same namespace. If your print installation is large, with many printers distributed across a wide area and managed by different InfoPrint Manager systems, this function can help you to manage your installation more efficiently by defining separate LOMS to send jobs to separate systems.
You can implement this support by using the SAP GUI to add an optional flag with values in the form `host:socket` to your InfoPrint Manager OMS commands: `ipm_submit`, `ipm_dev_query`, `ipm_job_query`, and `ipm_job_cancel`.

Host represents the host name where the InfoPrint server is running and socket the socket for the InfoPrint server on that host.

Using the procedure described in Defining another logical output management system, p. 43, you can define a new LOMS for every InfoPrint Manager system to which you want to send jobs. For example, in the procedure below, you might want to create an LOMS1 and an LOMS2, one for each InfoPrint Manager system to which you want to send jobs. In Figure Sending jobs to multiple InfoPrint Manager instances, p. 45, LOMS1 points to the New York system, while LOMS2 points to the London system.

**Sending jobs to multiple InfoPrint Manager instances**

To modify the OMS commands from your SAP GUI, use this procedure:

1. From the SAP R/3 graphical user interface, modify the logical output management system (LOMS) definitions by specifying the `spad` transaction.
2. From the Spool Administration: Initial Screen window, click **Extended admin** and select **Logical OMS** from the Output Management Systems pane to obtain a list of the logical output management systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, select the appropriate LOMS (for example, the LOMS1) and click **Commands**. SAP displays a list of operating systems.

4. From the list of operating systems, double-click the operating system where your SAP system is running to access the OMS commands. From the Spool Administration: Operating System Commands (Change) window, you can modify the OMS commands to switch from one InfoPrint system to another. For example, to change the ipm_submit command to send jobs to an InfoPrint system that is located in New York (ny1 at socket 6874), you can change the ipm_submit command field as follows:

   **Original ipm_submit command**

   \[
   \text{ipm_submit \&P \&F \&EI \&EG \&Es 'O' 'o' 'R' 'f' 'C' 'Y' 'E1' 'T' 'D' 't'}
   \]

   **Modified ipm_submit command**

   \[
   \text{ipm_submit -c ny1:6874 \&P \&F \&EI \&EG \&Es 'O' 'o' 'R' 'f' 'C' 'Y' 'E1' 'T' 'D' 't'}
   \]

   **Notes**

   1) Even though this example shows only changes to the ipm_submit command, make sure that you make the same change to all InfoPrint Manager OMS commands.

   2) Do not make changes to any other part of the commands; these parameters are positional and must not be modified.

5. Save your changes by clicking the **Save** (diskette) icon.

If you wanted another set of devices from this same SAP system to send jobs to another InfoPrint system that is located in London, (lon at socket 6874), you can return to Step 4, access another LOMS on this SAP system, and proceed to change the ipm_submit command fields for this LOMS as follows:

   **Original ipm_submit command**

   \[
   \text{ipm_submit \&P \&F \&EI \&EG \&Es 'O' 'o' 'R' 'f' 'C' 'Y' 'E1' 'T' 'D' 't'}
   \]

   **Modified ipm_submit command**

   \[
   \text{ipm_submit -c lon:6874 \&P \&F \&EI \&EG \&Es 'O' 'o' 'R' 'f' 'C' 'Y' 'E1' 'T' 'D' 't'}
   \]

   As before, remember to save your changes before exiting the Spool Administration: Operating System Commands (Change) window by clicking on the **Save** (diskette) icon.
Moving OMS definitions among SAP systems

You can maintain OMS definitions on a single application by replicating your InfoPrint Manager OMS definitions in other SAP R/3 systems. To make changes to OMS definitions, you can transport the OMS objects from the maintenance system to your other systems.

If you decide to transport the OMS objects from this maintenance system, you must use only logical spool servers in these:

- OMS ROMS and LOMS definitions
- InfoPrint Manager Output device definitions

Logical servers allow you to organize your printing architecture and manage printers. By using only logical spool servers, you will not have to change server names in the OMS definitions after you have transported them. For more information about Logical servers, see the “Spool Server Definitions: Classifying Servers, Using Logical Servers, and Using Alternate Servers” topic in your SAP R/3 documentation.

This procedure describes how you can use the R/3 logistics (transport) system to move OMS definitions between SAP R/3 systems:

1. From the R/3 main menu, access the Real OMS window by using this path Tools → CCMS → and Spool → Spool Administration or type spad in the ok-Code field.

2. From the Spool Administration: Initial Screen window, click Extended admin and select Real OMS from the Output Management Systems pane to obtain a list of the real output management systems (ROMS) available on your installation.

3. From the Spool Administration: List of Real Output Management Systems window, select Change mode from the ROMS list and double-click ROMS definition that you want to transport.

4. From the Spool Administration: Real Output Management System window, select the appropriate transport function:

   - To transport only the ROMS definition, push the Transport (truck) icon.
   - To transport both the ROMS definition and all LOMS definitions that reference it, push the Transport all (truck) icon to the right.

   In either case, a transport request is created for transporting the OMS definition objects to other R/3 systems.

5. To transport your OMS definitions, type /SE09 in the ok-Code field so you can complete this task from the R/3 software logistics transport system.

Switching InfoPrint Manager servers

InfoPrint Manager provides you with the ability to switch the InfoPrint server to which your SAP system is sending commands. This can be a valuable feature to use if a particular InfoPrint command processor fails and you want to switch to one that is still active, or when switching from an InfoPrint test system to an InfoPrint production system (as shown in Figure Switching from one InfoPrint Manager server to another, p. 48). An InfoPrint Manager system consists of one or more InfoPrint Manager servers residing on either the same or different machines that are set up to interoperate by sharing the same namespace.
If switching from one InfoPrint Manager system to another, you must make sure that the same logical destination names have been defined on both systems.

You can implement this support by using the SAP GUI to add an optional flag with values in the form host:socket to your InfoPrint Manager OMS commands: ipm_submit, ipm_dev_query, ipm_job_query, and ipm_job_cancel.

host represents the host name where the InfoPrint server is running and socket the socket for the InfoPrint server on that host.

Switching from one InfoPrint Manager server to another

To modify the OMS commands from your SAP GUI, use this procedure:

1. From the SAP R/3 graphical user interface, modify the logical output management system (LOMS) definitions by specifying the SpAd transaction.

2. From the Spool Administration: Initial Screen window, click **Extended admin** and select **Logical OMS** from the Output Management Systems pane to obtain a list of the logical output management systems (LOMS) available on your installation.
3. From the Spool Administration: List of Logical Output Management Systems window, select the appropriate LOMS (for example, the IPM001 LOMS) and specify the Commands icon. SAP displays a list of operating systems.

4. From the list of operating systems, double-click the operating system where your SAP system is running to access the OMS commands. From this panel, you can modify the OMS commands to switch from one InfoPrint server to another. For example, to change the ipm_submit command to send jobs to the InfoPrint server info1 at socket 6874, you can change the ipm_submit command field as follows:

**Original ipm_submit command**

```
ipm_submit &P &F &EI &EG &Es 'O' 'o' 'R' 'f' 'C' 'Y' 'E1' 'T' 'D' 't'
```

**Modified ipm_submit command**

```
ipm_submit -c info1:6874 &P &F &EI &EG &Es 'O' 'o' 'R' 'f' 'C' 'Y'
```

**Notes**

1) Even though this example only shows changes to the ipm_submit command, make sure that you make the same change to all InfoPrint Manager OMS commands.

2) Do not make changes to any other part of the commands; these parameters are positional and must not be modified.

**Failing over to other servers in the same InfoPrint Manager system**

InfoPrint Manager provides you with the ability to send jobs to destinations in multiple InfoPrint servers through any InfoPrint Manager server in that InfoPrint Manager system. An InfoPrint Manager system consists of one or more InfoPrint Manager servers residing on either the same or different machines that are set up to interoperate by sharing the same namespace. A distributed installation that uses an InfoPrint server (pdserver) as a command processor might want to define another pdserver as a backup command processor to fail over to if the primary command processor goes down so you can continue to send jobs to the destinations. As shown in Figure Failing over from one InfoPrint Manager server to another on the same system, p. 50, you might want to specify either the InfoPrint Manager server with the actual destination or the InfoPrint Manager server with the logical destination as the backup server.

You can implement this support by using the SAP GUI to add an optional flag with values in the form `host:socket` to your InfoPrint Manager OMS commands: `ipm_submit`, `ipm_query`, `ipm_job_query`, and `ipm_job_cancel`.

`host` represents the host name where the InfoPrint server is running and `socket` the socket for the InfoPrint server on that host.

Before using this function, make sure that you understand that:

- Even though this example only shows changes to the ipm_submit command, make sure that you make the same change to all InfoPrint Manager OMS commands.
- Do not make changes to any other part of the commands; these parameters are positional and must not be modified.
Failing over from one InfoPrint Manager server to another on the same system

To modify the OMS commands from your SAP GUI, use this procedure:

1. From the SAP R/3 graphical user interface, modify the logical output management system (LOMS) definitions by specifying the spad transaction.

2. From the Spool Administration: Initial Screen window, click Extended admin and select Logical OMS from the Output Management Systems pane to obtain a list of the logical output management systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, select the appropriate LOMS (for example, the IPM001 LOMS) and specify the Commands icon. SAP displays a list of operating systems.

4. From the list of operating systems, double-click the operating system where your SAP system is running to access the OMS commands. From this panel, you can modify the OMS commands to switch from one InfoPrint server to another. For example, to change the ipm_submit command to failover to another InfoPrint (pdserver) that is located in the same InfoPrint Manager system, you can change the ipm_submit command field as follows:

   **Original ipm_submit command**
   
   ```
ipm_submit &P &F &EI &EG &Es '&O' '&o' '&R' '&f' '&C' '&Y' '&E1' '&T' '&D' '&t'
   ```

   **Modified ipm_submit command for InfoPrint server failover**
   
   ```
ipm_submit -c 'info1:6874 info1:5157' &P &F &EI &EG &Es '&O' '&o' '&R' '&f' '&C' '&Y' '&E1' '&T' '&D' '&t'
   ```
Notes

1) Even though this example only shows changes to the ipm_submit command, make sure that you make the same change to all InfoPrint Manager OMS commands.

2) Do not make changes to any other part of the commands; these parameters are positional and must not be modified.

Customizing a SAP daemon error log on AIX or Linux

By default, the SAP daemon error logs (SAP Callback) start when you create them. When you create a SAP Callback daemon, InfoPrint Manager creates a SAP directory (sapcbd.sysname, where sysname is the SAP application server) under /var/pd for each daemon. Use this procedure to customize the SAP error log:

**Note**

Any SAP daemons running on this AIX or Linux server are changed by this customization.

1. Find the sap_error.cfg file from the /usr/lpp/pd/bin directory where the file is installed and copy it into the /var/pd directory:

   ```bash
cp /usr/lpp/pd/bin/sap_error.cfg /var/pd/sap_error.cfg
   ```

   If you already customize your SAP daemon error logs, remember to change the name or move the current sap_error.cfg file in /var/pd so that your customization values can be copied over into the newer version of the file.

2. Open the copy of the sap_error.cfg file that you created and specify the settings for the log attributes that you want (as shown in Figure Sample sap_error.cfg file provided by InfoPrint Manager, p. 51). For example, you can modify the log-backup-number attribute, which allows you to specify the number of backup logs that InfoPrint saves, including the initial error.log.BAK file.

Sample sap_error.cfg file provided by InfoPrint Manager

```bash
#
# ErrorLog Configuration File
#
# Log size (units = KBytes)
log-size = 1024
# Wrap On?
log-wrap = true
# Severity?
log-severity = debug
# Number of backup log files
log-backup-number = 10
```

When you start a SAP Callback daemon after a shutdown, it backs up the first error log by creating an error.log.BAK file. With each successive restart, it creates an additional .BAK file, adding a timestamp as a fourth qualifier. By default, the log-backup-number attribute specifies a
value of 10, meaning that you can have nine back up files with timestamps and the initial .BAK file. You can reduce this number as low as 1 or increase it as high as 999.

For a complete list of the error log attributes that you can customize, see the InfoPrint Manager: Reference.

3. Once you have finished defining your options, save and close the /var/pd/sap_error.cfg file.

**Note**

If you do not need the customization change to take effect immediately, you can skip the final two steps and just wait until the next time the SAP daemon is restarted.

4. From an AIX or Linux command line, you must do one of these tasks for the SAP Callback daemon to shut down so that these customization changes can take effect.

   - For the SAP Callback daemon, type `stopcbd sysname` (where sysname is the three-character SAP R/3 system name).

5. To restart the SAP Callback daemons:
   
   From an AIX command line:

   ```
   /etc/rc.iprsap
   ```

   All SAP daemons restart automatically if you have followed the configuration directions in Configuring to start callback daemons at system reboot on AIX, p. 35.

   From Linux command line:

   ```
   /etc/rc.iprsap
   ```

   From the InfoPrint Management Interface:

   1. Select the SAP Callback daemons you want to restart.
   2. Right-click on it and select Start.

**Customizing an SAP callback process error log on Windows**

By default, the SAP process error logs start when you create them. Use this procedure to customize the SAP error log or logs. Note that any SAP processes running on this server are changed by this customization.

1. Find the sap_error.cfg file in the bin directory that is located under the directory where the file is installed

2. Copy it into the workspace_path\sap directory.

The workspace_path is specified on the Workspace path field. From the InfoPrint Manager Management Console, select Edit → Service Configuration to verify the setting of the Workspace path field. For these examples, workspace_path signifies the fully qualified path where the error log is located, such as C:\Program Files\InfoPrint Manager\var\pd\.

**Note**

If you already customize your SAP error logs, remember to change the name or move the current sap_error.cfg file in workspace_path\sap so that your customization values can be copied over into the newer version of the file.
3. Open a copy of the sap_error.cfg file in the workspace_path\sap directory, and edit it to specify the settings for the log attributes that you want (as shown in Figure Sample sap_error.cfg file provided by InfoPrint Manager, p. 53). For example, you can modify the log-backup-number attribute, which lets you specify the number of backup logs that InfoPrint saves, including the initial error.log.BAK file.

Sample sap_error.cfg file provided by InfoPrint Manager

```plaintext
# ErrorLog Configuration File
#
# Log size (units = KBytes)
log-size = 1024
# Wrap On?
log-wrap = true
# Severity?
log-severity = debug
# Number of backup log files
log-backup-number = 10
```

When you start a SAP Callback process after a shutdown of the InfoPrint Manager server, it backs up the first error log by creating an error.log.BAK file. With each successive restart, it creates an additional .BAK file, adding a timestamp as a fourth qualifier. By default, the log-backup-number attribute specifies a value of 10, meaning that you can have nine back up files with timestamps and the initial .BAK file. You can reduce this number as low as 1 or increase it as high as 999.

For a complete list of the error log attributes that you can customize, see InfoPrint Manager: Reference.

4. Once you have finished defining your options, save and close the file.

**Note**

If you do not need the customization change to take effect immediately, you can skip the final four steps and just wait until the next time the InfoPrint Manager server is restarted.

5. From the Management Console, you must stop all SAP processes so that these customization changes can take effect:

1. Start the InfoPrint Manager Management Console.
2. In the Objects view in the left pane of this window, click **SAP Callback Processes**.
3. Stop all the SAP Callback processes that display in the main view by doing either of these options on each icon:
   - Right click and select **Stop SAP Callback**.
   - Highlight each icon and select these from the menu bar: **Actions → Stop**.

6. Once all SAP processes have been shut down, you must stop the SAP services:

1. Click **Start → Settings → Control Panel → Services**.
2. Highlight **SAP Services** and click **Stop**.

7. To restart the SAP Services:
1. Click Start → Settings → Control Panel → Services.
2. Highlight SAP Services and click Start.

8. Once the SAP Services have been restarted, you can restart the SAP Callback processes:
   1. Start the InfoPrint Manager Management Console.
   2. In the Objects view in the left pane of this window, click SAP Callback Processes.
   3. Restart individual SAP Callback processes that display in the main view by right-clicking on each icon and selecting Start SAP Callback.

**Shutting down the callback daemon on AIX**

This procedure describes how you can shut down the SAP callback daemon. This procedure is useful if you are migrating the SAP callback daemon from one InfoPrint Manager server to another or if the SAP R/3 system it supports is not going to be used for awhile.

From an AIX command line on the system where the SAP callback daemon is currently running, type:

```
stopcbd systemname
```

where systemname is your three-character SAP R/3 system name.

If you do not want a reboot of the system to restart the SAP callback daemon, remove its entry from the /etc/rc.ipr.sap file. If you remove its entry from the file, you do not have to do this task.

To make sure that no SAP callback daemons are restarted automatically whenever the systems they are running on are restarted, use the InfoPrint SMIT interface: InfoPrint Solutions → InfoPrint Utilities → SAP Daemons.

From the SAP Daemons panel, select the Do not start SAP daemons at reboot option.

If you are moving the SAP callback daemon to another system, remember to follow the instructions for both Starting the SAP callback daemon or process, p. 32 and Configuring to start callback daemons at system reboot on AIX, p. 35.

**Shutting down the callback daemon on Linux**

This procedure describes how you can shut down the SAP callback daemon. This procedure is useful if you are migrating the SAP callback daemon from one InfoPrint Manager server to another or if the SAP R/3 system it supports is not going to be used for awhile.

From a Linux command line on the system where the SAP callback daemon is currently running, type:

```
stopcbd systemname
```

where systemname is your three-character SAP R/3 system name.

From the InfoPrint Manager Management Interface:

1. Select the SAP Callback daemon you want to stop.
2. Right-click on it and select Stop.
If you do not want a reboot of the system to restart the SAP callback daemons, remove its entry from the `/etc/rc.iprsap.daemons` file. If you remove its entry from the file, you do not have to do this task.

To make sure that no SAP callback daemons are restarted automatically whenever the systems they are running on are restarted, go to **Applications** → **InfoPrint Manager** → **Management Interface** → **Options** → Configuration.

From the **Configuration** panel, do not check **Automatically start SAP Callback daemons during startup** option.

If you are moving the SAP callback daemon to another system, remember to follow the instructions for both Starting the SAP callback daemon or process, p. 32 and Configuring to start callback daemons at system reboot on Linux, p. 36.

**Shutting down the callback process on Windows**

This procedure describes how you can shut down the SAP callback process. This procedure is useful if you are migrating the SAP callback daemon from one InfoPrint Manager server to another or if the SAP R/3 system it supports is not going to be used for awhile.

To shut down the SAP callback process on an InfoPrint Manager Windows server, you must access the SAP Callback Processes from the InfoPrint Manager Management Console.

1. From the Start menu, select **Programs** → **InfoPrint Manager** → **Management Console**.
2. From the Objects view in the left pane of this window, click on **SAP Callback Processes** to switch the main view to SAP Callback Processes.
3. Select the particular SAP Callback Process you want to stop from those shown in the main view. You can do either one of these options:
   - Right-click and select **Stop SAP Callback**.
   - From the menu bar, select **Actions** → **Stop**.

If you are moving the SAP callback process to another system, remember to follow the instructions for Starting the SAP callback process on Windows, p. 37.

**Deleting an SAP callback process on Windows**

This procedure describes how you can delete an SAP callback process. This procedure is useful if you are removing one SAP callback process and replacing it with another, or if the SAP R/3 system it supports is not going to be used for awhile. If you accidentally created an SAP callback process for the wrong host or instance ID and you want to remove it from the InfoPrint Manager Management Console and the InfoPrint Manager namespace, you would use this procedure:

To delete the SAP callback process on an InfoPrint Manager Windows server, you must access the SAP Callback Processes from the Management Console.

1. From the Start menu, select **Programs** → **InfoPrint Manager** → **Management Console** path.

   **Note**

   Before deleting a particular SAP callback process, you must first stop it as described in Shutting down the callback process on Windows, p. 55.

   1. From the Start menu, select **Programs** → **InfoPrint Manager** → **Management Console** path.
2. Select the **SAP Callback Process** object.

3. From here, you can do either one of these actions to remove the process from the system:
   - Specify **Edit → Delete → SAP Callback Process**.
   - Right-click on the **SAP Callback Process** object and select **Delete**.
3. InfoPrint Manager non-OMS support

- Understanding SAP access method L support
- Installing InfoPrint SAP Client support when SAP runs on HP-UX, Linux, or Sun Solaris
- Installing the SAP Client when SAP runs on AIX
- Installing the SAP Client when SAP runs on Windows
- Configuring your SAP system to use the InfoPrint Manager Client command

Understanding SAP access method L support

If you either cannot or choose not to use SAP Output Management System (OMS) support, we recommend using SAP's local access method L (InfoPrint Manager's ipm_print command) to send jobs to the InfoPrint Manager server. InfoPrint Manager provides a command-line client interface for SAP to submit jobs to InfoPrint Manager with job attribute information and to query for jobs to determine when they have completed.

The InfoPrint Manager ipm_print command provides SAP job information to InfoPrint Manager. For example, each SAP userid can be used to track a job through the system. The corresponding ipm_query command allows InfoPrint Manager to provide job status to SAP. A job is not identified as complete until it actually prints or is deleted from the print queue.

For an alternative method of submitting jobs from non-AIX SAP R/3 or non-Linux SAP R/3 application servers that provide no feedback to the SAP servers, see Alternate access methods for submitting SAP jobs to InfoPrint Manager, p. 99.

To use the InfoPrint Manager SAP Transform, you must install the SAP Print Feature and fonts on every InfoPrint Manager server with actual destinations that transforms either SAP OTF or ABAP data. For information on installing the SAP Print Feature and fonts on the InfoPrint Manager server, see Installing the SAP Print Feature on the InfoPrint Manager server, p. 14.

Depending on the platform that your SAP system runs on, see the appropriate chapter from the list below to install and then see Configuring your SAP system to use the InfoPrint Manager Client command, p. 63 to configure your SAP system to use InfoPrint Manager's SAP access method L client:

- For installing InfoPrint Manager's client when SAP runs on HP-UX, Linux, or Sun Solaris servers, see Installing InfoPrint SAP Client support when SAP runs on HP-UX, Linux, or Sun Solaris, p. 57.
- For installing InfoPrint Manager's client when SAP runs on AIX servers, see Installing the SAP Client when SAP runs on AIX, p. 61.
- For installing InfoPrint Manager’s client when SAP runs on Windows systems, see Installing the SAP Client when SAP runs on Windows, p. 62.

When you have installed the InfoPrint Manager’s client for the appropriate operating system, see Configuring your SAP system to use the InfoPrint Manager Client command, p. 63 to configure your SAP system to use the InfoPrint Manager command.

Installing InfoPrint SAP Client support when SAP runs on HP-UX, Linux, or Sun Solaris

SAP R/3 installations that run on HP-UX, Linux, Sun Solaris or systems work with InfoPrint Manager when these installations are configured to invoke commands remotely on the InfoPrint server.

To use the access method L support of the SAP Print feature of InfoPrint Manager with an SAP R/3 system running on a non-AIX UNIX or non-Linux system, you must do these tasks:

1. Configuring the InfoPrint Manager server, p. 58
2. Configuring the SAP system server, p. 60

Configuring the InfoPrint Manager server

Follow the appropriate procedure depending on which version of InfoPrint Manager you are using:

- Configuring the InfoPrint Manager Windows server, p. 58
- Configuring the InfoPrint Manager AIX or Linux server, p. 59

Configuring the InfoPrint Manager Windows server

The rshd and rexecd services are prerequisites for HP-UX, Linux, and Sun Solaris SAP client support.

Use this procedure to configure the Windows server that has already installed InfoPrint Manager with the SAP Print Feature:

1. Install both an rshd and rexecd service on your InfoPrint Manager Windows server.
   
   
   During the installation of these services, make sure that remote users are defined users on the InfoPrint Manager for Windows system so that it is possible to write to this server from the Windows SAP client system.

2. From the Start menu, access the Programs → Administrative Tools → User Manager path.

3. Create a new user named sapuser.

   This user does not have to be part of any special groups.

4. Authorize the sapuser userid to issue remote commands by adding this entry to the .rhosts or equivalent file:

   +sapuser

5. Authorize all remote servers running the SAP R/3 applications to specify remote commands on the InfoPrint Manager Windows server by specifying:

   `fully_qualified_server_name +`

   where fully_qualified_server_name is either the IP address (in dotted decimal format) or the host name of the server.

   1. If you use a host name, TCP/IP must be able to resolve that name through either the security file or through a Domain Name Server (DNS).

   2. If a DNS is not being used, but the host name is specified in the hosts file, specify the fully qualified name in the .rhosts or equivalent file.

   3. If a DNS is not being used, and the host name is not specified in the hosts file, you must specify an IP address in the .rhosts or equivalent file (for example, 172.16.8.10 +).
For added accountability among SAP systems and print jobs, you can create separate Windows users for each SAP system or SAP R/3 application server. Repeat Steps through to create new user IDs that you can map to each SAP application server from which you plan to use InfoPrint Manager to print.

Turning off GOCA support on a Windows server

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an AFP data architecture used to represent pictures generated by computer. If your installation uses older printers (for example, 3900 printers as opposed to InfoPrint 4000 printers), GOCA support can cause the printers to print at less than rated speed. If your applications do not require GOCA support features, such as box shading, you might want to improve performance by turning off the GOCA support.

If your HP-UX, Linux, or Sun Solaris client is connected to an InfoPrint Manager Windows server, access the ipmcfg file from the directory where you installed InfoPrint Manager. When you click this file, it displays the IPM Server Settings dialog. From here, you can click the IPM GOCA Support check box to remove the check.

You can also turn off this support at a later date, as described in Adding box shading values to printed output, p. 91.

Configuring the InfoPrint Manager AIX or Linux server

Use this procedure to configure the AIX or Linux server that has already installed InfoPrint Manager with the SAP Print Feature.

1. Add a user called sapuser. This user does not have to be part of any special groups.
2. Authorize the sapuser userid to issue remote commands by adding this entry to the /etc/hosts.equiv file:

```
+ sapuser
```

3. Authorize all remote servers running the SAP R/3 application to specify remote commands on the InfoPrint Manager AIX or InfoPrint Manager Linux server as sapuser by doing this procedure:

   1. Add an .rhosts file with permissions of 600 to the /home/sapuser directory.
   2. Edit the .rhosts file and add a line for each non-AIX or non-Linux server running an SAP R/3 application with a plus (+) sign appended to it.

For added accountability among SAP systems and print jobs, you can create separate AIX or Linux users for each SAP system or SAP R/3 application server. Follow the three steps specified in this topic to create additional users (like sapuser) that you can map to each application server from which you will be using InfoPrint Manager to print.

For more information about using the rsh and rcp commands to connect to the InfoPrint Manager AIX or InfoPrint Manager Linux server and send files between servers, see your AIX Operating System or Linux Operating System documentation.

Turning off GOCA support on an AIX or Linux server

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an AFP data architecture used to represent pictures generated by computer. If your installation uses older printers (for example, 3900 printers as opposed to InfoPrint 4000 printers), GOCA support can cause
the printers to print at less than rated speed. If your applications do not require GOCA support features, such as box shading, you might want to improve performance by turning off the GOCA support.

If your HP-UX, or Sun Solaris client is connected to an InfoPrint Manager AIX or InfoPrint Manager Linux server, go to the AIX or Linux server and use this procedure:

1. Access the ipm_print file that reside in the /usr/lpp/pd/bin directory.
2. Using your AIX or Linux editor of choice, comment out the otheroptions="other-transform-options='-g'"; line by placing a hash mark (#) in front of the line.

You can also turn off this support at a later date, as described in Adding box shading values to printed output, p. 91.

### Configuring the SAP system server

To allow SAP HP-UX, Linux, or Sun Solaris to issue the InfoPrint Manager commands, you must install the InfoPrint Manager SAP Client on every SAP server where an SAP application server will issue the commands. This includes every application server with a spool work process (SWP) managing R/3 devices that have been configured to use access method L. If you have configured your SAP R/3 system to use alternate servers, you must repeat these installation tasks on the alternate servers as well.

Use this procedure to configure remote servers (HP-UX, Linux, or Sun) running the SAP R/3 application so you can print with InfoPrint Manager:

1. Obtain access to each HP-UX, Linux, or Sun Solaris server running SAP R/3 and log on.
2. Verify that you can ping the InfoPrint Manager server by host name:
   ```
   ping -c 3 hostname
   ```
   where hostname is the unqualified name for the InfoPrint Manager server, such as nwser.

   If the response shows that a good communication path exists, you will see this:
   ```
   ----tcpip_addr PING Statistics----
packets transmitted, 3 packets received, 0% packet loss
round-trip min/avg/max = 7/7/7 ms
   ```
3. Create a directory named /usr/lpp/pd/bin:
   ```
   mkdir /usr/lpp/pd/bin
   ```
4. Use the FTP client of your choice to copy these files from the InfoPrint Manager server to an SAP R/3 application server in your configuration. If you are using an InfoPrint Manager AIX or InfoPrint Manager Linux server, these files reside in the /usr/lpp/pd/bin directory. If you are using an InfoPrint Manager for Windows server, these files reside in the Install_path\bin folder:
   - ipm_print.sys
   - ipm_query.sys

   For the secondary qualifier (sys), specify the name of the system where your SAP applications are running, hp for HP-UX, linux for Linux, or sun for Sun Solaris.
5. Make sure that each file copied in Step 5 is executable.
6. On the SAP application server in your installation, edit both files so they specify the name of the user (sapuser) and host name where InfoPrint Manager is running. If you want the SAP Client for Linux, HP-UX, or Sun Solaris to use the secure shell (SSH) and secure copy (SCP) commands, you must edit these files so that they specify the secure shell commands. The default behavior of the SAP Clients is to use the remote shell commands (RSH).

   To use the secure shell commands, you must change the value rsh to ssh:

   ```
   # change the line below from "rsh" to "ssh" for secure shell
   remote_shell="rsh"
   ```

7. Copy the edited SAP command files to any other SAP application servers in your installation that use the InfoPrint Manager server.

Once you have completed this procedure, follow the directions for updating the SAP Profile to activate the SAP Print command and define SAP devices that use access method L in Configuring your SAP system to use the InfoPrint Manager Client command, p. 63.

### Installing the SAP Client when SAP runs on AIX

To allow SAP to issue the InfoPrint Manager commands, you must install the InfoPrint Manager SAP client on every SAP server where an SAP application server will issue the commands. This includes every application server with an SWP managing R/3 devices that have been configured to use access method L for sending jobs to InfoPrint Manager. If you have configured your SAP R/3 system to use alternate servers, you must repeat these installation tasks on the alternate servers as well.

To install the SAP client for AIX on your SAP application servers, use this procedure:

1. Log into the AIX system as root.

2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642 into the DVD-ROM reader.

3. Open a terminal window.

   - If you are using the Common Desktop Environment (CDE), you can open a terminal window by clicking on the terminal icon contained in the front panel. (The front panel is the task bar that appears at the bottom of the screen.) By default, the terminal icon is contained in a pop-up menu above the text editor icon that appears on the front panel.

4. The first time you run the Installer, follow this procedure:

   1. Type this on the command line:

      ```
      smit cdrfs
      ```

   2. Select **Add a CDROM File System** from the list of choices presented.

   3. Click the List button and select your DVD-ROM device name (cd0, for example).

   4. Type this in the **MOUNT POINT** field:

      ```
      /cdrom
      ```

   5. Click **OK**. The running person will raise his arms to indicate success. If he instead falls down and you see `crfs: 0506-909 /cdrom file system already exists, do not interpret this as a failure. (The existing /cdrom file system should be usable.)`

   6. Press the F12 key to exit SMIT.
5. Type this on the command line:

```
mount /cdrom
```

6. The SAP Client package (ipr.sapclient) is installed at the command line by specifying `setup -x`.

During the course of the install, you are prompted to specify values for both PDHOST and PD_SOCKET.

### Notes

1. The SAP Client package cannot be installed if other ipr* filesets reside on an SAP application server.

2. If your installation uses older printers (for example, 4000 printers instead of InfoPrint 4100 printers),
the GOCA support can cause the printers to print at less than rated speed. If your applications do not require GOCA support features, such as box shading, you might want to improve performance by turning off the GOCA support. For instructions on turning off this support after installing the SAP Client, see Adding box shading values to printed output, p. 91.

Once you have completed this procedure, follow the directions for updating the SAP profile to activate the SAP Print Command and define SAP devices that use access method L in Configuring your SAP system to use the InfoPrint Manager Client command, p. 63.

### Installing the SAP Client when SAP runs on Windows

To allow SAP to issue the InfoPrint Manager commands, you must install the InfoPrint Manager SAP client on every SAP server where an SAP application server will issue the commands. This includes every application server with an SWP managing R/3 devices that have been configured to use access method L for sending jobs to InfoPrint Manager. If you have configured your SAP R/3 system to use alternate servers, you must repeat these installation tasks on the alternate servers as well.

To install the InfoPrint Manager SAP Client for Windows on your Windows SAP system, use this procedure:

1. Log in as the Administrator user.
2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642 into your DVD-ROM drive.
3. From the InfoPrint Manager: Common Clients window, click **Install InfoPrint Manager Products**.
4. Click on **InfoPrint Manager SAP Clients**.
5. Select a location for installing the clients (the default is `install_path \Infoprint Manager SAP Clients \`).
6. From the IPM Server Settings pop-up dialog, specify either the fully qualified host name or the IP address of the InfoPrint Manager server to which you will be sending jobs. The **IPM Hostname** field defaults to showing the loop back address and must be changed. The **IPM Server Port Number** field defaults to 6874, which you do not need to change.
Notes

1) Do not check the **IPM Debug Mode** checkbox unless instructed to do so by technical support.

2) Enable the **IPM LDAP Mode** if you are using the InfoPrint Manager Pull Print feature with your InfoPrint Manager server. For more information, see **Enabling LDAP mode**, p. 88.

3) Remove the check in the **IPM GOCA Support** checkbox only if you want to turn off graphics object content architecture (GOCA support) in the SAP transform.

   By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an AFP data architecture used to represent pictures generated by computer. If your installation uses older printers (for example, 3900 printers instead of InfoPrint 4000 printers), the GOCA support can cause the printers to print at less than rated speed. If your applications do not require GOCA support features, such as box shading, you might want to improve performance by turning off the GOCA support. For instructions on turning off this support after installing the SAP Client, see **Adding box shading values to printed output**, p. 91.

   Once you have set the appropriate values, click **OK** to close this dialog.

7. When the SAP client has been installed, click **Finish**.

8. To exit the install process, click **Back**, and then the **Exit** button on the next screen.

9. To complete the configuration, follow the directions for updating the SAP Profile to activate the SAP print command and define SAP devices that use access method L as described in **Configuring your SAP system to use the InfoPrint Manager Client command**, p. 63.

### Configuring your SAP system to use the InfoPrint Manager Client command

SAP R/3 systems work best with InfoPrint Manager when these installations are configured to use our ipm_print command.

The InfoPrint Manager ipm_print command provides SAP job information to InfoPrint Manager. For example, each SAP userid can be used to track a job through the system. The corresponding ipm_query command allows InfoPrint Manager to provide job status to SAP. A job is not identified as complete until it actually prints or is deleted from the print queue.

Use the **Modifying the print profile for SAP**, p. 63 before **Defining SAP devices to send jobs to InfoPrint Manager**, p. 65.

### Modifying the print profile for SAP

To print with access method L from an SAP server, you must edit the print profile on your SAP application server. From your SAP R/3 graphical user interface, use this procedure:

1. Enter RZ10 in the **OK-Code** field to access the Edit Profiles window.

2. Select the **Extended maintenance** radio button and click **Change** to access the Maintain R/3 Profile print_profile window.
3. In the appropriate fields, specify these values, and click **Check** in the upper left corner to save the values. You will return to the screen two more times to add rsno/host_spool/query, and rsno/host_spool/answer_format values:

**Parameter name:**

rsno/host_spool/print

**Parameter val:**

```
ipm_print -P &P -F &F -O '&O' -o '&o' -R '&R' -C &C -Y '&Y' -T "&T" -D 
"&D" -t '&t'
```

**Parameter name:**

rsno/host_spool/query

**Parameter val:**

rsno/host_spool/query=ipm_query -P&P

**Parameter name:**

rsno/host_spool/answer_format

**Parameter val:**

rsno/host_spool/answer_format=lpstat

**Note**

For the rsno/host_spool/print values, some parameters are in single quotation marks (’&o’) and some are in double quotation marks (“&T”).

4. Specify the **Check** icon in the upper left corner to save this data.

   The SAP system responds by providing a display that demonstrates how this print profile has been changed. Note the two highlighted sections to see the ipm_print and ipm_query SAP clients:

   **Active parameters list display from changed print profile**

<table>
<thead>
<tr>
<th>0/12/2001</th>
<th>Active parameters</th>
<th>14:33:04</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter name</td>
<td>Parameter value</td>
<td></td>
</tr>
<tr>
<td>rsno/host_spool/query</td>
<td>ipm_query -P &amp;P</td>
<td></td>
</tr>
<tr>
<td>rsno/host_spool/print</td>
<td>ipm_print -P &amp;F -F -O &quot;&amp;O&quot; -o &quot;&amp;o&quot;</td>
<td></td>
</tr>
<tr>
<td>eu/iwb/server_win32</td>
<td>hrmss1.jones.s10.ca.us</td>
<td></td>
</tr>
<tr>
<td>eu/iwb/server_mac</td>
<td>hrmss1.jones.s10.ca.us</td>
<td></td>
</tr>
<tr>
<td>eu/iwb/path_mac</td>
<td>zdummy</td>
<td></td>
</tr>
<tr>
<td>login/system_client</td>
<td>400</td>
<td></td>
</tr>
<tr>
<td>SAPLOCALHOST</td>
<td>hrmssbx</td>
<td></td>
</tr>
<tr>
<td>eu/iwb/path_win32</td>
<td>saphelp\helpdata</td>
<td></td>
</tr>
</tbody>
</table>

5. Once you have completed steps 4 and 5 three times to enter all the appropriate values, you must save these print profile changes. To save these print profile changes, be sure you check **yes** for the dialog box about the parameter change.

6. Then make sure that you click **yes** for the dialog box about the profile change.
If you neglect to specify yes for both dialog boxes, the SAP system might not save your changes. Once you verify these changes to the print profile, SAP R/3 might display this message, which you can ignore:

7. Once you have notified the other SAP R/3 application users, click Save and restart (bounce) the R/3 application servers.

Once you have completed these procedures, you can create devices to print from your SAP R/3 system, using InfoPrint Manager to drive the printers. Use the procedure for Defining SAP devices to send jobs to InfoPrint Manager, p. 65.

### Defining SAP devices to send jobs to InfoPrint Manager

This section describes how to create a new output device for printing to InfoPrint Manager. To enable this support, an SAP R/3 administrator must do this procedure from the SAP R/3 graphical user interface:

1. Make sure that you have a logical destination defined in InfoPrint Manager, which will send jobs to your physical printer device.
2. From the R/3 main menu, access the Spool Administration window by clicking the Tools main menu and then selecting the Tools → Administration → Spool → Spool Administration path, or typing /nSPAD in the ok-Code field.
3. From the Spool Administration window, select the Output devices option and click Change.
4. Click Create and fill in this information about the Create Output Device window:

#### Devices that use the InfoPrint Manager OMS

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output device</td>
<td>Type the name that R/3 users will need to access the printer.</td>
<td>PRT1</td>
</tr>
<tr>
<td>Device type</td>
<td>Select the device type that has been defined in the R/3 system for the printer model. POSTSCPT applies to any PostScript printer, while HPLJ4 applies to a Hewlett-Packard LaserJet 4 printer. SAPGOF sends both OTF and ABAP data to be transformed into AFP by the InfoPrint Manager SAP Transform.</td>
<td>POSTSCPT</td>
</tr>
<tr>
<td>Spool server</td>
<td>Select the name of the R/3 application server which will be the SAP R/3 spool server (spool work process) that</td>
<td>us01d2_P40_41</td>
</tr>
<tr>
<td>Field</td>
<td>Explanation</td>
<td>Example value</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td>processes requests for this device.</td>
<td></td>
</tr>
<tr>
<td>Host printer</td>
<td>Type the name of the InfoPrint Manager logical printer.</td>
<td>prt1-lp</td>
</tr>
<tr>
<td>Device class</td>
<td>Enter a space so that this field accepts the default value of printer, which is P.</td>
<td></td>
</tr>
<tr>
<td>Access method in host spool</td>
<td>Select the method that the spool work process uses to pass data to the host spool system.</td>
<td>L</td>
</tr>
</tbody>
</table>

5. From the menu bar, click **Back** and the system will prompt you to save the new output device.

**Note**

If your logical destination does not receive a job sent from your SAP device, delete and recreate the SAP callback daemon with the same settings on the InfoPrint Manager server.
4. Customizing your print environment

- Fax support in SAP R/3
- Print support that applies to InfoPrint Manager AIX and Windows servers
- Using bar codes with SAP R/3
- Alternate access methods for submitting SAP jobs to InfoPrint Manager

Fax support in SAP R/3

InfoPrint Manager provides one method for supporting fax support to SAP users: the SAPcommunications interface. The SAPcomm interface applies to all SAP releases until Release 6.1 and only provides you the ability to send faxes (fax-out) to InfoPrint Manager email or actual destination.

The SAPcomm method combines all the benefits of using InfoPrint Manager's OMS support (see Installing and configuring InfoPrint Manager’s OMS, p. 13) with the ability to send faxes. You can also send faxes from your SAP system to InfoPrint Manager, using access method L (see InfoPrint Manager non-OMS support, p. 57).

Note

Fax support is not currently available with InfoPrint Manager for Windows, unless you are also using InfoPrint Manager for AIX or InfoPrint Manager for Linux.

Using SAPcomm support for fax-out

Faxing jobs from SAP R/3 to InfoPrint Manager is similar to printing jobs from SAP R/3 to InfoPrint Manager: you must define an SAP device that is connected to an InfoPrint Manager destination. However, you must define an SAP device so that a fax number can be passed to InfoPrint Manager.

To submit faxes from SAP R/3 systems using SAPcomm, you must:

- Configure the InfoPrint Fax support on your InfoPrint Manager AIX or InfoPrint Manager Linux server
- Set your SAP system to send print jobs to InfoPrint Manager using either the OMS support (see Installing and configuring InfoPrint Manager’s OMS, p. 13) or access method L (see InfoPrint Manager non-OMS support, p. 57)

Once you have verified that these prerequisites have been done, use these two procedures to implement sending faxes from SAP R/3.

Creating an R/3 fax device

This procedure describes how you can create an SAP R/3 fax device for submitting jobs to an InfoPrint Manager AIX server:

1. Make sure that you have defined a logical destination in InfoPrint Manager that will send jobs to the fax destination.
2. From the SAP R/3 graphical user interface, specify either /nspad transaction in the ok-Code field, or take the Tools → Administration:Spool → Spool Administration) path from the main menu.
3. From the Spool Administration: Initial Screen window, click Output Devices, click Change (red pencil), and push Output Devices.
4. From the Spool Administration: List of Output Devices window, click **Create** (white paper image to the right of the trash can).

5. From the Spool Administration: Create Output Device window, fill in this information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output device</strong></td>
<td>FAX</td>
</tr>
<tr>
<td></td>
<td>Type the name that R/3 users will need to access the device.</td>
</tr>
<tr>
<td><strong>Device class</strong></td>
<td>F</td>
</tr>
<tr>
<td></td>
<td>Select a device class for the fax.</td>
</tr>
<tr>
<td><strong>Host printer</strong></td>
<td>ip01-sam</td>
</tr>
<tr>
<td></td>
<td>Type the InfoPrint Manager logical destination (printer) name that</td>
</tr>
<tr>
<td></td>
<td>will send the job to the InfoPrint email or actual destination.</td>
</tr>
<tr>
<td><strong>Access method to host spool</strong></td>
<td>access method E or access method L</td>
</tr>
<tr>
<td></td>
<td>Make sure that you specify the appropriate access method, depending</td>
</tr>
<tr>
<td></td>
<td>upon how you configure your SAP system to communicate with InfoPrint</td>
</tr>
<tr>
<td></td>
<td>Manager.</td>
</tr>
<tr>
<td><strong>LOMS (only applies to access method E).</strong></td>
<td>IPM001</td>
</tr>
<tr>
<td></td>
<td>If you are running with the InfoPrint Manager OMS support (access</td>
</tr>
<tr>
<td></td>
<td>method E), specify the LOMS to which this device should be assigned.</td>
</tr>
<tr>
<td></td>
<td>You specified this value on the Spool Admin.: Logical Output</td>
</tr>
<tr>
<td></td>
<td>Management System window when you defined the InfoPrint Manager OMS</td>
</tr>
<tr>
<td></td>
<td>(see Defining the InfoPrint Manager OMS to SAP R/3 on the SAP system</td>
</tr>
<tr>
<td></td>
<td>server, p. 28).</td>
</tr>
<tr>
<td><strong>Spool server</strong></td>
<td>ibmbtt15_BTF_15</td>
</tr>
<tr>
<td></td>
<td>Select an applicable spool server from the entries list on the field.</td>
</tr>
</tbody>
</table>

6. Save your device definition by specifying **Output Device → Save** from the menu options.

7. Specify the **/ns con** (**Tools → Communication → Configuration**) transaction.

8. From the SAPcomm: Configuration window, select the **Location** option from the Destination pane and click **Change**.

9. Click on the check box to close the pop-up message window that displays information about the table’s client independent status.
10. From the SAPcomm: "destination location": Overview window, click **New entries** and specify the **Output Device** that you created in step.

**Note**

Specify the appropriate country code in the Cntry column. For example, specify US for an installation in the United States.

11. From the New Entries: Details of Created Entries window, click **Save** to save your changes.

12. From the SAPcomm: Configuration window, select the **Selection** option from the Destination pane and click **Change**.

13. Click on the check box to close the pop-up message window that displays information about the table's client-independent status.

14. From the SAPcomm: "destination selection" window, click **New Entries**.

15. From the New Entries: Details of Created Entries window, fill in these values on the Selection pane:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>TELEFAX</td>
</tr>
<tr>
<td></td>
<td>Specify the type of service.</td>
</tr>
<tr>
<td>Cntry</td>
<td>US</td>
</tr>
<tr>
<td></td>
<td>Specify the country code that you specified in Step.</td>
</tr>
</tbody>
</table>

**Note**

The **Key**, **Type**, **Area Served**, and **Device group** fields should all be left blank.

16. Under the Destination pane, specify the output device that you created in Step: FAX.

**Note**

The **Country of location** field should be left blank.

17. Save your fax definition by clicking the **Save** folder icon.

Once you have completed this procedure, you are ready to submit a fax request from SAP R/3 to InfoPrint Manager.

**Submitting a fax from SAP R/3 to InfoPrint Manager**

Once you have finished creating an R/3 fax device, you can use this procedure to submit a fax from your SAP R/3 system to the InfoPrint Manager AIX or InfoPrint Manager Linux server:

1. From the SAP R/3 graphical user interface, create a spool request for a document that you want to fax.

**Note**

Make sure that the **Print immediate** button is not selected.
2. Enter /nsp01 in the **ok-Code** field.

3. From the Spool Requests window, select the spool request that you specified in Step and click **Printer**.

4. From the Spool: Output Request window, specify the relevant fields in the Print parameters and Title page pane, then click **Fax**.

5. From the Spool: Query FAX Number pop-up window, specify the number to which you are sending the fax in the **Recipient number** field and the appropriate country key in the **Country key** field.

6. Click **Fax**.

7. Your fax job will be sent to the InfoPrint Manager email or actual destination and be mailed or printed. You can also fax from SAP applications by providing the fax number and selecting the Fax device.

### Print support that applies to InfoPrint Manager AIX and Windows servers

These sections describe SAP R/3 features that can be used by installations running SAP R/3 Release 4 and later with InfoPrint Manager for AIX or InfoPrint Manager for Windows. All interfaces apply to AIX and Windows platforms unless clearly identified with a particular operating system.

### Customizing print characteristics

These sections describe how you can change output appearance when printing through InfoPrint Manager by modifying SAP devices and formats.

### How InfoPrint processes code pages from ABAP and OTF jobs

Code page support for OTF jobs is more flexible than for ABAP jobs.

Because OTF jobs request a specific font, the SAP transform compares the specified font name and point size values with the entries in the fonts.tab configuration file. If the transform finds a match, it uses both the AFP character set and AFP code page for the print job.

ABAP jobs can use different character sets, but are confined to using the same code page. When processing ABAP files, the SAP transform uses:

- The defcp.tab file to map single-byte ASCII code points to EBCDIC code points before calling the uconv utility.
- The pagedef.tab file to match the Paper parameter value with the PJPAPER or PJFORM (depending on the SAP/R3 version used) parameter value in the ABAP print job.

Once they are matched, the SAP transform uses the FontNorm and FontBold parameters on the selected line in the pagedef.tab file to determine which character sets to use in both normal and bold mode.
For ABAP jobs that are processed using Unicode, the `FontNorm` and `FontBold` fields are ignored, because the Unicode fonts are mapped in the page definition.

As a result, all ABAP jobs sent to a particular InfoPrint server use the same code page, but potentially different character sets, depending upon the `PJPAPER` value specified in the job.

**Defining a customized device type**

An SAP device type is a collection of table entries that you can access and modify online to describe the fonts, the printer driver to use to create the data, and the formats that can be used for SAPscript printing. Every output device must have a device type that is used to process the output document. An actual destination can have many output devices, with different device types for each one.

For basic printing, the SAP transform can use existing device types (such as SAPGOF) and existing formats, such as LETTER or X_65_255. However, if you plan on customizing any of these print characteristics, you should create a customized device type so that you will not lose data when you upgrade your SAP R/3 system.

To create a customized device type, an SAP R/3 administrator must do this procedure from the SAP R/3 graphical user interface:

1. From the R/3 main menu, access the Spool Administration window by selecting **Tools** main menu and then selecting the **Tools** → **Administration** → **Spool** → **Spool Administration** path or typing `/nSPAD` in the `ok-Code` field.
2. From the Spool Administration window, select **Utilities** → **Copy device type** pull-down option.
3. From the Copy Device Type window, specify the device type you want to customize (in this case, SAPGOF) in the **Copy device type** field and provide a name for your customized Device Type (in this case, ZDOCGOF) in the **to device type** field.

**Note**

Any customized Device Type must start with the Z character or it will be overwritten when you upgrade to a new level of SAP R/3.

4. From the menu bar, click **Execute**.
5. From the Create Object Catalog Entry window, decide whether you want to be able to copy this customized device type to another SAP system. If you do, specify a **Development class** field value.

   If you do not need to copy this Device Type to another SAP system, click **Local object**:

6. Click **Save**.

SAP R/3 provides a screen to show the customized Device Type and the original device type from which it was copied.

**Changing document print orientation**

The sap2afp transform lets you enhance the quality of your printing from an SAP R/3 enterprise through the use of form definitions. Form definitions allow you to use electronic overlays and specify both media orientation (how the page is printed) and bin selection. The sap2afp transform defines which form
definition should be used for printing through the use of Formats. Every spool job in R/3 requires a Format (Paper type), whether it is ABAP data (X_65_80) or OTF data (LETTER). SAP R/3 formats are mapped to Advanced Function Presentation (AFP) form definitions in the pagedef.tab configuration file. You can display the Format of a spool request in the output controller (SP01).

By default, the sap2afp transform uses F1SAP form definition, p. 75, which by default defines duplex, portrait printing. In addition, InfoPrint Manager provides an assortment of form definitions, which are documented in the InfoPrint Manager: Reference. Consult this list to find a form definition that meets your printing needs.

This section describes how to specify landscape media orientation through a form definition for an entire document and then connect the newly-created format to a device type. By mapping an SAP Format to a form definition in the pagedef.tab file, you can define the media style for the entire job. Depending upon the type of data you wish to print, there are two separate procedures:

- Defining a customized device type for ABAP jobs, p. 72
- Defining a new OTF format, p. 72

**Defining a customized device type for ABAP jobs**

If you are printing Advanced Business Application Programming (ABAP) jobs, you must create a blank ABAP Format in the SAP system by using this procedure:

1. From the R/3 main menu, access the Spool Administration window by selecting the **Tools** main menu and then selecting **Tools** → **Administration** → **Spool** → **Spool Administration** path, or typing /nSPAD in the **ok-Code** field.

2. From the Spool Administration: Initial Screen window, select the **Formats** option and click **Change**.

3. From the Spool Administration: Format window, select an existing Format (in this case, X_65_255) from which to copy.

   ![Note](https://example.com/note-icon.png)

   All ABAP system formats follow the naming convention of X_number-of-rows_number-of-columns.

4. From the Spool Administration: Copy Format from X_65_255 window, specify the name of your customized Format with the naming convention of Z_number-of-rows_number-of-columns_more-identifying-text.

5. Click the back icon (the left-pointing arrow) and the system prompts you to save the new ABAP format.

Once you have saved the new ABAP format, you must use Connecting a new format to a device type, p. 74.

**Defining a new OTF format**

If you are printing Output Text Format (OTF) jobs, you must create page format with the same name as the customized format you plan to apply:

1. From the R/3 main menu, access the Spool Administration window by selecting the **Tools** main menu and then selecting the **Tools** → **Administration** → **Spool** → **Spool Administration** path, or typing the /nSPAD transaction in the **ok-Code** field.

2. From the Spool Administration: Initial Screen window, select the **Page formats** option and click **Change**.
3. Select the page format that you want to copy (in this case, LETTER) and click **copy from**.

4. From the Spool Administration: Copy Page Format from LETTER window, specify the name of the customized paper type that you are creating (in this case, ZLETDOC).

5. Select the back icon (the left-pointing arrow) and the system prompts you to save the new page format.

6. Specify `/nSPAD` in the **ok-Code** field.

7. From the Spool Administration: Initial Screen window, select the **Formats** option and click **Change**.

8. Select the Format that you wish to copy (in this case, ZLETDOC), and click **Copy from**.

9. From the Spool Administration: Copy Format from LETTER window, fill in the values as displayed in Spool Administration: Copy Format from LETTER window, p. 73:

**Spool Administration: Copy Format from LETTER window**

![Spool Administration: Copy Format from LETTER window](image)

10. Click the **Back** icon (the left-pointing arrow) and the system prompts you to save the new OTF format.
Once you have saved the new OTF format, you must use Connecting a new format to a device type, p. 74.

Connecting a new format to a device type

To use the format you created, you must connect the format to a device type by doing these steps:

1. From the R/3 main menu, access the Spool Administration window by selecting the Tools main menu and then selecting the Tools → Administration → Spool → Spool Administration path, or typing /nSPAD in the ok-Code field.

2. From the Spool Administration: Initial Screen window, select the Device formats option and click Change.

3. From the Spool Administration: Choose Format for Device Type window, specify the Device Type (link to creating custom device types) and your customized Format name (in this case, Z_65_255_DOC or ZLETDOC) in the appropriate fields.

   ![Note]

   All ABAP customized user Formats follow the naming convention of Z_number-of-rows_number-of-columns_descriptive-text.

4. Click Execute.

5. From the Maintain Format for Device Type window, the blank left column indicates that the customized format has not yet been initialized.

6. Click Copy format.

7. From the Spool Administration: Copy Format window, you can see that the system has filled in the information from the Maintain Format for Device Type window.

8. Press the Copy from button to initialize your new Format.

9. Click the back icon (the left-pointing arrow) and the system prompts you to save the new format.

10. Access the pagedef.tab configuration file that is located in the /usr/lpp/psf/sap2afp directory on an InfoPrint Manager AIX or InfoPrint Manager Linux server and the install_path\sap2afp folder on an InfoPrint Manager Windows server.

11. In the pagedef.tab configuration file, create a new entry for the format that you just created. If you are printing landscape, specify F1C10011 as the form definition value.

   ![Note]

   All fields must be specified in pagedef.tab. However, for OTF printing, only the form definition value is used, while ABAP printing uses all values.

12. Exit and save the pagedef.tab configuration file.

Changing page print orientation

The sap2afp transform lets you enhance the quality of your printing from an SAP R/3 enterprise through the use of form definitions. Form definitions allow you to use electronic overlays and specify both media orientation (how the page is printed) and bin selection. A form definition can consist of multiple copy groups, which are also known as media maps.
This procedure shows how you can define a name for each defined page in an existing Layout Set. If you do not need to change page orientation on a page-by-page basis, see Changing document print orientation, p. 71. Page-by-page mapping is necessary only if different pages in a document are formatted differently. You should use a custom layout set when making these changes. If you use a system Layout Set, your changes are overwritten each time you upgrade your SAP R/3 system. Remember that each media map remains in effect until SAP R/3 encounters a new media map.

Every spool job in R/3 requires a format (Paper type), whether it is ABAP data (X_65_80) or OTF data (LETTER). SAP R/3 formats are mapped to Advanced Function Presentation (AFP) form definitions in the pagedef.tab configuration file. You can display the format of a spool request in the output controller (SP01).

When mapping an SAP Format to a form definition in the pagedef.tab file, the first media map in the form definition defines the media style for the entire job. If you have a job that contains different electronic overlays on each page, you might have to switch media styles on each page. The sap2afp transform converts names defined in SAP Layout Sets in the paper resources for pages to AFP media map names. For each page that defines a paper resource, the sap2afp transform uses the AFP media map.

By default, the sap2afp transform uses F1SAP form definition, p. 75, which contains 25 separate media maps for simplex printing, duplex printing, bin selection, and page orientation. In addition, InfoPrint Manager provides an assortment of form definitions, which are described in the InfoPrint Manager: Reference.

Use this procedure on your SAP application server to modify the media map on any page of a job by specifying the media map defined in the F1SAP form definition for the Resource name field:

1. From the SAP R/3 graphical user interface, access the Layout Set menu screen.

   You can access this view from the SAP R/3 main menu by either specifying the SE71 transaction code in the ok-Code field, or by selecting: Tools → Word Processing → Layout Set

   In SAP R/3 Release 4.9, the Layout Set menu is the Page menu, which contains the Resource Name field cited in step 1.

2. From the Layout Set main menu, access the Change Pages option and select the job for which you are changing page orientation (in this case, ZASORDER1).

3. From the first page of the job, double-click so that it is highlighted and fill in the Resource Name field (under the Print Attributes pane).

4. Double-click the next page that you intend to modify and fill in the Resource Name field on the second page.

5. Continue with the same procedure on any page where you want to specify a new media style.

6. Once you have finished, click Save (open folder) to save this setting.

F1SAP form definition

The form definition specified in the pagedef.tab configuration file is the default submitted with every Advanced Function Presentation (AFP) data stream document. F1SAP is the default form definition that each of the media maps references. Table F1SAP Form Definition Values, p. 76 briefly describes the media maps contained in this form definition.
The print direction is across and the Page Position in inches from the edge of the paper is 0.165, 0.165 for all 25 media maps.

**F1SAP Form Definition Values**

<table>
<thead>
<tr>
<th>Media map</th>
<th>Bin</th>
<th>Sides</th>
<th>Presentation mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1A10111</td>
<td>1</td>
<td>2</td>
<td>Portrait</td>
</tr>
<tr>
<td>S100000P</td>
<td>1</td>
<td>1</td>
<td>Portrait</td>
</tr>
<tr>
<td>S200000P</td>
<td>2</td>
<td>1</td>
<td>Portrait</td>
</tr>
<tr>
<td>S300000P</td>
<td>3</td>
<td>1</td>
<td>Portrait</td>
</tr>
<tr>
<td>S400000P</td>
<td>4</td>
<td>1</td>
<td>Portrait</td>
</tr>
<tr>
<td>D100000P</td>
<td>1</td>
<td>2</td>
<td>Portrait</td>
</tr>
<tr>
<td>D200000P</td>
<td>2</td>
<td>2</td>
<td>Portrait</td>
</tr>
<tr>
<td>D300000P</td>
<td>3</td>
<td>2</td>
<td>Portrait</td>
</tr>
<tr>
<td>D400000P</td>
<td>4</td>
<td>2</td>
<td>Portrait</td>
</tr>
<tr>
<td>T100000P</td>
<td>1</td>
<td>2</td>
<td>Portrait</td>
</tr>
<tr>
<td>T200000P</td>
<td>2</td>
<td>2</td>
<td>Portrait</td>
</tr>
<tr>
<td>T300000P</td>
<td>3</td>
<td>2</td>
<td>Portrait</td>
</tr>
<tr>
<td>T400000P</td>
<td>4</td>
<td>2</td>
<td>Portrait</td>
</tr>
<tr>
<td>S100000L</td>
<td>1</td>
<td>1</td>
<td>Landscape</td>
</tr>
<tr>
<td>S200000L</td>
<td>2</td>
<td>1</td>
<td>Landscape</td>
</tr>
<tr>
<td>S300000L</td>
<td>3</td>
<td>1</td>
<td>Landscape</td>
</tr>
<tr>
<td>S400000L</td>
<td>4</td>
<td>1</td>
<td>Landscape</td>
</tr>
<tr>
<td>D100000L</td>
<td>1</td>
<td>2</td>
<td>Landscape</td>
</tr>
<tr>
<td>D200000L</td>
<td>2</td>
<td>2</td>
<td>Landscape</td>
</tr>
<tr>
<td>D300000L</td>
<td>3</td>
<td>2</td>
<td>Landscape</td>
</tr>
<tr>
<td>D400000L</td>
<td>4</td>
<td>2</td>
<td>Landscape</td>
</tr>
<tr>
<td>T100000L</td>
<td>1</td>
<td>2</td>
<td>Landscape</td>
</tr>
<tr>
<td>T200000L</td>
<td>2</td>
<td>2</td>
<td>Landscape</td>
</tr>
<tr>
<td>T300000L</td>
<td>3</td>
<td>2</td>
<td>Landscape</td>
</tr>
<tr>
<td>T400000L</td>
<td>4</td>
<td>2</td>
<td>Landscape</td>
</tr>
</tbody>
</table>
Enabling non-Latin character sets

The sap2afp transform supports the use of these non-Latin character sets on both the AIX, Linux, and Windows operating systems:

• Japanese (Shift-JIS encoding)
• Korean
• Simplified Chinese
• Traditional Chinese
• Cyrillic

All are multi-byte character sets (MBCS) except Cyrillic, which is single-byte.

The sap2afp transform supports these character sets through the use of the uconv utility. To use this support, you must run the SAPGOF (or a compatible) device type on an SAP R/3 system at Release 4.0A or higher.

Before doing these configuration tasks on AIX, Linux, and Windows systems, you must first obtain and install the selected AFP fonts that are required for printing.

• ABAP data requires raster fonts.
• OTF data can be printed with either raster or outline fonts.

You can obtain these resources from either of these product DVD-ROMs:

• InfoPrint Font Collection: AFP Outline Fonts, LCD4-5683-02 (DVD). This DVD includes AFP Outline fonts, CID fonts, and Type1 fonts. For more information about purchasing this product, see either your sales representative or access the AFP Font Collection home page (http://rpp.ricoh-usa.com/products/software/composition/inforprint-font-collection) on the World Wide Web.

• InfoPrint Font Collection: AFP Raster Fonts, LCD4-5700-02 (DVD). This DVD includes AFP Raster fonts. This product includes outline fonts only. For more information about purchasing this product, see either your sales representative or access the AFP Font Collection home page (http://rpp.ricoh-usa.com/products/software/composition/inforprint-font-collection) on the World Wide Web.

When you have installed these fonts, make sure that your actual destination uses the /usr/lpp/psf/fontlib directory as its primary search path for fonts. To modify the font search path from the InfoPrint Manager Administration GUI:

1. From the InfoPrint Manager Administration Servers window, highlight the actual destination.
2. Right-click and select Properties from the pop-up menu.
3. From the printer properties window, select the AFP Resources tab and specify:

   • /usr/lpp/psf/fontlib in the Location of fonts field on InfoPrint Manager for AIX or InfoPrint Manager for Linux

   • install_path\fontlib in the Location of fonts field on InfoPrint Manager for Windows
Enabling non-Latin character sets on an InfoPrint Manager AIX or InfoPrint Manager Linux server

To support the printing of box characters, these customized conversion files are provided with the sap2afp transform:

- For Japanese:
  IBM-939-SAP2AFP, which extends the IBM-939 conversion file
- For Simplified Chinese:
  IBM-1388-SAP2AFP, which extends the IBM-1388 conversion file
- For Traditional Chinese:
  IBM-937-SAP2AFP, which extends the IBM-937 conversion file
- For Korean:
  IBM-933-SAP2AFP, which extends the IBM-933 conversion file

In addition, InfoPrint provides these Korean resources in the /usr/lpp/psf/sap2afp/koreanfonts directory:

- C0H0GW72.240 (dpi Korean Gothic character sets)
- C0H0GW96.240 (dpi Korean Gothic character sets)
- C0H0MW72.240 (dpi Korean Myengjo character sets)
- C0H0MW96.240 (dpi Korean Myengjo character sets)
- T1H01150 (Korean code page)

With both dpi Korean Gothic character sets and dpi Korean Myengjo character sets at either 7.2 point size or 9.6 point size, you can print with both box characters and the check box on and off characters.

InfoPrint provides a Cyrillic code page that includes box characters, T1001172.CDP, in the /usr/lpp/psf/sap2afp/cyrillic directory. It also provides page definitions modified for Cyrillic support, P1CYR182 and P1CYR683, in the /usr/lpp/psf/sap2afp/cyrillic directory.

To enable non-Latin character support on an InfoPrint Manager AIX or InfoPrint Manager Linux server, an administrator must do this procedure:

1. Obtain and install the fonts required for printing the script that you want to support.
2. Create backup copies of these current files:

<table>
<thead>
<tr>
<th>Script</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyrillic</td>
<td>/usr/lpp/psf/fontlib/T1001172.CDP /usr/lpp/psf/reslib/P1CYR182 /usr/lpp/psf/reslib/P1CYR683</td>
</tr>
</tbody>
</table>

3. Copy these files:

<table>
<thead>
<tr>
<th>Script</th>
<th>Source file</th>
<th>Target file or directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Korean</td>
<td>All files in /sap2afp/koreanfonts</td>
<td>/usr/lpp/psf/fontlib</td>
</tr>
<tr>
<td>Cyrillic</td>
<td>/usr/lpp/psf/sap2afp/cyrillic/T1001172.CDP</td>
<td>/usr/lpp/psf/fontlib/ T1001172.CDP</td>
</tr>
</tbody>
</table>
4. Enter the script name in the userenv file at this location `/usr/lpp/psf/sap2afp/`.

The possible script names are:

- `japanese` for Japanese
- `spchinese` for Korean
- `tdchinese` for Simplified Chinese
- `korean` for Traditional Chinese
- `cyrillic` for Cyrillic

Each of these specified script names enable the transform to use the `defcp.tab.language` and `pagedef.tab.language` files corresponding to that language.

When you have completed this procedure, you can modify the `pagedef.tab.language` or `fonts.tab` to specify a different set of fonts. Both these files reside in the `/usr/lpp/psf/sap2afp` directory.

### Enabling non-Latin character sets on an InfoPrint Manager Windows server

To support the printing of box characters, these customized conversion files are provided with the `sap2afp` transform:

- For Japanese: IBM-939-SAP2AFP, which extends the IBM-939 conversion file
- For Simplified Chinese: IBM-1388-SAP2AFP, which extends the IBM-1388 conversion file
- For Traditional Chinese: IBM-937-SAP2AFP, which extends the IBM-937 conversion file
- For Korean: IBM-933-SAP2AFP, which extends the IBM-933 conversion file

In addition, InfoPrint provides these Korean resources in the `install_path\sap2afp\koreanfonts` directory:

- C0H0GW72.240 (dpi Korean Gothic character sets)
- C0H0GW96.240 (dpi Korean Gothic character sets)
- C0H0MW72.240 (dpi Korean Myengjo character sets)
- C0H0MW96.240 (dpi Korean Myengjo character sets)
- T1H01150 (Korean code page)

With both dpi Korean Gothic character sets and dpi Korean Myengjo character sets at either 7.2 point size or 9.6 point size, you can print with both box characters and the check box on and off characters.
InfoPrint provides a Cyrillic code page that includes box characters, T1001172.CDP, in the install_path \sap2afp\cyrillic directory. It also provides page definitions modified for Cyrillic support, P1CYR182 and P1CYR683, in the install_path\sap2afp\cyrillic directory.

To enable non-Latin character support on an InfoPrint Manager Windows server, an administrator must do this procedure:

1. Obtain and install the fonts required for printing the script that you want to support.
2. Create backup copies of these current files:

<table>
<thead>
<tr>
<th>Script</th>
<th>Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyrillic</td>
<td>/usr/lpp/psf/fontlib/T1001172.CDP</td>
</tr>
<tr>
<td></td>
<td>/usr/lpp/psf/reslib/P1CYR182</td>
</tr>
<tr>
<td></td>
<td>/usr/lpp/psf/reslib/P1CYR683</td>
</tr>
</tbody>
</table>

3. Copy these files:

<table>
<thead>
<tr>
<th>Script</th>
<th>Source file</th>
<th>Target file or directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Korean</td>
<td>All files in install_path\sap2afp\koreanfonts</td>
<td>install_path\fontlib</td>
</tr>
<tr>
<td>Cyrillic</td>
<td>install_path\sap2afp\cyrillic\T1001172.CDP</td>
<td>install_path\fontlib\T1001172.CDP</td>
</tr>
<tr>
<td>Cyrillic</td>
<td>install_path\sap2afp\cyrillic\P1CYR182</td>
<td>install_path\reslib\P1CYR182</td>
</tr>
<tr>
<td>Cyrillic</td>
<td>install_path\sap2afp\cyrillic\P1CYR183</td>
<td>install_path\reslib\P1CYR683</td>
</tr>
</tbody>
</table>

4. Enter the script name in the userenv file at this location install_path\sap2afp\. The possible script names are:
   - japanese for Japanese
   - spchinese for Korean
   - tdchinese for Simplified Chinese
   - korean for Traditional Chinese
   - cyrillic for Cyrillic

   Each of these specified script names enable the transform to use the defcp.tab.language and pagedef.tab.language files corresponding to that language.

When you have completed this procedure, you can modify the pagedef.tab.language or fonts.tab to specify a different set of fonts. Both these files reside in the install_path\sap2afp directory.

### Enabling Unicode support

The sap2afp transform supports SAP Unicode OTF and ABAP data on AIX, Linux, and Windows operating systems. Also, SAP Unicode OTF and ABAP data is not supported with PSF-Other destinations, due to PCL Secondary not supporting the AFP Unicode Migration Fonts.
Before doing these configuration tasks on AIX, Linux, and Windows systems, you must first obtain and install the AFP Unicode Migration Fonts that are required for printing:

AIX, Linux, Windows, AS/400, AFP Unicode Font PRPQ (5799-GJJ)

For more information about purchasing this product, see your service representative.

SAP Systems recommends using SAP Unicode systems that output SAPGOFU format, not the SAPGOF format. Excerpt from the official SAPGOF specification: "With the development of the Unicode variant of SAPGOF (device type SAPGOFU), the ASCII and EBCDIC variants are considered obsolete and are provided only for the sake of compatibility. Developers of new SAPGOF converters should base their implementation on the Unicode variant of SAPGOF." Consequently, we recommend using SAPGOFU input files in Unicode environment when invoking the SAP2AFP transform.

### Enabling Unicode support an InfoPrint Manager AIX, InfoPrint Manager Linux, and Windows server

For the OTF input files, the detection of the environment (Unicode and non-Unicode) and the detection of the double-byte languages in non-Unicode environments is automatic. For the ABAP files, if the input file is a Unicode-encoded (SAPGOFU) file, the environment automatically goes to Unicode.

The input file encoding is automatically detected and you do not have to edit the contents of a `syscp` file to set the input encoding when both SAPGOF and SAPGOFU files are submitted in a Unicode environment.

#### Environment automatic detection

<table>
<thead>
<tr>
<th>Type of the input file</th>
<th>Encoding of the input file</th>
<th>Environment detection method</th>
<th>Additional comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OTF</td>
<td>UTF-16 (BE or LE)</td>
<td>Automatic</td>
<td>Environment is set to Unicode.</td>
</tr>
<tr>
<td>ASCII</td>
<td>UTF-16 (BE or LE)</td>
<td>Automatic</td>
<td>Environment is set based on the code pages used (code page commands)</td>
</tr>
<tr>
<td>ASCII</td>
<td>'userenv' config file is used</td>
<td></td>
<td>The default value is NORMAL, which means non-Unicode.</td>
</tr>
</tbody>
</table>

#### Resources for supporting Unicode ABAP files

Specific coded fonts are available to reference the AFP migration fonts. These coded fonts are used for the Unicode processing of the ABAP files. To map these coded fonts for Unicode, page definitions were also created. The page definitions are divided into 5 pairs, which map the Courier fonts, the Japanese fonts, the Simplified Chinese fonts, the Traditional Chinese fonts, and the Korean fonts.
The resources are not part of the **AFP Font Migration** collection. All these resources and their source code are available in the `unicode.rc` subfolder from the `sap2afp` folder, where the configuration files also reside. When the **Unicode** processing is required, the transform automatically searches for the resources in that specific folder. Otherwise it continues to search in the InfoPrint Manager `fontlib` and `reslib` folders.

The table lists the new coded fonts, page definitions and Page Printer Formatting Aid (PPFA) source files used:

### Coded fonts, pages definitions and PPFA source files for Unicode ABAP files

<table>
<thead>
<tr>
<th>File name</th>
<th>Type</th>
<th>Location (subfolder in InfoPrint Manager)</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>XZ420U10</td>
<td>coded font</td>
<td>sap2afp/unicode.rc/</td>
<td>Courier Normal</td>
</tr>
<tr>
<td>XZ440U10</td>
<td>coded font</td>
<td>sap2afp/unicode.rc/</td>
<td>Courier Bold</td>
</tr>
<tr>
<td>XZJHMNU</td>
<td>coded font</td>
<td>sap2afp/unicode.rc/</td>
<td>Japanese Mincho (used for normal text)</td>
</tr>
<tr>
<td>XZJHKGU</td>
<td>coded font</td>
<td>sap2afp/unicode.rc/</td>
<td>Japanese Gothic (used for bold text)</td>
</tr>
<tr>
<td>XZHSMM2U</td>
<td>coded font</td>
<td>sap2afp/unicode.rc/</td>
<td>Korean Myengjo (used for normal text)</td>
</tr>
<tr>
<td>XZHKG2U</td>
<td>coded font</td>
<td>sap2afp/unicode.rc/</td>
<td>Korean Gothic (used for bold text)</td>
</tr>
<tr>
<td>XZSSNGU</td>
<td>coded font</td>
<td>sap2afp/unicode.rc/</td>
<td>Simplified Chinese Song (used for normal text)</td>
</tr>
<tr>
<td>XZSKAIU</td>
<td>coded font</td>
<td>sap2afp/unicode.rc/</td>
<td>Simplified Chinese Kai (used for bold text)</td>
</tr>
<tr>
<td>XZTSGNU</td>
<td>coded font</td>
<td>sap2afp/unicode.rc/</td>
<td>Traditional Chinese Sung (used for normal text)</td>
</tr>
<tr>
<td>XZTCAIU</td>
<td>coded font</td>
<td>sap2afp/unicode.rc/</td>
<td>Traditional Chinese Kai (used for bold text)</td>
</tr>
<tr>
<td>P1UNI683</td>
<td>page definition</td>
<td>sap2afp/unicode.rc/</td>
<td>maps the Courier coded fonts</td>
</tr>
<tr>
<td>P1UNI182</td>
<td>page definition</td>
<td>sap2afp/unicode.rc/</td>
<td>maps the Courier coded fonts</td>
</tr>
<tr>
<td>P1UNI83</td>
<td>page definition</td>
<td>sap2afp/unicode.rc/</td>
<td>maps the Japanese coded fonts</td>
</tr>
<tr>
<td>P1UNI82</td>
<td>page definition</td>
<td>sap2afp/unicode.rc/</td>
<td>maps the Japanese coded fonts</td>
</tr>
<tr>
<td>P1UNIK83</td>
<td>page definition</td>
<td>sap2afp/unicode.rc/</td>
<td>maps the Korean coded fonts</td>
</tr>
<tr>
<td>P1UNIK82</td>
<td>page definition</td>
<td>sap2afp/unicode.rc/</td>
<td>maps the Korean coded fonts</td>
</tr>
<tr>
<td>P1UNISC3</td>
<td>page definition</td>
<td>sap2afp/unicode.rc/</td>
<td>maps the Simplified Chinese coded fonts</td>
</tr>
</tbody>
</table>
Using TrueType and OpenType fonts

In the Unicode environment, the sap2afp transform supports the use of TrueType and OpenType fonts for actual destinations that support them. This support consists of one set of Unicode configuration files and resources for the TrueType/OpenType fonts. By default, these configuration files map the WorldType fonts, which is a set of OpenType/TrueType fonts provided by InfoPrint Manager, but you can change them to map any OpenType/TrueType fonts that you have. For SAP OTF input files with TrueType inline fonts, the transform will output AFP data containing the referenced TrueType fonts as inline resources. The TrueType fonts and the resources are used only when the -truetype parameter is passed to the sap2afp transform specifying the use the TrueType configuration files, and if present, TrueType fonts from the OTF files. InfoPrint Manager passes this parameter to the transform, depending on the values of the these InfoPrint Manager attributes:

- font-resolution
- default-font-resolution
- font-resolutions-supported

Note

Unless you explicitly specify that TrueType/OpenType fonts are used, the system uses the AFP Migration Fonts for Unicode processing.
If you do not specify any value for `font-resolution` or you leave its default value, InfoPrint Manager passes the `-truetype` parameter to the transform only if the actual destination's `default-font-resolution` attribute value is set to `open-type`. When a job does have a `font-resolution` attribute specified, InfoPrint Manager passes the `-truetype` parameter to the transform only if its value is set to `open-type`, regardless of the `default-font-resolution` value.

**Configuring TrueType and OpenType support**

The TrueType and OpenType fonts that are supported must be Unicode-enabled, and they are used for processing files in a Unicode environment. For ASCII text data (a non-Unicode environment), do not use TrueType/OpenType fonts. Whereas FOCA fonts are referenced in AFP with coded font names, Global Resource Identifiers (GRIDs), or code page and font character set name pairs, TrueType and OpenType fonts are always referenced by MDR structured fields using a name that is reflected in the actual font file: the full font name. This means that the actual font data is not needed in this referencing stage, just the full font names. At the printing stage, the font data is needed.

PSF uses two methods to resolve the font references:

1. Inline within the resource group of the AFP file. This means the font is embedded into the AFP.
2. Through the Resource Access Table (RAT).

The Resource Access Table is created using AFP Font Installer. It maps each Full Font Name to a file name within the current directory. When the RAT is used, each directory that contains TrueType and OpenType fonts should contain its own RAT file.

**Enabling support for TrueType/OpenType fonts when RAT is installed**

If you have installed the RAT, the AFP files will only reference the fonts using MDR structured fields. When AFP is submitted to PSF for printing, the fonts are resolved through the RAT. This situation is supported for both OTF and ABAP types of files.

To transform and print OTF files in Unicode environment using TrueType/OpenType fonts:

1. Open the `fonts.tab.unicode.truetype` file using a text editor.
2. Use the `FullFontName` column to map the OTF fonts to the desired TrueType/OpenType fonts.

To transform and print ABAP files in Unicode environment using TrueType/OpenType fonts:

1. Open the `pagedef.tab.unicode.truetype` file using a text editor.
2. In the `PAGEDEF` fields, specify the names of the page definitions mapping the TrueType fonts.

**Enabling support for TrueType/OpenType fonts when RAT is not installed**

When the RAT is not installed, the names of the font files are needed for embedding them into the AFP. When AFP is later sent to PSF for printing, the fonts are found inline, in the resource group, at the beginning of the AFP file. This case is supported for both OTF and ABAP files.

To transform and print OTF files in a Unicode environment using TrueType/OpenType fonts:

1. Open the `fonts.tab.unicode.truetype` file using a text editor.
2. In the `TTF_PATH` field, specify the path to the fonts.
3. Use the `FullFilePath` column to map the OTF fonts to the desired TrueType/OpenType fonts.
To transform and print with ABAP files in Unicode environment using TrueType/OpenType fonts:

1. Open the `pagedef.tab.unicode.truetype` file using a text editor.
2. In the PAGEDEF fields, specify the names of the page definitions mapping the TrueType fonts.
3. In the TTFembedNorm and TTFembedBold fields, specify the file names of the normal and bold TrueType fonts specified in the PAGEDEF.

For more information about the configuration files and their contents, see InfoPrint Manager: Reference.

**Resources for supporting TrueType and OpenType fonts**

The configuration files mapping the WorldType fonts are:

- `pagedef.tab.unicode.truetype`
- `fonts.tab.unicode.truetype`

These files are located in the `/sap2afp` folder, along with the other configuration files.

The page definition files mapping the WorldType fonts are available in the `sap2afp/unicode.truetype.rc` folder.

**Configuration files, resources, and PPFA sources for supporting TrueType and OpenType fonts**

<table>
<thead>
<tr>
<th>File name</th>
<th>Type</th>
<th>Path</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>pagedef.tab.unicode.truetype</td>
<td>config file</td>
<td>sap2afp/</td>
<td>specifies pagedefs to be used with TrueType for ABAP</td>
</tr>
<tr>
<td>fonts.tab.unicode.truetype</td>
<td>config file</td>
<td>sap2afp/</td>
<td>specifies TrueType fonts to be used for OTF</td>
</tr>
<tr>
<td>P1UTT182</td>
<td>page definition</td>
<td>sap2afp/unicode.truetype.rc/</td>
<td>maps the WGL WorldType fonts</td>
</tr>
<tr>
<td>P1UTT683</td>
<td>page definition</td>
<td>sap2afp/unicode.truetype.rc/</td>
<td>maps the WGL WorldType fonts</td>
</tr>
<tr>
<td>P1UTTJ82</td>
<td>page definition</td>
<td>sap2afp/unicode.truetype.rc/</td>
<td>maps the Japanese WorldType fonts</td>
</tr>
<tr>
<td>P1UTTJ83</td>
<td>page definition</td>
<td>sap2afp/unicode.truetype.rc/</td>
<td>maps the Japanese WorldType fonts</td>
</tr>
<tr>
<td>P1UTTK82</td>
<td>page definition</td>
<td>sap2afp/unicode.truetype.rc/</td>
<td>maps the Korean WorldType fonts</td>
</tr>
<tr>
<td>P1UTTK83</td>
<td>page definition</td>
<td>sap2afp/unicode.truetype.rc/</td>
<td>maps the Korean WorldType fonts</td>
</tr>
<tr>
<td>File name</td>
<td>Type</td>
<td>Path</td>
<td>Details</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------</td>
<td>-----------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>P1UTTSC2</td>
<td>page definition</td>
<td>sap2afp/unicode.</td>
<td>maps the Simplified Chinese WorldType fonts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTSC3</td>
<td>page definition</td>
<td>sap2afp/unicode.</td>
<td>maps the Simplified Chinese WorldType fonts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTTC2</td>
<td>page definition</td>
<td>sap2afp/unicode.</td>
<td>maps the Traditional Chinese WorldType fonts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTTC3</td>
<td>page definition</td>
<td>sap2afp/unicode.</td>
<td>maps the Traditional Chinese WorldType fonts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTT182.PPFA</td>
<td>PPFA source file</td>
<td>sap2afp/unicode.</td>
<td>source code for P1UTT182</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTT683.PPFA</td>
<td>PPFA source file</td>
<td>sap2afp/unicode.</td>
<td>source code for P1UTT683</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTJ82.PPFA</td>
<td>PPFA source file</td>
<td>sap2afp/unicode.</td>
<td>source code for P1UTTJ82</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTJ83.PPFA</td>
<td>PPFA source file</td>
<td>sap2afp/unicode.</td>
<td>source code for P1UTTJ83</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTK82.PPFA</td>
<td>PPFA source file</td>
<td>sap2afp/unicode.</td>
<td>source code for P1UTTK82</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTK83.PPFA</td>
<td>PPFA source file</td>
<td>sap2afp/unicode.</td>
<td>source code for P1UTTK83</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTSC2.PPFA</td>
<td>PPFA source file</td>
<td>sap2afp/unicode.</td>
<td>source code for P1UTTSC2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTSC3.PPFA</td>
<td>PPFA source file</td>
<td>sap2afp/unicode.</td>
<td>source code for P1UTTSC3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTTC2.PPFA</td>
<td>PPFA source file</td>
<td>sap2afp/unicode.</td>
<td>source code for P1UTTTC2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
<tr>
<td>P1UTTTC3.PPFA</td>
<td>PPFA source file</td>
<td>sap2afp/unicode.</td>
<td>source code for P1UTTTC3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>truetype.rc/</td>
<td></td>
</tr>
</tbody>
</table>

### Enabling SAPGOF_ST_CHARS support

The sap2afp transform is now able to correctly process OTF files that have been generated from SAP Unicode Systems using the SAPGOF_ST_CHARS setting enabled. For this, the new `sapgof_st_chars` transform parameter must be passed to sap2afp transform. It can be used for transforming SAPGOF OTF files (ASCII-encoded) and SAPGOFU OTF files (Unicode-encoded), which have been generated.
using the SAPGOF_ST_CHARS. This flag informs the sap2afp transform that the OTF input file has been generated using the SAPGOF_ST_CHARS:X entry from the SAP Unicode System, thus the sap2afp transform detects that for Unicode codepages, the ST and BC commands counters are halved and it will double them, internally, so that the OTF file is correctly processed.

**Note**

The flag **-sapgof_st_chars** is ignored for files containing only non-Unicode codepages.

To support non-Unicode printing (for example using the PCL secondary) of SAPGOF OTF files generated from SAP Unicode Systems, the **-useascii** flag switches to a non-Unicode environment for processing the input files, regardless of the codepages used by the file. The Latin-1 codepage is used instead of the Unicode codepages, and the files are printed using non-Unicode fonts.

**Notes**

1. The **-useascii** flag is ignored for SAPGOFU files.
2. When the **-useascii** flag is used on a SAPGOF OTF file that uses Unicode codepages, the Unicode characters that are not covered by the non-Unicode Latin-1 codepage will be replaced with spaces.

The **-sapgof_st_chars** and **-useascii** flags can be used together to signal that the OTF input file has been generated with SAPGOF_ST_CHARS and must be printed using non-Unicode fonts.

**Note**

Do not specify the **-sapgof_st_chars** flag for files that have been generated without the SAPGOF_ST_CHARS setting.

Because the SAPGOF_ST_CHARS option is an SAP system setting, we recommend that you set the **-sapgof_st_chars** transform option on a SAP system basis, either by using a separate logical destination or by configuring the InfoPrint Manager SAP Client.

If you are using a separate logical destination, you must add the **-sapgof_st_chars** parameter to the **other-transform-options** attribute of the logical destination.

If you want to configure the InfoPrint Manager SAP Client to use the **-sapgof_st_chars** parameter for all incoming SAP jobs, you must follow the instructions below:

On the AIX or Linux SAP system, you must update the **ipm_submit** script on the InfoPrint Manager machine:

1. Search for the **ipm_submit** script.
2. Use a text editor to open and edit the script.
3. Search for the line containing "other-transform-options='-g'";
4. Add **-sapgof_st_chars** to the transform options, if the SAPGOF_ST_CHARS system setting is enabled.

The line must be the same as in the example:

```
otheroptions="other-transform-options='-g -sapgof_st_chars'";
```

On the Windows SAP systems:

1. Go to the folder where InfoPrint Manager SAP Client is installed. The default path is c:\Program Files\RICOH\Infoprint Manager SAP Clients\.
2. Run the **SapIPMcfg.exe** configuration utility in Administrator mode. To do this, right click the configuration file and select “Run as Administrator”.

3. Check the **SAPGOF ST CHARS** box when the **SAPGOF_ST_CHARS** setting in SAP is on.

### Enabling LDAP mode

If you are using the InfoPrint Manager Pull Print feature with your InfoPrint Manager server, enable the LDAP mode. If you enable the LDAP mode, SAP clients specify through the **authenticated-login** attribute that the job is authenticated.

#### Enabling LDAP mode on an AIX or Linux SAP system running the SAP Client

To enable GOCA support from an AIX or Linux system, follow this procedure:

1. Access the `ipm_submit` file for OMS configurations or the `ipm_print` file for non-OMS configurations. You can find these files in the `/usr/lpp/pd/bin` directory.

2. If you use AIX or Linux, remove the hash mark (#) that is placed in front of the line `#LDAP_MODE_ENABLED='YES'`. To disable the LDAP mode, access these files again and add the hash mark (#) in front of the line.

#### Enabling LDAP mode on a Windows SAP system

If you have already installed the InfoPrint Manager SAP Client on a Windows system and want to enable LDAP mode, access the **SapIPMcfg.exe** file from the directory where you installed the SAP client. When you click this file, it displays the **IPM Server Settings** dialog. Then, select IPM LDAP Mode and enable it. To disable the LDAP mode, access the **SapIPMcfg.exe** file and clear the check box.

#### Enabling GOCA support on an HP-UX or Sun Solaris SAP system

To enable the LDAP mode from an HP-UX system or a Sun Solaris system running the SAP client, you must enable the support for the InfoPrint Manager server to which the client machine is connected. If you are connected to an InfoPrint Manager AIX or InfoPrint Manager Linux, go to the AIX or Linux server and follow this procedure:

1. Access the `ipm_submit` file for OMS configurations or the `ipm_print` file for non-OMS configurations. You can find these files in the `/usr/lpp/pd/bin` directory.

2. If you use AIX or Linux, remove the hash mark (#) that is placed in front of the line `#LDAP_MODE_ENABLED='YES'`. To disable the LDAP mode, access these files again and add the hash mark (#) in front of the line.

If you are connected to an InfoPrint Manager Windows server, access the **SapIPMcfg.exe** file from the directory where you installed InfoPrint Manager. When you click this file, it displays the **IPM Server Settings** dialog. Then, select IPM LDAP Mode and enable it. To disable the LDAP mode, access the **SapIPMcfg.exe** file and clear the check box.

### Setting up your SAP R/3 system to support new OTF user fonts

Use this procedure when using the sap2afp transform to print with a new font that you have created for the job:
1. From the R/3 main menu, access the Font window so you can create a font family for this new, customized font, by selecting the Tools main menu and then selecting the Word Processing → Font path, or typing /nSP73 in the ok-Code field.

2. From the SAPscript Font Maintenance: Initial Screen window, select the Font families option and click Change.

3. Click Create and fill in the font information on the Create/Change Font Family window as shown in Figure SAPScript Font Maintenance: Create/Change Font Family window, p. 89:

**SAPScript Font Maintenance: Create/Change Font Family window**

<table>
<thead>
<tr>
<th>Font family</th>
<th>ZDOC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Documentation MICR font</td>
</tr>
<tr>
<td>Proportional</td>
<td></td>
</tr>
<tr>
<td>Replacement family 1</td>
<td>OCRA</td>
</tr>
<tr>
<td>Replacement family 2</td>
<td></td>
</tr>
<tr>
<td>Replacement family 3</td>
<td></td>
</tr>
<tr>
<td>Character set</td>
<td>4001</td>
</tr>
</tbody>
</table>

4. Click Continue.

5. When the system prompts you for a Change Request Query request, click Cancel.

6. From the SAPscript Font Maintenance: Initial Screen window, select the System Fonts option and click Create.

7. Fill in the information from the Create System... window as shown in Figure SAPScript Font Maintenance Create System... window, p. 90:
8. Click **Continue**.

9. When the system prompts you for a Change Request Query request, click **Cancel**.

10. From the SAPscript Font Maintenance: Initial Screen window, select the **Printer fonts/AFM metrics** option and click **Change**.

11. From the Create/Change... window shown in Figure SAPScript Font Maintenance (Create/Change) window for OTF Fonts, p. 90, select the intended device type (ZDOC0GF) and fill in the remaining information:

### SAPScript Font Maintenance (Create/Change) window for OTF Fonts

- **Device type**: ZDOCGOF
- **Font family**: ZDOC
- **Font size**: 100
- **Bold**: Check box
- **Italic**: Check box
- **Characters per inch**: 10.00
- **Print ctrl portrait**: Blank
- **Print control lands**: Blank
12. Click **Continue**.

Before you can use this new Output Text Format (OTF) font, you must define a layout set that contains this new font to use your device type.

13. Add an entry in the fonts.tab configuration file that identifies this new OTF font and make sure that these resources are on the InfoPrint server where your InfoPrint actual destination is located.

**Printing oversize characters on a 6400 printer with SAP R/3**

InfoPrint Manager gives you the ability to resize Output Text Format (OTF) fonts on a 6400 Printer. If your printer supports the graphics object content architecture (GOCA) feature, you can use the 6400fonts.tab configuration file to alter the height and width of characters printed. The `SIZE=` parameter lets you specify the height of a font (in points) and have it scaled appropriately. Since there are 72 points in an inch, 720 indicates a height of an inch. The `CPI=` (characters per inch) parameter defines the horizontal width to which the 6400 printer-resident fonts should be scaled. The smaller the number you specify, the wider the font you receive.

To make sure that a font prints one inch high, specify this line in the 6400fonts.tab configuration file:

```
FONT=TIMES SIZE=720 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0
```

The 6400fonts.tab configuration file is located in the `/usr/lpp/psf/sap2afp` directory on an InfoPrint Manager AIX or InfoPrint Manager Linux server and the `install_path\sap2afp` folder on an InfoPrint Manager Windows server.

To make sure that a font prints one inch wide, specify this line in the 6400fonts.tab configuration file:

```
FONT=TIMES SIZE=720 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0 CPI=1
```

To make sure that a font prints one-half inch wide, specify this line in the 6400fonts.tab configuration file:

```
FONT=TIMES SIZE=720 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0 CPI=2
```

Once you have modified the 6400fonts.tab file appropriately, access the Print Screen List window on the SAP R/2 graphical user interface and specify 6400 in the **Title** field of the Spool request pane.

**Adding box shading values to printed output**

InfoPrint Manager supports both Output Text Format (OTF) shading values and border thickness values. The BX OTF command lets you print boxes that are either clear, solid, or contain four different levels of shading. The levels of shading are a percentage between 0 and 100, with 0 indicating a clear box and 100 a solid box.

The InfoPrint Manager SAP transform recognizes the BX OTF command and creates graphics object content architecture (GOCA) output if passed the `-g` flag. GOCA is an AFP data architecture used to represent pictures generated by computer. Both the `ipm_submit` and `ipm_print` commands used by the OMS (see *Installing and configuring InfoPrint Manager's OMS*, p. 13) and access method L (see *InfoPrint Manager non-OMS support*, p. 57) automatically pass the `-g` flag to the SAP transform through the other-transform-options attribute. For more information about the other-transform-options attribute, see the documentation for your InfoPrint Manager server.
attribute and the sap2afp command, see InfoPrint Manager: Reference. For more information about the BX command values required to specify box shading, see your SAP R/3 documentation.

If you use this function with an IPDS InfoPrint printer that is not enabled for GOCA, the file prints a presentation text object content architecture (PTOCA) box or boxes without shading and this message sequence for each box at the end of the job:

```
0420-535: ERROR: One or more graphics objects were encountered. The printer does not support this type of object.

0420-879: InfoPrint continues processing the print job: The STOP when errors found in IMAGE and GRAPHICS data field on the InfoPrint SMIT Error Handling Options panel is set to no.
```

If your installation uses older printers (for example, 3900 printers instead of InfoPrint 4000 printers), the GOCA support can cause the printers to print at less than rated speed. If your applications do not require GOCA support features such as box shading, you might want to improve performance by turning off the GOCA support. For instructions on how to turn off GOCA support on the various platforms supported, see the following sections.

### Turning off GOCA support on an AIX or Linux SAP system

To turn off GOCA support from an AIX or Linux system running the SAP Client, use this procedure:

1. Access either the `ipm_submit` (for OMS configurations) or the `ipm_print` file (for non-OMS configurations) file that reside in the `/usr/lpp/pd/bin` directory.
2. Using your AIX or Linux editor of choice, comment out the `othertoptions="other-transform-options='-g'"` line by placing a hash mark (`#`) in front of the line.

**Note**

If you ever wish to reactivate GOCA support, just access these files again and remove the hash mark (`#`) in front of the line.

### Turning off GOCA support on an HP-UX or Sun Solaris SAP system

To turn off GOCA support from either an HP-UX system or a Sun Solaris system running the SAP Client, you must turn the support off at the InfoPrint Manager server to which the client machine is connected. If you are connected to an InfoPrint Manager AIX, go to the AIX server and use this procedure:

1. Access either the `ipm_submit` (for OMS configurations) or the `ipm_print` file (for non-OMS configurations) file that reside in the `/usr/lpp/pd/bin` directory.
2. Using your AIX or Linux editor of choice, comment out the `othertoptions="other-transform-options='-g'"` line by placing a hash mark (`#`) in front of the line.

**Note**

If you ever wish to reactivate GOCA support, just access these files again and remove the hash mark (`#`) in front of the line.
If you are connected to an InfoPrint Manager Windows server, access the ipmcfg file from the directory where you installed InfoPrint Manager. When you click this file, it displays the IPM Server Settings dialog. From here, you can click **IPM GOCA Support** to remove the check.

**Note**

If you ever wish to reactivate GOCA support, just access the ipmcfg and click the check box again.

### Turning off GOCA support on a Windows SAP system

If you have already installed the InfoPrint Manager SAP Client on a Windows system and want to turn off GOCA support, access the ipmcfg file from the directory where you installed the SAP Client. When you click this file, it displays the IPM Server Settings dialog. From here, you can click **IPM GOCA Support** to remove the check.

**Note**

If you ever wish to reactivate GOCA support, just access the ipmcfg and click the check box again.

### Using bar codes with SAP R/3

These sections describe the bar codes for printing that can be used when printing OTF and ABAP output from InfoPrint Manager:

- Bar codes supported by the InfoPrint SAP (sap2afp) transform, p. 93
- Setting up your SAP R/3 system to support new OTF user bar codes, p. 95
- Bar codes and printing from SAP R/3 through InfoPrint Manager, p. 96
- Specifying width in SAP bar codes, p. 98.

#### Bar codes supported by the InfoPrint SAP (sap2afp) transform

Some SAP R/3 applications require that data is printed as a bar code. If OTF specifies bar code data, the sap2afp transform converts it into Bar Code Object Content Architecture (BCOCA) data, which is understood directly by the control unit of the AFP printer. This bar code data can also be converted to the Printer Control Language (PCL) PCL4, PCL5, or PCL5c data streams. This allows InfoPrint Manager to print to any printers that accept Printer Control Language data.

These printers support both InfoPrint Manager and BCOCA:

- 3130 Advanced Function Printer
- 3160 Advanced Function Printer
- 3900 Advanced Function Duplex Printing System, Models D01, D02
- 3900 Advanced Function Wide Duplex Printing System, Models DW1, DW2
- 3900-OW1 Advanced Function Printer
- 3900-OW3 Advanced Function Printer
- 3935 Advanced Function Printer
- 4312 Network Printer 12 (NP 12)
- 4317 Network Printer 17 (NP 17)
• 4324 Network Printer 24 (NP 24)
• 4400 Thermal Printer
• InfoPrint 20 Printer
• InfoPrint 21 Printer
• InfoPrint 32 Printer
• InfoPrint 40 Printer
• InfoPrint 45 Printer
• InfoPrint 60 Printer
• InfoPrint 62 Printer
• InfoPrint 70 Printer
• InfoPrint 70 Plus Printer
• InfoPrint 1120 Printer
• InfoPrint 1125 Printer
• InfoPrint 1130 Printer
• InfoPrint 1140 Printer
• InfoPrint 1145 Printer
• InfoPrint 1226 Printer
• InfoPrint 1332 Printer
• InfoPrint 1352 Printer
• InfoPrint 1372 Printer
• InfoPrint 2000-DP1 IPDS Printer
• InfoPrint 2060ES Printer
• InfoPrint 2075ES Printer
• InfoPrint 2085 Printer
• InfoPrint 2090ES Printer
• InfoPrint 2105 Printer
• InfoPrint 2105ES Printer
• InfoPrint 3000 Printer
• InfoPrint 4000 Printer
• InfoPrint 4100 Printer
• InfoPrint Color 100 Printer
• InfoPrint Color 130 Plus Printer
• InfoPrint Color 1220 Printer
• InfoPrint Color 1228 Printer
• InfoPrint Color 1354 Printer
• InfoPrint Color 1357 Printer
• LaserPrinter 4028 Models AS1 and NS1
Setting up your SAP R/3 system to support new OTF user bar codes

Use this procedure when using the sap2afp transform to print with a new bar code that you have created for the job:

1. From the R/3 main menu, access the Font window by either taking the Word Processing → Font path, or typing /nSP73 in the ok-Code field.

2. From the SAPscript Font Maintenance: Initial Screen window, select the System bar codes option and click Change.

3. Click Create and fill in the bar code information on the Create/Change System Bar Code window as shown in Figure SAPScript Font Maintenance (Create/Change) System Bar Code window, p. 95:

SAPScript Font Maintenance (Create/Change) System Bar Code window

4. Click Continue.

5. When the system prompts you for a Change Request Query request, click Cancel.

6. From the SAPscript Font Maintenance: Initial Screen window, select the Printer bar codes option and click Change.

7. From the Create/Change... window displayed below, select the intended bar code (ZDOCGOF) and fill in the remaining information as shown in Figure SAPScript Font Maintenance (Create/Change) window, p. 96:
8. Click **Continue**.

   Before you can use this new Output Text Format (OTF) bar code, you must define a layout set that contains this new bar code to use your device type (in this case, ZDOCGOF).

9. Add an entry in the barcode.tab configuration file that identifies this new OTF bar code name to an actual bar code type. The barcode.tab configuration file identifies values in this format:

   ```
   BarCode=ZDOBAR Type=017 Mode=002 Flag=128
   ```

   For more information about the barcode.tab configuration file and how it relates to the Bar Code Object Content Architecture (BCOCA), see Bar codes and printing from SAP R/3 through InfoPrint Manager, p. 96.

---

### Bar codes and printing from SAP R/3 through InfoPrint Manager

*Table Bar code Type field values, p. 96, Table Bar code Mode field values, p. 97, and Table Bar Code Flag Values, p. 98 map the Bar Code Object Content Architecture values with the SAP R/3 system values found in the barcode.tab configuration file, which is located in the /usr/lpp/psf/sap2afp directory on an InfoPrint AIX or InfoPrint Linux system and the install_path\sap2afp folder on an InfoPrint Windows system.*

#### Bar code Type field values

<table>
<thead>
<tr>
<th>Bar code Type field values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X'01'</td>
<td>Code 3 of 9</td>
</tr>
<tr>
<td>X'02'</td>
<td>MSI</td>
</tr>
<tr>
<td>X'08'</td>
<td>EAN-8</td>
</tr>
<tr>
<td>X'09'</td>
<td>EAN-13</td>
</tr>
<tr>
<td>X'0C'</td>
<td>Interleaved 2 of 5</td>
</tr>
<tr>
<td>X'11'</td>
<td>Code 128</td>
</tr>
</tbody>
</table>
### Bar code Type field values

<table>
<thead>
<tr>
<th>Bar code Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X'18'</td>
<td>POSTNET</td>
</tr>
<tr>
<td>X'1E'</td>
<td>PDF 417</td>
</tr>
</tbody>
</table>

### Bar code Mode field values

<table>
<thead>
<tr>
<th>Mode Field values</th>
<th>Bar code Type</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>X'01'</td>
<td>Present the bar code without a generated check digit.</td>
</tr>
<tr>
<td>2</td>
<td>X'01'</td>
<td>Generate a check digit and present it with the bar code.</td>
</tr>
<tr>
<td>1</td>
<td>X'02'</td>
<td>Present the bar code without check digits generated by the printer.</td>
</tr>
<tr>
<td>2</td>
<td>X'02'</td>
<td>Present the bar code with generated modulo-10 check digit. This check digit is the second check digit; the first check digit is the last byte of the BSA data.</td>
</tr>
<tr>
<td>3</td>
<td>X'02'</td>
<td>Present the barcode with two check digits. Both check digits are generated using the modulo-10 algorithm.</td>
</tr>
<tr>
<td>5</td>
<td>X'02'</td>
<td>Present the barcode with two check digits. The first check digit is generated using the modulo-11 algorithm; the second using the modulo-10 algorithm. The first check digit equals the remainder; exception condition EC-0E00 exists if the first check-digit calculation results in a value of 10.</td>
</tr>
<tr>
<td>0</td>
<td>X'08'</td>
<td>Present an EAN-8 barcode symbol. The input data consists of seven digits: two flag digits and five article digits. All seven digits are encoded along with a generated check digit.</td>
</tr>
<tr>
<td>0</td>
<td>X'09'</td>
<td>Present an EAN-13 barcode symbol. The input data consists of twelve digits: two flag digits and ten article digits, in that order. The first flag digit is not encoded. The second flag digit, the article number digits, and generated check digits are encoded. The first flag digit is presented in HRI form at the bottom of the left quiet zone. The first flag digit governs the A and B number-set pattern of the barcode and space coding of the six digits to the left of the symbol center pattern.</td>
</tr>
<tr>
<td>1</td>
<td>X'0C'</td>
<td>Present the bar code without a generated check digit. In sequence, the input data consists of a start character, digits to be encoded, and a stop character.</td>
</tr>
<tr>
<td>2</td>
<td>X'0C'</td>
<td>Generate a check digit and present it with the bar code. In sequence, the input data consists of a start character, digits to be encoded, and a stop character.</td>
</tr>
</tbody>
</table>
Mode Field values | Bar code Type | Meaning
--- | --- | ---
2 | X'11' | Generate a Code 128 symbol using subset A, B, or C as appropriate, to produce the shortest possible bar code from the given data. The Code 128 code page is used to interpret the bar code symbol data. Generate a check digit and present it with the data.

0 | X'18' | Present the ZIP code as 5 digits.
1 | X'18' | Present the ZIP code as 9 digits.
0 | X'1E' | Present a full PDF417 bar code symbol.
1 | X'1E' | Present a truncated PDF417 bar code symbol, for use in a relatively clean environment in which damage to the symbol is unlikely. This version omits the right row indicator and simplifies the stop pattern into a single module width bar.

The barcode.tab configuration file can contain the FlagPDF keyword that represents byte 5 of the BSA (Bar Code Symbol Data) from PDF417 Special-Function Parameters. This flag is only used with PDF417 bar code types, and it controls how the bar code data is processed by the BCOCA receiver. For more information, see Bar Code Object Content Architecture Reference.

### Bar Code Flag Values

| Flag field values | Meaning |
--- | --- |
128 | Present without Human Readable Text (HRI) |
0 | Present with Human Readable Text |

### Specifying width in SAP bar codes

InfoPrint Manager lets you modify bar code width using the same command syntax provided with the Page Printer Formatting Aid (PPFA) product. By modifying the barcode.tab configuration file to use the ModWidth parameter, you can change the width of bar codes and the wide-to-narrow ratio.

**ModWidth**

Specifies the width of the smallest defined bar code element, using mils (thousandths of an inch). For bar code types that explicitly specify the module width (for example, POSTNET and RM4SCC), this field is ignored. The range of values allowed is 1 to 254. If ModWidth is not specified in the barcode.tab file, the sap2afp transform uses the defaulted bar code width.

**n**

Specifies the width of each module, using thousandths of an inch (1/1000) as the unit of measure.

**Ratio**
Specifies a percent value in the form nnn. For example, 200 represents a ratio of 2.5 to 1. For most bar code symbols, the Ratio value should be between 200 and 300. For bar code types that explicitly specify the module width (for example, POSTNET and RM4SCC), this field is ignored. If Ratio is not specified, the default ratio for the bar code symbol is used. This value must be a three-digit character between 100 and 500.

To shorten an existing bar code, you can specify this line in the barcode.tab file:

| BarCode = BC_CD39 Type = 001 Mode = 001 Ratio = 2000 ModWidth = 10 |

## Alternate access methods for submitting SAP jobs to InfoPrint Manager

To use InfoPrint Manager as an SAP OMS you define your SAP devices to use access method E (see Installing and configuring InfoPrint Manager’s OMS, p. 13). If you cannot use InfoPrint Manager as an SAP OMS, we recommend defining your SAP devices to use access method L (see InfoPrint Manager non-OMS support, p. 57). There are other access methods that can be used for submitting print jobs from SAP systems to InfoPrint Manager. This topic describes some of those methods. These methods do not require an InfoPrint SAP Client to be installed on your SAP system, but do not allow SAP job attributes to be passed with the job or provide for any status information regarding the job to be known on the SAP system. You can install and use the SAP transform with these methods.

## Defining SAP devices using access method U

From your SAP system, you can submit jobs to an InfoPrint Manager for AIX, Manager for InfoPrint Linux, or InfoPrint Manager for Windows server using LPD by defining your SAP device to use access method U.

This method is intended for InfoPrint Manager users whose SAP R/3 applications run on non-AIX or non-Linux systems. This method is discouraged with SAP systems running on AIX or Linux because you must create AIX or Linux print queues to use it. For a preferred method of submitting jobs from SAP systems to InfoPrint Manager that provides better feedback, see either Installing and configuring InfoPrint Manager’s OMS, p. 13 or InfoPrint Manager non-OMS support, p. 57.

To use access method U to send jobs to InfoPrint Manager, you need to make sure that the LPD service is running on the InfoPrint server. Use the procedure appropriate to your InfoPrint Manager server operating system:

- Verifying the InfoPrint Manager for Windows LPD service is started, p. 99
- Verifying the LPD service is started on InfoPrint Manager for AIX, p. 100
- Verifying the LPD service is started on InfoPrint Manager for Linux, p. 100

## Verifying the InfoPrint Manager for Windows LPD service is started

To submit jobs to InfoPrint Manager through the LPD service, the InfoPrint Manager LPD service that comes with InfoPrint Manager for Windows must be active. Note that this service is different from the LPD Windows service that comes with the base operating system. Use this procedure to verify that the service is started on your InfoPrint Manager Windows server, and if necessary, to activate the InfoPrint Manager LPD service:
1. From the Start menu, select Programs → InfoPrint Manager → Management Console.
2. Click File → Stop Server.
3. Access the Edit → Service Configuration... path.
4. From the Service Configuration window, make sure that the Run InfoPrint Manager LPD service check box has been checked. Press OK to save this change.
5. Click File → Start Server.
6. Exit the InfoPrint Manager Management Console.

**Verifying the LPD service is started on InfoPrint Manager for AIX**

To submit jobs to InfoPrint Manager through LPD, you must make sure that the AIX lpd daemon is active on your InfoPrint Manager AIX server.

To either verify that the lpd daemon is active or to start it on your InfoPrint Manager AIX server:
1. From an AIX command line, use either smit or smitty to access the System Management Interface Tool.
2. From the main menu, take the Print Spooling → Manage Print Server path.
3. From the Manage Print Server panel, scroll down and click Show Status of the Print Server Subsystem.
   - If the lpd subsystem displays an inoperative status, return to the Manage Print Server panel and click Start the Print Server Subsystem (lpd daemon).
   - If the lpd subsystem displays an active status and shows a PID value, you can exit the SMIT interface and do not have to take any action.
4. From the Start the Print Server Subsystem panel, take the default values and press Enter.
   The system responds with a message similar to this:

   0513-059 The lpd Subsystem has been started. Subsystem PID is 25550.
   which indicates that the lpd daemon is now active.
5. Exit the SMIT interface.

**Verifying the LPD service is started on InfoPrint Manager for Linux**

To submit jobs to InfoPrint Manager through the LPD service, the InfoPrint Manager LPD service that comes with InfoPrint Manager for Linux must be started. Use this procedure to verify that the service is started on your InfoPrint Manager for Linux server, and if necessary, to activate the InfoPrint Manager LPD service:
1. Go to Applications → InfoPrint Manager → Management Interface.
2. Expand the Objects group.
3. Left click the LPD Gateway object to see the status in the right panel.
4. Exit the InfoPrint Manager Management Interface.
Defining devices that use InfoPrint Manager for access method U

To define SAP devices to use access method U, follow this procedure:

1. Make sure that you have a logical printer defined in InfoPrint Manager, which will send jobs to your physical printer device.

2. From the R/3 main menu, access the Spool Administration window by clicking the Tools main menu and then selecting the Tools → Administration → Spool → Spool Administration path or typing /nSPAD in the ok-Code field.

3. From the Spool Administration window, select the Output devices option and select the Change button.

4. Click Create and fill in this information on the Create Output Device window:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output device</td>
<td>Type the name that R/3 users need to access the printer.</td>
<td>ipm1pms</td>
</tr>
<tr>
<td>Device type</td>
<td>Select the device type that has been defined in the R/3 system for the printer model. For example, POST2 applies to any PostScript printer.</td>
<td>POST2</td>
</tr>
<tr>
<td>Spool server</td>
<td>Select the name of the R/3 application server, which will be the SAP R/3 spool server (spool work process), that transfers output across a network link.</td>
<td>hrmssbx_SBX_00</td>
</tr>
<tr>
<td>Destination hosts</td>
<td>Type the host name for the InfoPrint server.</td>
<td>nwser</td>
</tr>
<tr>
<td>Host printer</td>
<td>Type the name of the InfoPrint Manager logical destination.</td>
<td>prtl-lp</td>
</tr>
<tr>
<td>Device class</td>
<td>Enter a space so that this field accepts the default value of printer, which is P, or you can specify Standard printer.</td>
<td></td>
</tr>
<tr>
<td>Access method in host spool</td>
<td>Select the method that the spool work process uses to pass data to the host spool system.</td>
<td>U</td>
</tr>
</tbody>
</table>

5. From the menu bar, click Back and the system prompts you to save the new output device.

Once you have completed this task, you can begin submitting jobs to InfoPrint Manager.
Submitting jobs from Windows SAP systems to InfoPrint Manager Windows with access method C

If your SAP system runs on a Windows system, you can submit jobs to a printer running on an InfoPrint Manager Windows server through Access Method C. To configure your Windows SAP system to print through an InfoPrint Manager Windows server, you must create a Windows gateway printer on that InfoPrint Manager Windows server, and then define devices on your SAP system to use access method C.

A Windows gateway printer is the combination of a printer driver and a port. You can create a Windows printer using the Windows Add Printer wizard. You can see these printers from the Windows Printers window, but you should never open and modify them from there.

To define SAP devices to use access method C, follow this procedure:

1. Make sure that you have a logical printer defined in InfoPrint Manager that sends jobs to your actual destination device.
2. From the R/3 main menu, access the Spool Administration window by selecting the Tools main menu and then selecting the Tools → Administration → Spool → Spool Administration path or typing /nSPAD in the ok-Code field.
3. From the Spool Administration window, select the Output devices option and click Change.
4. Click Create and fill in this information about the Create Output Device window:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output device</td>
<td>Type the name that R/3 users will need to access the printer.</td>
<td>prt2</td>
</tr>
<tr>
<td>Device type</td>
<td>Select the device type that has been defined in the R/3 system for the printer model. HPLJ4 applies to a Hewlett-Packard LaserJet 4 printer.</td>
<td>HPLJ4</td>
</tr>
<tr>
<td>Spool server</td>
<td>Select the name of the R/3 application server, which will be the SAP R/3 spool server (spool work process), that transfers output across a network link.</td>
<td>rt1_RT1_00</td>
</tr>
<tr>
<td>Host printer</td>
<td>Type the hostname of the InfoPrint Manager Windows server (ANAKE), followed by the Windows shared printer name (EDPTEST).</td>
<td>\ANAKE\EDPTEST</td>
</tr>
<tr>
<td>Field</td>
<td>Explanation</td>
<td>Example value</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Device class</td>
<td>Enter a space so that this field accepts the default value of printer, which is P.</td>
<td></td>
</tr>
<tr>
<td>Access method in host spool</td>
<td>Select the method that the spool work process uses to pass data to the host spool system.</td>
<td>C</td>
</tr>
</tbody>
</table>

5. From the menu bar, click **Back** and the system prompts you to save the new output device.
This glossary defines technical terms and abbreviations used in InfoPrint Manager.

**Special Characters**

*.Guidefaults file*

A file created by InfoPrint in the home directory of a person using the InfoPrint GUI. InfoPrint uses this file to save and reference information about the servers you are monitoring and the windows you are working in.

**A**

**Access Control List (ACL)**

In computer security, a collection of all access rights for one object.

**ACL**

Access Control List.

**acl editor**

A command line interface that lets you view, add, update, and delete access authorization records in an ACL.

**action**

In the InfoPrint GUI, an icon that represents an operation that you can perform on an InfoPrint object. You drag and drop the action onto an object to initiate the operation for that object. For example, using the **Enable** action to enable a disabled actual destination.

**actual destination**

In InfoPrint, an object that represents the output device that performs the printing or transmission function. See email destination; see also physical printer, printer device; contrast with logical destination.

**additive color system**

A system that reproduces an image by mixing (adding) appropriate quantities of red, green, and blue light (the additive primary colors) to create all other colors of light, either direct or transmitted. When the additive primaries are superimposed on one another, they create white light. Contrast with subtractive color system.

**administrator**

In InfoPrint, the person who creates and manages one or more components of a printing system, such as servers and actual destinations. By default, InfoPrint gives administrators authorization to perform some InfoPrint operations and to access certain information that is not available to the operators or job submitters.

**Adobe Acrobat**

An Adobe software program that provides instant access to documents in their original format, independent of computer platform. With the Adobe Reader, you can view, navigate, print, and present any Portable Document Format (.pdf) file.

**Adobe PageMaker**
A desktop publishing program that produces PostScript documents.

**Adobe PostScript Raster to Image Transform (RIP)**

See raster image processor (RIP).

**ADSM/6000**

Advanced Distributed Storage Manager.

**Advanced Distributed Storage Manager (ADSM/6000)**

A program that provides storage management for archived files.

**Advanced Function Common Control Unit (AFCCU)**

A RISC-based control unit with code common to all printers that use the AFCCU.

**Advanced Function Presentation (AFP)**

A set of licensed programs, together with user applications, that use the all-points-addressable concept to print data on a wide variety of printers or to display data on a wide variety of display devices. AFP includes creating, formatting, archiving, retrieving, viewing, distributing, and printing information.

**Advanced Function Presentation data stream (AFP data stream)**

The printer data stream used for printing AFP data. The AFP data stream includes composed text, page segments, electronic overlays, form definitions, and fonts downloaded from the operating system to the printer.

A presentation data stream that is processed in AFP environments. The AFP data stream includes MO:DCA-P-based data streams.

**Advanced Interactive Executive (AIX)**

An operating system used with pSeries computers. The AIX operating system is IBM’s implementation of the UNIX operating system.

**AFCCU**

Advanced Function Common Control Unit.

**AFP**

Advanced Function Presentation.

**AFP data stream**

Advanced Function Presentation data stream.

**ainbe**

The printer input/output backend program used by the PSF DSS to send jobs to printer devices. Depending on the incoming data stream of the job, the PSF DSS might have transformed the data stream of the job before the backend program sending it to the printer device.

**AIX**

Advanced Interactive Executive.

**AIX-attached printer**
A printer device, attached to an pSeries computer through the network or through a serial or parallel port that receives jobs from an AIX print queue.

In InfoPrint, a PSF physical printer that represents an AIX-attached printer device. See also direct-attached printer, TCP/IP-attached printer, upload-TCP/IP-attached printer.

**AIX destination support system**

In InfoPrint, the destination support system that communicates with the standard AIX print backend (piobe), or with certain variations of the rembak print backend, to print jobs.

**AIX physical printer**

In InfoPrint, the object representing a printer device that uses the AIX destination support system.

**aliasing**

In a digitized image, the creation of diagonal lines by combining short horizontal and vertical line segments that approximate the path of the desired line.

**all-points-addressability (APA)**

The capability to address, reference, and position text, overlays, and images at any defined point of the printable area of the paper or display medium.

**alphameric**

Synonym for alphanumeric.

**alphanumeric**

Pertaining to a character set containing letters, digits, and other symbols such as punctuation marks. Synonymous with alphameric.

**AMPV**

Average monthly print volume.

**analog**

Pertaining to a continuous variable sampling of information between two points that achieves an even, smooth transition of photographic material.

**analog color proof**

An off-press color proof made from separation films.

**anti-aliasing**

The rendering of hard-edged objects so that they blend smoothly into the background. PhotoShop offers anti-aliasing when rasterizing an EPS file.

Removing the jagged “stairstep” quality in diagonal lines produced on a computer screen by aliasing. This removal is effected by creating less densely shaded fields parallel to the diagonal line.

**APA**

All-points-addressability.

**API**

Application Program Interface.

**Application Program Interface (API)**
The call interface between a client program and the procedures that implement the printing system, as defined by the specification. Clients use the API to access servers. (P)

architecture

The set of rules and conventions that govern the creation and control of data types such as text, image, graphics, font, color, audio, bar code, and multimedia.

archiving

The transfer of digital information from an online system onto floppy disk, compact disc, or other media for offline storage. The original copy is deleted from the online system. See also retrieval.

array inkjet

An ordered collection of multiple print heads used in an inkjet printer.

ASCII

American National Standard Code for Information Exchange. The standard code, using a coded character set consisting of 7-bit coded characters (8 bits including a parity check). The ASCII code is used for information exchange among data processing systems, data communications systems, and associated equipment. The ASCII character set includes control characters and graphic characters.

asynchronous

Pertaining to two or more processes that do not depend upon the occurrence of specific events, such as common timing signals. (T)

In InfoPrint, occurring without a regular or predictable time relationship to a specified action. Contrast with synchronous.

attachment type

Defines the method by which a printer device is attached to the AIX system from which it receives data. See AIX-attached printer, direct-attached printer, TCP/IP-attached printer, and upload-TCP/IP-attached printer.

attribute

A defined characteristic of an object, such as the number of copies required of a job, or the document formats accepted by an actual destination.

attribute name

A string that identifies an attribute. Typically, in InfoPrint attribute names consist of two or more words separated by hyphens.

attribute value

The element of an attribute that specifies the characteristics relating to the attribute.

authorization

In computer security, verification of the eligibility of a user to access an object.

authorized user

A person with the appropriate permissions to access an object or to issue a command.

automatic recovery
A function of printer logic that permits the printer to reprint a job if the job is misprinted or damaged or if a component has failed.

**auxiliary sheet**

In InfoPrint, an object that represents a particular sheet of paper, blank or otherwise, that can precede a job, separate documents in a job, or follow a job.

**auxiliary-sheet selections**

A particular combination of start, separator, and end sheets that print with jobs on a particular printer device.

**B**

**backend**

In AIX or Linux, the program that is invoked by the `qdaemon` process (AIX) or CUPS printing system (Linux) to run a print or batch job. Synonymous with backend program.

**backend program**

Synonym for backend.

**backlog**

In InfoPrint, the amount of time calculated by InfoPrint that is required to print all of the jobs currently in a queue.

**backspace**

In InfoPrint, the action used to back up and reprint pages in a job.

**bar code**

A code representing characters by sets of parallel bars of varying thickness and separation that are read optically by transverse scanning.

An array of parallel rectangular bars and spaces that together represent data elements or characters in a particular symbology. The bars and spaces are arranged in a predetermined pattern following unambiguous rules defined by the symbology.

**BCOCA**

Bar Code Object Content Architecture.

**Bezier curves**

A method of defining curves using anchor points, control handles, and tangent lines. The PostScript path passes through anchor points. Its approach direction is along the tangent lines that are controlled by the control handles. Many personal computer programs use this drawing method. Type 1 PostScript fonts are defined using Bezier curves.

**binding**

The cover and materials that hold a book together. See edition binding, perfect binding, spiral binding, wire-o binding.

The process of applying the binding to a book.

In InfoPrint, assigning a job to an actual destination. See early binding, late binding.

**bitmapmed**
Pertaining to an image formed by a rectangular grid of pixels. Each pixel is assigned a value to denote its color. One-bit images are black and white; 8-bit images have 256 colors (or grays); 24-bit images have full color. CMYK images have 32-bits per pixel to encode 256 levels in each of four channels. Bitmapted images are also called raster images.

**bleed**
An extra amount of printed image that extends beyond the trim edge of the sheet. Bleed ensures that no white gap appears at the edge of the sheet.

**boot**
To prepare a computer for operating by loading an operating system.

**BSD**
Berkeley Software Distribution.

**BSD destination support system**
In InfoPrint, the destination support system that generates a print command string that the shell runs to print jobs.

**BSD physical printer**
In InfoPrint, the object representing a printer device that uses the BSD destination support system.

**burn**
In platemaking, an exposure. Burn is named because of the extremely bright ultraviolet lamps used to transfer images from film to plate.
In photography, to lengthen the final exposure time to increase the final density of print.

**C**

**CDE**
Common Desktop Environment.

**child**
See parent/child relationship.

**choke**
In color printing, an area whose dimensions have been reduced to avoid overlapping another color. Contrast with spread.

**class**
Synonym for object class.

**clean**
In InfoPrint, an action used to remove all the jobs from specified servers, actual destinations, or queues, or to remove all the jobs submitted to specified logical destinations.

**CLI**
Command Line Interface.

**client**
In InfoPrint, the component of the print system that assembles a print request and submits the request to a server. The client generates the local ID numbers for each job, submits the jobs to the servers, and keeps track of where each user's jobs have been submitted.

**CMR**

Color Management Resource.

**CMY**

Cyan, magenta, yellow.

**CMYK**

Cyan, magenta, yellow, black.

**collator**

In some printers a special-purpose hard drive disk array used to store RIPped files and later transfer them to the LED print heads for imaging.

**color balance**

The relative levels of cyan, magenta, and yellow channels in an image to produce accurate color rendition of an original image.

**color correction**

The adjustment of the color balance in an image to produce accurate color rendition of an original image. Color correction is used for two- or three-spot-color jobs.

**color key**

A color proof similar to Cromalin, but typically not laminated and not necessarily accurate in color. Color keys are used to verify that breaks or color assignments and traps have been made accurately.

**Color management resource**

Color management resource (CMR) is an architected resource that is used to carry all of the color management information required to render a print file, document, group of pages or sheets, page, or data object with color fidelity.

**Command Line Interface (CLI)**

A type of user interface where commands are specified on the command line. Contrast with Graphical User Interface.

**Common Desktop Environment (CDE)**

A graphical user interface running on a UNIX operating system.

**complex attribute**

In InfoPrint, an attribute that can have multiple values with each value containing multiple components.

**constant data**

Data that does not change between copies of a document and that is merged with variable data to produce personalized documents. For example, a form letter (constant data) can be merged with a customer's name and address (variable data).
contextual help
A type of online help that provides specific information about each selectable object, menu choice, notebook tab, field, control, and pushbutton in a window.

control strip
A strip of information that can be attached to a print job and used to measure registration and density.

Cromalin
The Dupont color proofing system. Four layers (CMYK) of light-sensitive material are exposed through final halftone negative films, then laminated together on an opaque backing to produce a color- and trap-accurate final proof showing actual halftone dot structure. Cromalin is sometimes called an analog proof.

crop
To remove unwanted areas of an image, usually indicated by crop marks on the original.

CTS
Cutter-trimmer-stacker.

CUPS
Common Unix Printing System is a modular printing system for Unix-like computer operating systems which allows a computer to act as a print server. A computer running CUPS is a host that can accept print jobs from client computers, process them, and send them to the appropriate printer.

CUPS destination support system
In InfoPrint, the destination support system that communicates with the standard LINUX print system (CUPS) and that uses InfoPrint Manager pioinfo backend, InfoPrint Manager piorpdm backend for Ricoh printers or other print backends to print jobs.

cutter-trimmer-stacker (CTS)
A post-processing device attached to a printer device and used for paper handling.

cyan, magenta, yellow (CMY)
The subtractive primary colors.

cyan, magenta, yellow, black (CMYK)
The four basic colors used in offset printing, as opposed to the three basic colors of light: red, green, and blue. Magenta, yellow, and cyan are the subtractive primaries. Black is added to provide better density and to produce a true black.

D

daemon
A program that runs unattended to perform a standard service. Some daemons are triggered automatically to perform their tasks; others operate periodically. Daemon processes generally provide a service that must be available at all times to more than one task or user, such as sending data to a printer.

data stream
All information (data and control commands) sent over a data link.

A continuous stream of data that has a defined format.

In InfoPrint, pertaining to the incoming format of the job and the output format required by the printer device. InfoPrint transforms the incoming format into the output format, as required. See also document format.

DB2*/6000

Database 2/6000.

deadline

In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the one whose deadline is closest. Contrast with FIFO (first-in-first-out), job-priority, longest-job-first, and shortest-job-first.

default document

In InfoPrint, an object that represents default attribute values for a document in a job. Synonymous with initial value document.

default job

In InfoPrint, an object that represents default attribute values for a job. Synonymous with initial value job.

default object

In InfoPrint, a general term that refers either to a default document or a default job. Synonymous with initial value object.

default value

A value stored in the system that is used when no other value is specified.

delete

In InfoPrint, an action used to delete default objects, jobs, logical destinations, actual destinations, or queues from the server.

desktop publishing

Performing print-related activities on a personal computer, including but not limited to layout, design, photo manipulation, creating fonts, editing text, color separation, scanning, and animation.

destination

See actual destination, logical destination.

destination support system (DSS)

In InfoPrint, the programs that an actual destination uses to communicate with the output device. Synonymous with device support system. See AIX destination support system, BSD destination support system, email destination support system, and PSF destination support system.

device

An individual piece of equipment (hardware) that attaches to a computer, such as a printer device.

device address

The identification of an input or output device by its channel and unit number.
device driver
A file that communicates with a specific device such as a printer, disk drive, or display. An application that sends output to a device controls the actions of the device through the device driver. See printer driver.

device support system (DSS)
Synonym for destination support system.

DFS
Distributed File Service.

digital
Pertaining to data represented by digits, sometimes with special characters and the space character.

digital color proof
An off-press color proof made from a color printer attached to a computer.

digital printing
A filmless and plateless printing process in which digital data for each page is transferred directly to a light-sensitive drum and then to paper for a final image.

direct-attached printer
A printer device, attached to an pSeries computer through the network or through a serial or parallel port.

In InfoPrint, a PSF physical printer that represents a direct-attached printer device. See also AIX-attached printer, TCP/IP-attached printer, and upload-TCP/IP-attached printer.

disable
In InfoPrint, an action used to stop the acceptance of jobs on destinations, queues, or servers, or to stop writing information to logs.

distributed print system
A computer system with the ability to interchange print data and controls among different computing environments with the intent of printing the data on a different system from the one where the print request was generated. For example, in host-to-LAN distributed printing, data that is located on the host is printed on printers attached to a local area network.

dithering
A technique of filling the gap between two pixels with another pixel having an average value of the two to minimize the difference or to add detail to smooth the result.

document
In InfoPrint, an object representing a grouping of data in a job. A job can contain one or more documents. The documents in a job can differ from each other in some ways. For example, they can contain different data and can have different document formats. A document in a job can contain printable data or a resource that is not printable by itself. See file-reference document, printable document, and resource document.

document element
A portion of a document at least a single page in size.
document format
In InfoPrint, a document format describes the type of the data and control characters in the
document, such as line data or PostScript. The format of the data determines which printer devices
are capable of printing the document and whether InfoPrint must transform the format.

document identifier
A string that identifies a document in a job. It consists of a job ID followed by a period (.) and a
document sequence number. For example, 12.2. Document sequence numbers are integers
starting at 1.

Document Printing Application (DPA)
An ISO/IEC 10175 standard that addresses those aspects of document processing that enable
users in a distributed open systems environment to send electronic documents to shared, possibly
geographically-dispersed printers. InfoPrint supports the DPA standard.

document transfer method
In InfoPrint, the transfer method describes how documents are transferred to, or acquired by,
servers. See pipe-pull and with-request.

document type
In InfoPrint, the document type describes the kind of data in the document. A printable document
can only contain printable data. A resource document can only contain data such as fonts or form
definitions that are not printable. A file reference document can only contain names of files entered
on separate lines.

dot
The individual elements of a halftone.

dot gain
An increase in the size of a halftone dot during printing, caused by ink spreading. Generally, this
value is known precisely, and the scanning and filming production process is calibrated to
compensate for it. The Cromalin proofing system simulates this effect.

dots per inch (dpi)
A measure of data density per unit distance. Typical values for desktop publishing range from 200
to 300 dpi.

DPA
Document Printing Application.

DPF
Distributed Print Facility.

dpi
Dots per inch.

drag and drop
In graphical user interfaces, a procedure by which you perform actions and tasks. Using the mouse,
you drag (move) an action or object icon to a new position where you want the action or task to
occur.
DSS
Destination support system.

dummy
A rough paste-up or hand-drawn representation of the anticipated finished product. A dummy is used for basic design and pagination.

duplex printing
Printing on both sides of the paper. Contrast with simplex printing (1).

Printing on both sides of the paper, placing output images on the media in a head-to-head format, so that the top of one image is at the same edge as the top of the next image. Contrast with tumble duplex printing; see also simplex printing (2).

E
early binding
In InfoPrint, assigning a job to an actual destination as soon as it is accepted. Early binding permits InfoPrint to estimate the time when the job will be completed. Contrast with late binding.

dedtion binding
A type of book binding in which printed sheets are folded into 16- or 32-page signatures. Four-page endleaves are pasted on the outside of the first and last signature. The signatures are then collated by machine and sewn together using special sewing machines. Contrast with perfect binding, spiral binding, and wire-o binding.

electronic document
A document stored in a computer instead of printed on paper.

electronic mail
Correspondence in the form of messages sent between workstations over a network. Synonymous with email.

electrophotographic
Pertaining to a type of printer technology that creates an image on paper by uniformly charging the photoconductor, creating an electrostatic image on the photoconductor, attracting negatively charged toner to the discharged areas of the photoconductor, and transferring and fusing the toner to paper.

em
In composition, a unit of measurement exactly as wide and as high as the point size of the font being set. The name is derived from the fact that the letter M in early typefaces was usually cast on a square body.

electronic mail
Electronic mail.

e-mail destination
In InfoPrint, an actual destination representing an electronic mailing system.

e-mail destination support system
In InfoPrint, the destination support system that supports email destinations.

**embellishments**
Variable data added to all copies of assembled pages to make the unit appear like a whole; for example, headers, footers, a table of contents, and chapter separations.

**en**
In composition, exactly one-half an em.

**enable**
In InfoPrint, the action that makes a destination, queue, or server able to accept jobs, or a log able to accept information.

**end sheet**
The sheet of paper, blank or otherwise, that can follow a job. See also auxiliary sheet.

**Enhanced X-Windows**
A tool designed to permit multiple application processes to operate in multiple windows displayed on a virtual terminal. See X-Windows.

**environment variable**
Any one of a number of variables that describe the way an operating system runs and the devices it recognizes.

**error log**
A data set or file in a product or system where error information is stored for later access.

**estimate**
The professional cost analysis made by a print shop in response to a customer's request for a price quotation on a print job.

**event**
In InfoPrint, an occurrence in the printing system during an operation; for example, the completion of a command.

**event log**
In InfoPrint, a collection of messages about events that have occurred.

**event notification**
The notification that is sent by InfoPrint for an event.

**F**

**FIFO (first-in-first-out)**
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the job that has been in the queue for the longest time. InfoPrint processes jobs in the order in which they are received. Contrast with deadline, job-priority, longest-job-first, and shortest-job-first.

**file-reference document**
In InfoPrint, a file containing the names of other files, each entered on a separate line. Job submitters can specify this file for printing when they specify a document type of file-reference; InfoPrint prints each file listed in the reference document.

File Transfer Protocol (FTP)
In TCP/IP, the application protocol that makes it possible to transfer data to and from host computers and to use foreign hosts indirectly.

finisher
A hardware device attached to a printer that performs such operations as folding or stapling the printed pages.

finishing
In a print shop, the final operations on a printed product, such as stapling, trimming, drilling, folding, embossing, varnishing, gluing, shrink wrapping, perforating, laminating, collating, and so on.

flag
A modifier of a command that specifies the action of the command. A dash usually precedes a flag. Synonymous with option. See also keyword.

FOCA
Font object content architecture.

folder
In the InfoPrint GUI, an object that represents a container for a collection of similar objects. For example, the Retained Jobs folder contains retained jobs.

font
A family of characters of a given size and style; for example, 9-point Helvetica.
One size and one typeface in a particular type family, including letters, numerals, punctuation marks, special characters, and ligatures.
A paired character set and code page that can be used together for printing a string of text characters. A double-byte font can consist of multiple pairs of character sets and code pages.

form definition
A resource object used by InfoPrint that defines the characteristics of the form or printed media, which include: overlays to be used, the paper source (for cut-sheet printers), duplex printing, text suppression, and the position of composed-text data on the form.

forward space
In InfoPrint, the action used to move ahead and skip the printing of a specified number of pages in a job.

FPO
Low-quality (sometimes photographic) images placed in a dummy to represent final images. Desktop publishing software produces images as display-screen resolution FPOs.

front panel
In the CDE, a workspace area containing controls that represent various tasks you can perform and workspace switches.

**FST**
Files and Sockets Transport is the local security implementation for InfoPrint Manager. It uses the local namespace for user credentials, and it is a lightweight security protocol.

**FTP**
File Transfer Protocol.

**G**

**GCR**
Gray component replacement.

**GIF**
Graphics Interchange Format.

**global change**
In the InfoPrint GUI, an action used to make changes to one or more attributes of several objects at once. You can also perform the same action on several objects of the same object class at the same time; for example, disabling two or more actual destinations at the same time.

**global character**
A character or set of characters used to specify an unknown number or set of characters in a search string. In InfoPrint, a global character is represented by an asterisk (*).

**global ID**
Global job identifier.

**global job identifier**
An unambiguous job identifier. In InfoPrint, it is represented as the name of the server managing the job followed by a colon (:) and a generated integer. This ID uniquely identifies the job in the InfoPrint server.

**glyph**
An image, usually of a character, in a font.

**GOCA**
Graphics object content architecture.

**graphic character**
A visual representation of a character, other than a control character, that is normally produced by writing, printing, or displaying.

**Graphical User Interface (GUI)**
A type of user interface that takes advantage of a high-resolution monitor and includes a combination of graphics to implement an object-action paradigm, the use of pointing devices, menu bars, overlapping windows, and icons. Contrast with Command Line Interface.
A compressed graphics format widely used on the Internet.

gray component replacement (GCR)
Synonym for under color removal (UCR).

gray scale
A strip of standard gray tones, ranging from white to black, placed at the side of the original copy during photography to measure the tonal range and contrast obtained.

GUI
Graphical User Interface.

gutter
The blank area or inner margin from the printing area to the binding.

H
halftone
A printing method that simulates continuous-tone shading using dots of varying sizes laid out on a rectangular grid. Larger dots simulate darker tones and smaller dots simulate lighter tones. Typical grid spacings are 85 lines per inch (lpi) (newspaper), 133 lpi (low end), 150 lpi (midrange), and 175+ lpi (high quality).

help
In the InfoPrint GUI, an action used to display the online help for a specific template, object, action, button, control, or area in an application window.
The name of a button used to access the online help.

hold
An indication determined by the job-hold attribute that is used to keep a job in the queue and prevent InfoPrint from scheduling it.

hostname
The name given to an AIX system.

hot folder
A workstation directory where users copy jobs to submit them to print.

hypertext
A way of presenting information online with connections between one piece of information and another. These connections are called hypertext links. See also hypertext link.

hypertext link
A connection between one piece of information and another. Selecting a link displays the target piece of information.

I
icon
A graphic symbol displayed on a screen that a user can click to invoke a function or software application.

**image**
Toned and untoned pels arranged in a pattern.

**image data**
Rectangular arrays of raster information that define an image.

**imagesetter**
A high resolution (1270–3600+ dpi) printer that uses an Argon (green) laser to write to film using digital input. Imagesetting is the step before Cromalin proofing and platemaking.

**imposition**
The process of arranging pages on a press sheet to ensure the correct order during final cutting, folding, and binding. Electronic imposition builds press sheets automatically during the RIP and outputs film formatted for immediate use in platemaking.

**InfoPrint**
A solution of software and hardware products that can supplement or replace the offset presses and copiers in print shops with high-quality, non-impact, black and white or process color printers. InfoPrint takes documents from creation to the published, kitted, and shipped product.

In InfoPrint software publications, InfoPrint Manager for AIX or any of its components.

**InfoPrint Manager for AIX**
The software component of InfoPrint. InfoPrint Manager for AIX handles the scheduling, archiving, retrieving, and assembly of a print job and its related resource files. It also tracks the finishing and packaging of the printed product.

InfoPrint Manager for AIX is based on Palladium technology developed at MIT/Project Athena. It conforms to the ISO DPA and POSIX standards.

**InfoPrint Network**
The local area network running TCP/IP protocol that InfoPrint uses to communicate among servers, clients, and output devices.

**InfoPrint Select**
The component of InfoPrint Manager for AIX that lets you submit jobs from an OS/2 or Windows workstation.

**InfoPrint Submit Express**
The component of InfoPrint Manager that lets you submit jobs with a job ticket from a Windows or Macintosh workstation.

**InfoPrint 20**
A black and white, large-format, cut-sheet, workgroup laser printer with optional duplexing and 600-dpi resolution.

**InfoPrint 60**
A duplex, black and white, cut-sheet printer with 600-dpi resolution.
InfoPrint 62
A non-impact, continuous-forms printer that runs at a maximum of 62 impressions-per-minute (depending on forms size), and is factory set to run at either 240 or 300 dpi on a maximum paper size of 370.8 mm (14.6 in.).

InfoPrint 4000
A duplex, black and white, continuous-forms printer with 600-dpi resolution.

initial value document
Synonym for default document.

initial value job
Synonym for default job.

initial value object
Synonym for default object.

initially settable attribute
An attribute whose value can be established when an object is created but cannot be subsequently set or modified. See also resettable attribute; contrast with non-settable attribute.

input focus
The area of a window where user interaction is possible from either the keyboard or the mouse.

input tray
For a printer device, the container that holds the medium upon which the printer prints its output.

Intelligent Printer Data Stream (IPDS)
An all-points-addressable data stream that enables users to position text, images, and graphics at any defined point on a printed page.

Information that the host sends to IPDS printers. This information generally contains basic formatting, error recovery, and character data and enables the printers to make decisions.

An architected host-to-printer data stream that contains both data (text, image, graphics, and bar codes) and controls defining how the data is to be presented. IPDS provides a device-independent interface for controlling and managing all-points-addressable (APA) printers.

International Organization for Standardization (ISO)
An organization of national standards bodies from various countries established to promote development standards to facilitate international exchange of goods and services, and develop cooperation in intellectual, scientific, technological, and economic activity.

Internet
A wide area network connecting thousands of disparate networks in industry, education, government, and research. The Internet network uses TCP/IP as the protocol for sending information.

Internet Protocol
The set of rules that determines how to route data from its source to its destination in an internet environment.
intervening jobs
In InfoPrint, the number of jobs in a queue that are scheduled to print before the job in question.

IOCA
Image object content architecture.

IP address
The IPv4 or IPv6 address.

IPDS
Intelligent Printer Data Stream.

ISO
International Organization for Standardization.

J

job
In InfoPrint, an object that represents a request to print or send one or more documents together in a single session. A job includes the data to be printed or sent and resources such as fonts, images, and overlays. Depending on how it was submitted, it can also include a job ticket. Synonymous with job bundle and print job.

job bundle
Synonym for job.

job data
The page descriptions, merge data, and embellishments that compose a document in a job, either directly or by reference.

job ID
A local or a global identifier that identifies a job to a job submitter, administrator, operator, or InfoPrint. See local job identifier, global job identifier.

job-priority
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the one with the highest priority. Contrast with deadline, FIFO (first-in-first-out), longest-job-first, and shortest-job-first.

job submitter
In InfoPrint, the person who submits jobs for printing. Often, this person is an application programmer who maintains applications that generate data to be printed.

job ticket
The customer’s hardcopy or electronic instructions listing all the variables describing a print job, either directly or by reference. The print shop can add specifications to the job ticket and can print the job ticket.

Joint Photographic Experts Group (JPEG)
A compressed graphics format widely used on the Internet.
JPEG
Joint Photographic Experts Group.

K
kerning
In typesetting, adjusting the relative spacing of two characters to improve their appearance and readability. Kerning pairs are specific sets of characters with built-in relative spacing. Some typefaces have as many as 100 kerning pairs.

keyword
A name or symbol that identifies a parameter.
Part of a command operand that consists of a specific character string, such as DNAME=.

kitting
In a print shop, packaging the completed published work with attendant binders, tabs, diskettes, and other equipment or information, before shipping the finished product.

L
LAN
Local Area Network.
laser (light amplification by stimulated emission of radiation)
In InfoPrint printers, a device that emits a beam of coherent light that forms the image on the photoconductor that is subsequently transferred to the paper.
late binding
In InfoPrint, waiting to assign a job to an actual destination until it is about to be processed. Late binding permits InfoPrint to route a job to the first suitable actual destination that becomes available. Contrast with early binding.

LDAP
Lightweight Directory Access Protocol is the network security implementation for InfoPrint Manager. It uses an LDAP or Active Directory server for user credentials, and it offers a unified security implementation in a customer environment.

LED
Light-emitting diode.

light-emitting diode (LED)
The imaging device element for electrophotographic print units.

lines per inch (lpi)
A measure of the density of the grid used to space halftone dots. Typical grid spacings are 85 lpi (newspaper), 133 lpi (low end), 150 lpi (midrange), and 175+ lpi (high quality).

Linux
Linux is an open-source operating system modeled on UNIX. There are multiple distributions available, InfoPrint Manager is only supported on Red Hat Enterprise Linux (RHEL) and SUSE Linux Enterprise Server (SLES).

**Local Area Network (LAN)**

A computer network at one location that consisting of devices connected to one another and communicating. This network can also be connected to a larger network.

**local ID**

Local job identifier.

**local job identifier**

In InfoPrint, a job identifier automatically generated by the server, identifying the job to the person who submitted it. InfoPrint maps a local job ID to a global job ID.

**locale**

The human language and character set of information presented to a user.

In InfoPrint, the language InfoPrint uses when sending notification and error messages or displaying the InfoPrint graphical user interfaces.

**log**

A collection of messages or message segments added to a file for accounting or data collection purposes.

To record messages in a file.

**logical destination**

In InfoPrint, an object to which users submit their jobs. The logical destination routes jobs to one or more actual destinations representing output devices such as printers, or electronic mail systems. See also logical printer; contrast with actual destination.

**logical printer**

In InfoPrint, a type of logical destination. The logical printer routes jobs to one or more physical printers representing printing devices.

**logical unit (LU)**

A type of network accessible unit that enables end users to gain access to network resources and communicate with each other.

**logical unit (LU) 6.2**

A type of logical unit that supports general communication between programs in a distributed processing environment. LU 6.2 is characterized by (a) a peer relationship between session partners, (b) efficient utilization of a session for multiple transactions, (c) comprehensive end-to-end error processing, and (d) a generic application program interface (API) consisting of structured verbs that are mapped into a product implementation.

**longest-job-first**

In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the longest job in the queue. Contrast with deadline, FIFO (first-in-first-out), job-priority, and shortest-job-first.
lpi
Lines per inch.

LU
Logical unit.

M

magnetic ink character recognition (MICR)
Identification of characters printed with ink that contains particles of magnetic material.

mainframe processor
A functional unit that interprets and executes instructions in a large computer to which other computers are connected so that they can share the facilities the mainframe provides.

makeready
All the setup work involved in preparing a press for a print run.

manage
In the InfoPrint GUI, the action used to put an object into a mode where its icon reflects changes of status.

mechanical
A camera-ready layout. The mechanical can consist of multiple sheets or overlays for each spot or process color used. Final images, if not stripped in later, should be at final size, cropped and screened to the correct line frequency.

medium
In InfoPrint, an object representing the physical material upon which a job is printed.

merge data
Data that is unique to each copy of a document and that customizes the document; for example, serial numbers or mailing information. Merge data is typically a small percentage of the total data in the document.

message catalog
A file of all the possible messages than can display during the processing of an application.

MICR
Magnetic ink character recognition.

Mixed Object Document Content Architecture (MO:DCA)
An architected, device-independent data stream for interchanging documents.

MO:DCA-P
Mixed Object Document Content Architecture Presentation.

modify
In InfoPrint, an action used to modify the values of attributes in the object attributes notebook.

moire
Undesirable interference patterns caused by two overprinting halftone screens with incorrect halftone dot angles.

**monospaced**

In typesetting, pertaining to a typeface in which all the characters have equal widths. Monospaced typefaces are useful for tabulating figures.

**Multiple Virtual Storage (MVS)**

An operating system developed by IBM. The design of MVS incorporates an addressing architecture that provides a unique address space to each job in the system.

**MVS**

Multiple Virtual Storage.

**N**

**N_UP**

Pertaining to the number of forms placed together in a layout. Typical layouts are 2_UP, 4_UP, 8_UP, 16_UP, and so on. N_UP printing is done to use the maximum area of the print sheet.

**namespace**

A global name repository available to all utilities and API procedures. The namespace contains mappings of object names to other related objects. For example, the namespace provides the mapping of a logical destination to the server in which it is located.

**Network File System (NFS)**

A protocol developed by Sun Microsystems that uses Internet Protocol to allow a set of cooperating computers to access each other's file systems as if they were local.

**newline options**

The different ways in which the printer determines how lines are delimited in a document data stream.

**NFS**

Network File System.

**non-process-runout (NPRO)**

A printer function that moves the last printed sheet to the stacker of the printer device.

**non-settable attribute**

An attribute that is neither initially settable nor resettable. The values for these attributes are controlled by InfoPrint. Contrast with initially settable attribute and resettable attribute.

**notification**

The act of reporting the occurrence of events.

In InfoPrint, notification of events appears as messages in event logs or messages sent to administrators, operators, and job submitters. In the InfoPrint GUI, notification of events also appears as changes to the appearance of icons.

**notification-profile**
In InfoPrint, an attribute associated with an object that contains information designating the people to whom InfoPrint sends notification about events for that object, which event information it sends, and how it sends the information.

**NPRO**

Non-process-runout.

**O**

**object**

A collection of attributes that represent a physical or logical entity in the print system. For example, a specific printer device is represented by an actual destination (physical printer) object. An object is identified by its object name. Objects are grouped into classes. See also object class.

**object class**

A group of objects that share a common definition and therefore share common properties, operations, and behavior as defined by their attributes. For example, all InfoPrint queue objects are in the same object class and each queue has the same set of queue attributes. However, the values for those attributes can differ for each queue in the queue object class.

**Object Identifier (OID)**

In architecture, a notation that assigns a globally unambiguous identifier to an object or a document component. The notation is defined in international standard ISO.IEC 8824(E).

**object name**

The alphanumeric term that identifies an object.

**object state**

The state of an object indicates its availability and readiness for performing its functions. An object can be in one of a number of states such as ready, busy, or unknown.

**OCR**

Optical character recognition.

**octet**

A byte that consists of eight binary digits (bits).

**offset stacking**

In certain printer devices, a function that allows the printer to offset the printed output pages for easy separation of the jobs.

**OID**

Object Identifier.

**open destinations window**

In the InfoPrint GUI, the action used to open a new application window displaying the logical and actual destinations associated with a queue.

**Open Prepress Interface (OPI)**
An industry standard for replacing low-resolution images in review documents with high-resolution images needed for high-quality final output.

**Open Software Foundation (OSF)**
A nonprofit research and development organization created by a consortium of companies that work together to develop software in the open systems market.

**OpenType font (OTF)**
An extension of the TrueType font format that adds:
- Support for PostScript outlines
- Better support for international character sets
- Broader support for advanced typographic control

**open window**
In the InfoPrint GUI, the action used to open a new application window representing one or more objects displayed in the currently open application window.

**operation**
An action performed on one or more data items.

**operator**
In InfoPrint, the person responsible for printer devices. Also, this person performs a subset of tasks for InfoPrint queues and actual destinations and performs some job-related tasks.

**OPI**
Open Prepress Interface.

**optical character recognition (OCR)**
Conversion of scanned text to editable ASCII characters.

**option**
A modifier of a command that specifies the action of the command. A dash usually precedes an option. Synonymous with flag. See also keyword.

**orphan logical destination**
In the InfoPrint GUI, an object that represents a logical destination that is not associated with an existing queue.

**orphan logical printer**
In the InfoPrint GUI, an object that represents a logical printer that is not associated with an existing queue.

**OSF**
Open Software Foundation.

**overlay**
A collection of constant data, such as lines, shading, text, boxes, or logos, that is electronically composed in the host processor and stored in a library, and that can be merged with variable data during printing.
OTF

OpenType font.

P

PAC

Privilege Attribute Certificate.

page definition

A resource that contains the formatting controls for line data.

In InfoPrint, a resource that defines the rules of transforming line data into composed pages and text controls.

page segment

A resource that contains composed text and images, which are prepared before formatting and included during printing.

Palladium

A distributed print system developed at MIT/Project Athena with participation from Digital Equipment Corporation (DEC), International Business Machines (IBM), and Hewlett-Packard (HP). It is a reference implementation for the OSI Document Printing Architecture (DPA) standard, ISO/IEC 10175.

pane

In the Work Area of the InfoPrint Manager Administration GUI, an area containing a group of objects of a specific type, such as an actual destinations pane.

parent/child relationship

In InfoPrint, servers, queues, and destinations are related to one another in a parent/child relationship. For example, a server is the parent of all the queues that reside in that server, and these queues are its children.

pass through

In InfoPrint, referring to options submitted with a job that are used by the device driver, but not InfoPrint. InfoPrint does not process or validate this information; it passes it along to the device driver. See printer driver.

path

The route used to locate files; the storage location of a file. A fully qualified path lists the drive identifier (if any), directory name, subdirectory name (if any), and file name with the associated extension.

pause

In InfoPrint, the action used to temporarily halt the printing or transmission of jobs on actual destinations or the distribution of jobs from servers or queues.

pdcreate

In InfoPrint, the command used to create a new object and set its attributes to specified values.

PDF
Portable Document Format.

Printer description file.

pdmsg

In InfoPrint, a utility used to display information about a message.

pdpr

In InfoPrint, the command used to create and submit a job, consisting of one or more documents, to a server for printing or transmission.

perfect binding

A type of book binding in which the pages are held together with flexible adhesive. Contrast with edition binding, spiral binding, and wire-o binding.

permissions

In AIX, codes that determine who can access a file and what operations they can perform on the file.

physical printer

In InfoPrint, a type of actual destination that represents a printer device. See also printer device.

piobe

The standard printer input/output backend program used by AIX for printing. See also ainbe.

pipe-pull

In InfoPrint, a document transfer method where InfoPrint saves the documents in a file and transfers the address of the file to the server. InfoPrint transfers the file to the server upon the request from the server. This is an efficient transfer method for large jobs and is the default transfer method at job submission. Contrast with with-request.

plex

A document or actual destination attribute used to define the placement of output images on the page. See the plex values simplex and tumble.

Portable Document Format (PDF)

An Adobe PostScript data format that can be viewed or printed.

Portable Operating System Interface for Computer Environments (POSIX)

An Institute of Electrical and Electronics Engineers (IEEE) standard for computer operating systems.

POSIX

Portable Operating System Interface for Computer Environments.

PostScript

Adobe's page description language. PostScript has become a standard for graphic design and layout software. PostScript files can contain both vector and raster data. Fonts are described using PostScript coding. Many desktop publishing systems produce PostScript data as their output data stream.

PostScript printer description (PPD)
A file that contains options for printing PostScript data on various printer devices.

**PPD**
PostScript printer description.

**Prefix lengths**
Identify a range of IPv6 addresses that are on the same network.

**preflight**
To assess all resources for a job before the actual print run.

**prepress**
Work done in the print shop before printing a job, such as preparing data and art, page imposition, color retouching, electronic editing, and page layout.

**print database**
The set of files on disk that provide a permanent repository for the attributes of all print objects, such as logical destinations, queues, and actual destinations.

**print job**
Synonym for job.

**Print Quality Enhancement (PQE)**
A printer facility that provides edge smoothing along diagonal lines, fine fidelity protection, and independent boldness control.

**Print Services Facility (PSF)**
Any of several programs, including PSF for AIX, PSF/MVS, PSF/VM, and PSF/VSE, that produce printer commands from the data sent to them.

**print system**
A group of one or more print servers and one or more printing devices, which might or might not be located in the same geographical area. The components of a print system are assumed to be interconnected in some manner, providing at least one network interface to print clients, and acting synergistically to supply the defined document print service. (D)

**printable document**
In InfoPrint, an object that represents text or data to be printed by a job. Contrast with resource document.

**printer description file (PDF)**
A file that contains options for printing PostScript data on a specific printer device.

**printer device**
The physical output device that performs the printing function. See also physical printer.

**printer driver**
A file that describes the physical characteristics of a printer or other peripheral device. This file is used to convert graphics and text into device-specific data at the time of printing or plotting. Synonymous with device driver.
priority

In InfoPrint, a number assigned to a job that determines its precedence in being printed. Jobs with higher priority numbers are handled before jobs with lower priority numbers.

process color

Color made up of CMYK links simulating a specified color. This is the traditional method of reproducing continuous tone color images (color separations). Because of the nature of color inks, certain inks do not reproduce well.

processor

In a computer, a functional unit that interprets and executes instructions. A processor consists of at least an instruction control unit and an arithmetic and logic unit. (T)

promote

In InfoPrint, the action used to move a job to the beginning of the queue so that it will print on the next available printer that can handle that job.

protocol

A set of semantic and syntactic rules that determines the behavior of functional units in achieving communication.

pSeries

A family of workstations and servers based on IBM’s POWER architecture. They are primarily designed for running multi-user numerical computing applications that use the AIX operating system.

PSF

Print Services Facility.

PSF destination support system

In InfoPrint, the destination support system that communicates with PSF for AIX to print jobs.

PSF physical printer

In InfoPrint, the object representing a printer device that uses the PSF destination support system.

Q

QuarkXpress

A desktop publishing system produced by Quark, Incorporated.

queue

In InfoPrint, an object that manages a collection of jobs that are waiting to print. A queue receives jobs from one or more logical destinations and sends jobs to one or more actual destinations.

A line or list formed by items waiting for processing.

R

raster

A pattern of dots defined at varying data depths. Black and white images are one-bit (on/off); grayscale images are 8-bit (256 levels); RGB images are 24-bit; CMYK images are 32-bit.
raster image processor (RIP)
A processor in which a PostScript data stream is converted into dot patterns that are transferred to the final print medium. InfoPrint uses an Adobe RIP to convert PostScript to IPDS for such printers as the InfoPrint 4000 and InfoPrint 60.

rc.pd
In InfoPrint, a utility used to start the InfoPrint servers listed in the /etc/pd.servers file.

read-only
In InfoPrint, describes an attribute value that cannot be set by the user but can change based on other activity.

ready
A state in which an object is ready and able to perform tasks.
An available resource, such as a value of the media-ready attribute. Contrast with supported.

red, green, blue (RGB)
The colors of CRT display phosphors. RGB images are for screen display only. They must be converted to CMYK images before printing.

registration
The accuracy of printing on paper relative to the edges of the paper.
The accuracy of printing a single color (cyan, magenta, or yellow) relative to black.
The accuracy of printing on one side of a page relative to printing on the reverse side of the page.

reprographics
The process of copying or duplicating documents or information.

requested
In InfoPrint, pertaining to the specific values of attributes requested by a job when it is submitted. The requested attribute values of a job are validated against supported attribute values for an actual destination to determine if the printer can handle that job. Contrast with supported.

resettable attribute
An attribute whose value can be set or modified after an object has been created, assuming the object is in an appropriate state to be modified. See also initially settable attribute; contrast with non-settable attribute.

resource
In AFP, a file containing a collection of printing instructions used when printing a job. Resources include fonts, overlays, form definitions, page definitions, and page segments.

resource context
In InfoPrint, an object that contains directory path information that helps the print system locate resources needed for printing a job. The resources include fonts, overlays, form definitions, page definitions, and page segments.

resource document
In InfoPrint, an object that represents a resource, such as graphics or fonts, used by a job to print a printable document. Contrast with printable document.

resubmit
In InfoPrint, an action used to reroute pending or retained jobs to a different logical destination than the one through which the job was originally submitted.

resume
In InfoPrint, the action used to resume the printing of paused jobs or resume the distribution of jobs from paused servers or queues.

retained job
In InfoPrint, an object that represents a job that is being stored in the print system for a specified amount of time, normally after the completion of printing the job. A retained job does not reside in a queue.

retention
The process of storing data after completion of a process for a certain length of time.

retrieval
The process of bringing digital archived data out of storage and into online memory for reuse. See also archiving.

RGB
Red, green, blue.

RIP
Raster image processor.
To convert data to dot patterns using a raster image processor.

root user
In the AIX environment, the system user with the most authority who can log in and execute restricted commands, shut down the system, and edit or delete protected files. Synonymous with superuser.

RPC
Remote Procedure Call.

RPM
Red Hat Package Management is the baseline package format of the Linux Standard Base distribution.

S
scanner
A device that converts hardcopy source data into digital format (halftone dots) to avoid retyping the data.

scheduler
In InfoPrint, the scheduling method that the queue uses when assigning a job to an actual destination.
separator sheet
The sheet of paper, blank or otherwise, that separates documents in a job. See also auxiliary sheet.

server
In InfoPrint, the object that accepts configuration, management, and printing requests, performs the requested operations, and sends responses back as a result of the operation.

settable attribute
See initially settable attribute, resettable attribute.

severity
An indication of how serious an error condition is.

shell
In the AIX operating system, a command interpreter that acts as an interface between the user and the operating system. In InfoPrint documentation, all shell examples use the Korn shell.

shift-out, shift-in code
Control characters used to indicate the beginning and end of a string of double-byte, ideographic characters.

shortest-job-first
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the shortest job in the queue. Contrast with deadline, FIFO (first-in-first-out), job-priority, and longest-job-first.

shut down
In InfoPrint, the action used to halt all server or actual destination processes without deleting the server or actual destination.

signature
A group of pages that are printed, folded, cut, and bound together. Manual placement of pages in the signature is determined using a folding dummy.

simplex
In InfoPrint, the value of the document or actual destination plex attribute indicating that output images are placed on the media in a head-to-head format, so that the top of one image is at the same edge as the top of the next image. Depending on the value of the document or actual destination sides attribute, the document can be printed on one or both sides of the paper. Contrast with tumble; see also simplex printing and duplex printing.

simplex printing
Printing on only one side of the paper. Contrast with duplex printing (1).

Printing on one or both sides of the paper, placing output images on the media in a head-to-head format, so that the top of one image is at the same edge as the top of the next image. Contrast with tumble duplex printing; see also duplex printing (2).

SMIT
System Management Interface Tool.
SNA

Systems Network Architecture.

spiral binding

A type of book binding in which wire or plastic coils are threaded through a series of holes or slots in the binding edge. Contrast with edition binding, perfect binding, and wire-o binding.

spot color

Individual colored inks formulated to exactly match a specified color. Spot color is used when CMYK process color cannot produce a reasonable facsimile of the color or when vivid color is needed. Spot color is also used when fluorescent or metallic colors are needed.

spread

In color printing, an area whose dimensions have been enlarged to eliminate white space between it and another color. Contrast with choke.

start sheet

The sheet of paper, blank or otherwise, that can precede a job. See also auxiliary sheet.

state

Synonym for object state.

stripping

The process of mechanically assembling film into plate layouts. Page imposition takes place during stripping.

subnet mask

Identify a range of IPv4 addresses that are on the same network.

subnetwork

Any group of nodes that have a set of common characteristics, such as the same network ID.

In the AIX operating system, one of a group of multiple logical divisions of another network, such as can be created by TCP/IP.

subtractive color system

A system that reproduces an image by mixing (adding) appropriate quantities of cyan, magenta, and yellow paints on white paper. These paints reflect certain colors and absorb—or subtract—others. Contrast with additive color system.

superuser

Synonym for root user.

supported

In InfoPrint, pertaining to the specific job attribute values that the actual destination can accept during job validation. InfoPrint validates the requested attribute values of the job against the supported attribute values of the actual destination to determine whether the actual destination can handle that job. Contrast with requested.

synchronous
Occurring with a regular or predictable time relationship to a specified action. Contrast with asynchronous.

**system administrator**

Synonym for administrator.

**System Management Interface Tool (SMIT)**

In the AIX operating system, an interface tool for installation, maintenance, configuration, and diagnostic tasks. SMIT lets you perform tasks without entering any commands.

**Systems Network Architecture (SNA)**

The description of IBM’s logical structure, formats, protocols, and operational sequences for sending units through, and controlling the configuration and operation of, networks.

**T**

**table reference character (TRC)**

An optional control character in a print data set. The TRC identifies the font used to print the record and can be used to select a font during printing.

**Tagged Image File Format (TIFF)**

A digital format for storing scanned images. TIFF files are also referred to as raster format files (as opposed to vector format files). When used in desktop publishing, TIFF files produce only a low-resolution FPO image; the high-resolution data remains on the hard disk.

**task help**

A type of online help that provides a list of tasks that can be completed with a selected object. When you select a task, the help provides step-by-step information about how to complete the task.

**TCP/IP**


**TCP/IP-attached printer**

A printer device attached to an pSeries computer through telecommunication lines using the TCP/IP protocol.

In InfoPrint, a PSF physical printer that represents a TCP/IP-attached printer device. See also AIX-attached printer, direct-attached printer, and upload-TCP/IP-attached printer.

**template**

In the InfoPrint Manager Administration GUI, an object that represents a set of default attribute values that has been defined for creating a particular type of object, such as an actual destination.

**ticket**

See job ticket.

**TIFF**

Tagged Image File Format.

**Transmission Control Protocol/Internet Protocol (TCP/IP)**
A set of communication rules used in the Internet and in any network that follows the U.S. Department of Defense standards for inter-network protocol. TCP provides a reliable host-to-host protocol between hosts in packet-switched communications networks and in interconnected systems of such networks. It assumes that the Internet Protocol (IP) is the underlying protocol. See also Internet Protocol.

trapping
In desktop publishing, the amount of overlap in overprinting colors. Trapping prevents white paper showing through gaps caused by normal errors in registration. On sheet-fed presses, trapping is usually 0.25 point. See also choke and spread.

TRC
Table Reference Character.

TrueType font (TTF)
A font format based on scalable outline technology with flexible hinting. Glyph shapes are based on quadratic curves. The font is described with a set of tables contained in a TrueType Font File.

TTF
TrueType font.

tumble
In InfoPrint, the value of the document or actual destination plex attribute indicating that output images are placed on the media in a head-to-toe format, so that the top of one image is at the same edge as the bottom of the next image. The document must be printed on both sides of the paper. Contrast with simplex.

tumble duplex printing
Printing on both sides of the paper, placing output images on the media in a head-to-toe format, so that the top of one image is at the same edge as the bottom of the next image. Contrast with simplex printing (2), duplex printing (2).

U
UCR
Under color removal.

under color removal (UCR)
Conversion of neutral color areas to black ink that reduces use of CMY inks, improves trapping, and reduces setup time. Generally, UCR is performed during image scanning, but some RIPs perform it during processing. Synonymous with gray component replacement (GCR).

unmanage
In the InfoPrint Manager Administration GUI, the action used to put an object into a mode where its icon does not reflect the changes of status for the object.

upload printer
See upload-TCP/IP-attached printer.

upload-TCP/IP-attached printer
In InfoPrint, a PSF physical printer that represents a printer device attached through an MVS system and managed by PSF/MVS. InfoPrint communicates with the MVS system through the TCP/IP network. See also AIX-attached printer, direct-attached printer, and TCP/IP-attached printer.

**V**

**validate**

In InfoPrint, to compare the attribute values requested by a job with the supported attribute values of the actual destinations in the system and to determine whether there is an actual destination capable of printing or sending the job.

**value**

A specific characteristic of an attribute.

**variable**

A name used to represent a data item whose value can change while the program is running.

**variable data**

Data that can be changed between copies of a document. For example, a form letter (constant data) can be merged with variable data, such as a customer's name and address to produce personalized documents.

**varnish**

A protective layer applied to a finished sheet, usually for photos, but sometimes used as a design element because of its reflective qualities. Varnishes can be tinted.

**vector**

An absolute coordinate point and line in space. PostScript files can contain vector artwork. Vector files are converted to rasters during the RIP process.

**velox**

A black and white photographic print made from a halftone negative, to be used as a proof copy.

**vignette**

An image with soft, fade-away edges.

**Virtual Machine (VM)**

An IBM licensed product that manages the resources of a single computer so that multiple computing systems appear to exist.

A virtual data processing system that appears to be at the exclusive disposal of a particular user, but whose functions are accomplished by sharing the resources of a real data processing system. (T)

**Virtual Storage Extended (VSE)**

An IBM licensed program whose full name is the Virtual Storage Extended/Advanced Function. It is a software operating system controlling the execution of programs.

**Visual Systems Management (VSM)**

In AIX, a type of graphical user interface that allows system management through the direct manipulation of objects.

**VM**
Virtual Machine.

VSE
Virtual Storage Extended.

VSM
Visual Systems Management.

W
web
A roll of paper used in web or rotary printing.

well
In the InfoPrint Manager Administration GUI, an area in a pane that contains a group of objects related to the objects in the pane; for example, a queues well in a servers pane.

what you see is what you get (WYSIWYG)
Refers to the fact that the composite image displayed on the screen at a computer workstation has the appearance of the final printed image.

window
A rectangular area of the screen that you can move about, place on top of, or pull under other windows, or reduce to an icon.

wire-o binding
A continuous double series of wire loops run through punched slots along the binding side of a booklet. Contrast with edition binding, perfect binding, and spiral binding.

with-request
In InfoPrint, a document transfer method where the client transfers the documents directly to the server. Contrast with pipe-pull.

workstation
A terminal or microcomputer, usually one that is connected to a mainframe or to a network, at which a user can use applications.

write access
A level of authorization that grants the ability to modify data.

WYSIWYG
What you see is what you get.

X
X-Windows
A network-transparent windowing system developed by MIT. It is the basis for Enhanced X-Windows, which runs on the AIX Operating System.

xerography
A dry printing process using corona-charged photoconductive surfaces to hold latent images that are developed with a dry toner and then transferred to paper and fused with heat.

Xstation

A terminal that is connected through a network to an pSeries computer, from which a user can perform command-line functions and run X-Windows based applications.
INDEX

A
abbreviations........................................... 5
access method C
printing PCL and PostScript..................... 102
using.................................................... 102
access method E
installing InfoPrint................................. 13
access method L
Installing the SAP Client when SAP runs on
AIX...................................................... 61
Installing the SAP Client when SAP runs on HP-
UX...................................................... 57
Installing the SAP Client when SAP runs on Solaris........................................... 57
Installing the SAP Client when SAP runs on Windows.......................................... 62
modifying the print profile............................. 63
non-OMS printing to InfoPrint Manager AIX
server................................................... 65
access method U
printing................................................... 101
activating
end-user pop-ups for SAP R/3 access method
E......................................................... 42
adding box shading values........................... 91
adding electronic forms and logos.................. 8
adding electronic forms to text..................... 8
Advanced Function Presentation data.............. 8
advanced OMS configuration
for SAP R/3 access method E...................... 42
AFP Font Collection
Japanese fonts.......................................... 77
Korean fonts............................................ 77
Simplified Chinese fonts.............................. 77
Traditional Chinese fonts............................. 77
AIX files
/etc/hosts.equiv....................................... 18, 59
/home/sapuser/.rhosts................................. 18, 59
/usr/lpp/pd/bin/ipm_dev_query*................... 21
/usr/lpp/pd/bin/ipm_job_cancel*................. 21
/usr/lpp/pd/bin/ipm_job_query*................... 21
/usr/lpp/pd/bin/ipm_print.sys..................... 60
/usr/lpp/pd/bin/ipm_query.sys.................... 60
/usr/lpp/pd/bin/ipm_submit*....................... 21
/usr/lpp/pd/bin/ipm.omsdesc....................... 21
AIX filesets
ipsc-psf.icu.rte..................................... 14
AIX SAP system
turning off GOCA support........................... 92
AIX Servers
installing InfoPrint OMS support............... 23
bar codes
BCOCA values in barcode.tab file................. 96
ModWidth values in barcode.tab file............. 98
Ratio values in barcode.tab........................ 98
supported by the SAP transform................... 93
supporting new user OTF bar codes............... 95
barcode.tab file
Flag values............................................ 96
Mode values.......................................... 96
ModWidth values..................................... 98
Ratio values.......................................... 98
Type values.......................................... 96
barcode.tab file values.............................. 96
box shading values.................................... 91
BX OTF command
box shading support.................................. 91
C
cancelling
jobs for SAP R/3 access method E................. 41
Cautions............................................... 3
changing
document print orientation........................ 71
page print orientation............................... 74
Chinese character sets................................ 77
Chinese fonts......................................... 77
Chinese language support.......................... 8
collecting information
to start an SAP callback daemon or
process............................................... 31
commands
- c flag for failing over InfoPrint Manager servers ................................................. 49
- c flag for sending jobs to other InfoPrint Manager servers ......................................... 44
- c flag for switching InfoPrint Manager servers .......................................................... 47
BX OTF .......................................................................................................................... 91
ipm_print ......................................................................................................................... 63
configuration files ........................................................................................................... 78–79
6400fonts.tab .................................................................................................................... 16
6400fonts.tab values ......................................................................................................... 91
barcode.tab ....................................................................................................................... 16
barcode.tab values ........................................................................................................... 96, 98
defcp.tab .......................................................................................................................... 16
fonts.tab ............................................................................................................................ 16
image.tab ............................................................................................................................ 16
pagedef.tab ......................................................................................................................... 16
16, 71, 74–75
table listing ......................................................................................................................... 16
xxxxyyyy.tab ...................................................................................................................... 16
configuration, access method U
defining SAP devices ......................................................................................................... 99
configure
to use SAP clients on InfoPrint Manager
Windows server ............................................................................................................. 20, 58
configuration
access method C for submitting jobs from SAP
Windows systems ............................................................................................................ 102
InfoPrint Manager AIX server for HP-UX, Linux, and Sun servers OMS support .......... 18
InfoPrint server OMS support for HP-UX and Sun Solaris servers .................................. 18
SAP callback daemon ......................................................................................................... 35
SAP system servers for HP-UX and Sun Solaris Servers .................................................... 21
SAP system servers for HP-UX, Sun Solaris, and Linux Servers ......................................... 60
SAP transform for SAP R/3 access method E .................................................................... 16
the InfoPrint Server for HP-UX, Linux, and Sun Solaris servers ........................................ 58
to use SAP clients on InfoPrint Manager AIX server ....................................................... 59
using access method E with InfoPrint Manager AIX server ............................................... 28
connecting
a format to a device type ................................................................................................. 74
conventions ......................................................................................................................... 5
creating
an R/3 fax device (SAPcomm) ......................................................................................... 67
customized device type (ABAP), defining ......................................................................... 72
customizing print characteristics ...................................................................................... 70
changing document print orientation ................................................................................. 71
defining a customized device type ..................................................................................... 71
Cyrillic character set .......................................................................................................... 77
Cyrillic script support ......................................................................................................... 8
D
daemons ............................................................................................................................ 13
sapcbd ................................................................................................................................. 14
sapcbd (for callback) .......................................................................................................... 13
default form definition
F1SAP ................................................................................................................................. 75
defcp.tab ............................................................................................................................ 78–79
defcp.tab configuration file ............................................................................................... 78–79
defining
a real output management system .................................................................................... 29
another logical output management system ..................................................................... 43
devices to InfoPrint OMS ................................................................................................... 39
for SAP R/3 access method E ............................................................................................ 29
SAP user for OMS callback .................................................................................................. 30
the InfoPrint Manager OMS to SAP for SAP R/3 access method E ................................. 28
defining a customized device type (ABAP)
changing document print orientation ................................................................................. 72
defining a new OTF format ................................................................................................. 72
defining devices
modifying the print profile for access method L ............................................................... 63
using access method C ........................................................................................................ 102
using access method L ........................................................................................................ 65
using access method U ........................................................................................................ 101
defining devices with SAPGOF ......................................................................................... 39
defining SAP devices
configuration tasks, access method U .............................................................................. 99
definitions
device type ........................................................................................................................... 71
deleting a callback process on Windows
for SAP R/3 access method E ........................................ 55
device status, displaying
  for SAP R/3 access method E ....................................... 41
device type
definition ................................................................... 71
directories
  /usr/lpp/pd/bin ......................................................... 19, 59
  /usr/lpp/psf/bin ......................................................... 16
displaying
device status for SAP R/3 access method E ....................... 41
distributing the callback workload .................................... 44
document print orientation, changing .............................. 71
E
enabling multi-byte character sets ............................... 77
Enabling Unicode support ........................................ 80
end-user pop-ups
  limitation in pre SAP R/3 4.5B systems ...................... 42
enhanced job status, viewing
  for SAP R/3 access method E ....................................... 40
error log
  SAP callback daemon ............................................. 51
  SAP callback process ............................................... 52
  /etc/hosts file .......................................................... 21
  /etc/hosts.equiv file ................................................. 18, 59
  /etc/rc.iprsap ......................................................... 31
  /etc/rc.iprsap file ................................................... 33
examples
failing over to other servers in the same
  InfoPrint Manager system ......................................... 49
  sending jobs to multiple InfoPrint Manager systems .... 44
  switching InfoPrint Manager servers ......................... 47
expanding server ports
  for the SAP callback process .................................... 38
F
F1 SAP form definition ............................................ 75
failing over to other servers in the same
  InfoPrint Manager system ......................................... 49
fax-out
  using SAPcomm ..................................................... 67
  files .......................................................................... 59
/etc/hosts ................................................................. 21
/etc/rc.iprsap .......................................................... 33
ipm_dev_query .......................................................... 23–24
ipm_job_cancel ......................................................... 23–24
ipm_job_query .......................................................... 23–24
ipm_print ................................................................. 59
ipm_submit ............................................................... 19, 23–24
ipm.omssdesc ........................................................... 28
ipmcfg ................................................................. 21, 92–93
rc.iprsap ................................................................. 31, 33
.rhosts ................................................................. 20, 58
sap_error.cfg ............................................................. 52
sapcbd ................................................................. 13
sapcbd.exe ............................................................... 13
/usr/lpp/pd/bin ........................................................ 21
files
sets
  ipr.sapclient ......................................................... 23–24, 61
fonts.tab ................................................................. 78–79
fonts.tab configuration file ......................................... 78–79
format
  defining ................................................................. 72
  format, connecting to a device type ............................ 74
  format, see paper type ............................................. 71
G
Generic Output Format (SAPGOF)
support for non-Latin scripts ...................................... 8
support for OTF and ABAP data streams ...................... 9
GOCA support
  adding box shading values ....................................... 91
  turning off ............................................................... 26, 62
  turning off on a Windows server ............................... 21
  turning off on an AIX server ..................................... 19
  turning off on an AIX server (non-OMS) ................... 59
H
/home/sapuser/.rhosts file ........................................ 18, 59
HP-UX SAP system
  turning off GOCA support ......................................... 92
HP-UX Servers
  configuring the InfoPrint Manager AIX server
    OMS support ........................................................ 18
  configuring the InfoPrint server ............................... 18, 58
  configuring the SAP system server ......................... 21, 60
installing InfoPrint OMS support ........................................ 18
HTML guide
Displaying ........................................................................ 4

Important ........................................................................... 3
InfoPrint AIX, print support ................................................... 70
InfoPrint filesets
ipr.sapclient ...................................................................... 23–24
InfoPrint Fonts
Japanese fonts .................................................................... 77
Korean fonts ........................................................................ 77
Simplified Chinese fonts ......................................................... 77
Traditional Chinese fonts ....................................................... 77
InfoPrint Manager AIX server
access method E configuration ........................................... 28
InfoPrint Manager AIX Server
configure to use SAP clients ............................................. 59
configure to use SAP clients OMS support ......................... 18
InfoPrint Manager DVD-ROMs
Common Clients ................................................................ 13
SAP Print Feature ............................................................... 13
InfoPrint Manager for AIX SAP OMS
for reliable job status notifications ..................................... 8
InfoPrint Manager for Windows SAP OMS
for reliable job status notifications ..................................... 8
InfoPrint Manager jobs
sending to multiple InfoPrint Manager systems ................. 44
InfoPrint Manager Management console
SAP Callback Processes support .......................................... 55
InfoPrint Manager Management Console
SAP Callback Processes support .......................................... 55
InfoPrint Manager OMS server switching
described ........................................................................... 9
failing over ......................................................................... 49
sending jobs ....................................................................... 44
switching servers in same name space ................................ 47
InfoPrint Manager OMS, defining to SAP
for SAP R/3 access method E ............................................ 28
InfoPrint Manager SAP Callback daemon
overview ............................................................................ 13
InfoPrint Manager servers
failing over in the same InfoPrint server ......................... 49
switching ........................................................................... 47
InfoPrint Manager service updates
failing over to other InfoPrint Manager servers support .......... 49
sending jobs to multiple InfoPrint Manager systems support .................................................... 44
switching InfoPrint Manager servers support ................... 47
InfoPrint Manager Windows server
configure to use SAP clients ............................................ 20, 58
installing InfoPrint OMS support ....................................... 26
InfoPrint Manager: Common Clients DVD-ROM
for installing SAP Clients ................................................... 13
InfoPrint Manager: SAP Print Feature DVD-ROM .......... 13
InfoPrint OMS, defining devices
for SAP R/3 access method E ............................................ 39
InfoPrint Windows, print support ......................................... 70
install_path\bin .................................................................. 16
install_path\bin\ipm.omsdesc file ....................................... 21
install_path\sap2afp ............................................................ 16
installing
InfoPrint Manager OMS support when SAP runs on HP-UX or Sun servers ........................................ 18
the SAP Client when SAP runs on AIX .............................. 61
the SAP Client when SAP runs on HP-UX ......................... 57
the SAP Client when SAP runs on Linux ......................... 57
the SAP Client when SAP runs on Sun Solaris ................. 57
the SAP Client when SAP runs on Windows .................. 62
Installing
InfoPrint with SAP R/3 for printing .................................. 57
Installing InfoPrint Manager OMS support
when SAP runs on AIX servers ......................................... 23
when SAP runs on Linux servers ...................................... 24
when SAP runs on Windows ............................................. 26
installing InfoPrint with SAP R/3 for OMS support .............. 13
ipm_cfg .............................................................................. 59
ipm_cfg file ........................................................................ 59
ipm_dev_query
AIX Servers, installing InfoPrint OMS support .......................................................... 23
Linux Servers, installing InfoPrint OMS support .......................................................... 24
ipm_job_cancel ........................................44, 47, 49
AIX Servers, installing InfoPrint OMS support .......................................................... 23
Linux Servers, installing InfoPrint OMS support .......................................................... 24
ipm_job_query ........................................44, 47, 49
AIX Servers, installing InfoPrint OMS support .......................................................... 23
Linux Servers, installing InfoPrint OMS support .......................................................... 24
ipm_print command .................................. 63
for non-OMS printing .......................57
ipm_query command ................................44, 47, 49
for non-OMS printing .......................57
ipm_submit
AIX Servers, installing InfoPrint OMS support .......................................................... 23
Linux Servers, installing InfoPrint OMS support .......................................................... 24
ipm_submit command ................................44, 47, 49
ipm_submit file ........................................ 19, 59
ipm.omdesc file
defines InfoPrint Manager as an OMS .......28
ipm.omdsdesc file ................................ 21
ipmcfg file ........................................ 21, 92–93
ipr.sapclient fileset ................................ 61
ipsc-psf.icu.rte fileset
required for installs ................................14

J
Japanese character set ........................................ 77
Japanese fonts ......................................... 77
Japanese language support ................... 8
jobs, cancelling
for SAP R/3 access method E ........... 41

K
keyboard shortcuts for the SAP GUI ....... 10
Korean character set ...................................... 77
Korean fonts ........................................... 77
Korean language support ..................... 8

L
limitations
to activating end-user pop-ups ..........42
Linux Servers
configuring the InfoPrint Manager AIX server
OMS support ......................................... 18
configuring the InfoPrint server ......... 58
configuring the SAP system server ....... 60
installing InfoPrint OMS support ........ 24
logical output management system, defining
for SAP R/3 access method E ........... 29
logical output management system, defining
another for SAP R/3 access method E ....... 43
LOMS commands
failing over in the same InfoPrint server .... 49
modifying for InfoPrint server switching .... 47
sending jobs to multiple InfoPrint Manager
systems .............................................. 44
LOMS, organizing OMS output devices
distributing the callback workload ....... 44
supporting multiple InfoPrint Manager
systems .............................................. 44
using different OMS services ............. 44
using different report levels or event delivery
criteria .............................................. 44
LPD service
from InfoPrint Manager for AIX .......... 100
from InfoPrint Manager for Windows .... 99

M
management console
SAP callback processes support .......... 37
SAP Callback Processes support .......... 55
modifying the print profile
defining devices for access method L .... 65
ModWidth values in barcode.tab .......... 98
moving
OMS definitions among SAP systems .... 47

N
non-OMS printing
defining devices for access method L ..... 65
non-OMS SAP R/3
installing InfoPrint.................................................57

O

OMS callback, defining an SAP user
  for SAP R/3 access method E..........................30
OMS commands
  -c flag for failing over InfoPrint Manager
    servers......................................................49
  -c flag for sending jobs to other InfoPrint
    Manager servers........................................44
  -c flag for switching InfoPrint Manager
    servers....................................................47
  host parameter ...........................................44, 47, 49
  socket parameter.........................................44, 47, 49
OMS configuration, advanced
  activating user pop-ups ................................42
  for SAP R/3 access method E..........................42
  moving OMS definitions among SAP
    systems....................................................47
  organizing output devices into LOMS.................43
  selecting event report levels........................43
OMS support
  when SAP runs on AIX servers ........................23
  when SAP runs on HP-UX or Sun servers .............18
  when SAP runs on Linux servers .......................24
  when SAP runs on Windows.............................26
OMS support tasks, using.................................40
OMS, see Output Management System.................8
organizing output devices into LOMS
  for SAP R/3 access method E..........................43
OTF bar codes, support.................................95
OTF fonts
  using to print...........................................88
OTF format
  defining..................................................72
Output Management System (OMS)
  for reliable job status notifications..............8
Output Management System (OMS)
  overview..................................................13
Output Management System overview
  for SAP R/3 access method E..........................13
Output Text Format data
  adding box shading values ..............................91
  overview of SAP R/3 Print Feature...................7
P

page print orientation
  changing..................................................74
pagedef.tab..................................................78–79
pagedef.tab configuration file.........................71, 74–75, 78–79
paper type, see format....................................71
paths
  install_path\bin..........................................16
  install_path\sap2afp.....................................16
PDF manual
  Displaying................................................4
pdserver
  InfoPrint Manager server..............................13
print management..........................................9
print profile
  modifying for access method L.......................63
  print profile values
    rspo/host_spool/answer_format ......................63
    rspo/host_spool/print.................................63
    rspo/host_spool/query.................................63
    rspo/host_spool/answer_format print profile
      values.................................................63
    rspo/host_spool/print print profile values .......63
    rspo/host_spool/query print profile
      values.................................................63
print support
  for both InfoPrint AIX and InfoPrint Manager
    Windows servers......................................70
printers
  6400 Printer.............................................91
printing
  defining devices for access method U..............101
  oversize characters on a 6400 .......................91
  using the InfoPrint ipm_print command...............63
  with access method L..................................57
printing PCL and PostScript
  defining devices for access method C...............102
property help..............................................5
R

Ratio values in barcode.tab.............................98
rc.iprsap file
  starting the callback daemon.........................33
Sun Solaris Servers
configuring the InfoPrint Manager AIX server OMS support .................................................. 18
configuring the InfoPrint server ........................................... 18, 58
configuring the SAP system server ........................................ 21, 60
installing InfoPrint OMS support ........................................ 18
supporting multiple InfoPrint Manager systems ............................................................... 44
supporting new OTF user fonts .................................................. 88
switching InfoPrint Manager servers ........................................ 47
switching off GOCA support .................................................... 26, 62
symbols ............................................................................. 5
T
Traditional Chinese character set .................................................. 77
Traditional Chinese fonts ............................................................. 77
Traditional Chinese language support ......................................... 8
turning off GOCA support ...................................................... 26, 62
turning off GOCA support on a Windows server ........................................ 21
turning off GOCA support on an AIX server ................................... 19
turning off GOCA support on an AIX server (non-OMS) ...................... 59
U
Unicode support ................................................................. 80
using different OMS services .................................................. 44
different report levels or event delivery criteria ........................................ 44
OMS support tasks ................................................................. 40
using bar codes ................................................................. 93
using SAPcomm support for fax-out ....................................... 67
using the InfoPrint ipm_print command
printing ................................................................. 63
/usr/lpp/pd/bin file ................................................................. 21
/usr/lpp/pd/bin/ipm_dev_query* file ...................................... 21
/usr/lpp/pd/bin/ipm_job_cancel* file ...................................... 21
/usr/lpp/pd/bin/ipm_job_query* file ...................................... 21
/usr/lpp/pd/bin/ipm_print.sys file ........................................ 60
/usr/lpp/pd/bin/ipm_query.sys file ........................................ 60
/usr/lpp/pd/bin/ipm_submit* file ........................................ 21
/usr/lpp/pd/bin/ipm.omsdesc file ........................................ 21
/usr/lpp/psf/bin ................................................................. 16
V
verifying the InfoPrint LPD service
to submit jobs with access method U from AIX ................................................................. 100
to submit jobs with access method U from Windows .................................................. 99
viewing enhanced job status for SAP R/3 access method E ............................................. 40
W
Windows files
\bin\ipm.omsdesc ................................................................. 21
Windows gateway printer
using access method C ...................................................... 102
Windows SAP system
turning off GOCA support .................................................. 93